Sun™ ldentity Manager Release Notes

Version 8.0 May 2008
Part Number 820-2958-10

These Release Notes contain important information available at the time of release of Sun Identity
Manager 8.0. New features and enhancements, known issues and limitations, and other
information are addressed here. Read this document before you begin using Identity Manager 8.0.

These Release Notes are organized into the following sections:
¢ Introduction
e Identity Manager 8.0 Features
¢ Installation and Update Notes
* Deprecated APIs
* Documentation Additions and Corrections

Third-party URLs are referenced in this document and provide additional, related information.

NOTE Sun is not responsible for the availability of third-party Web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content,
advertising, products, or other materials that are available on or through such sites
or resources. Sun will not be responsible or liable for any actual or alleged damage
or loss caused by or in connection with the use of or reliance on any such content,
goods, or services that are available on or through such sites or resources.




Supported Software and Environments

Introduction

This section of the Identity Manager 8.0 Release Notes provides information about:

Supported Software and Environments
Upgrade Paths and Support Policies
Redistributable Files

How to Report Problems and Provide Feedback
Sun Welcomes Your Comments

Additional Sun Resources

Supported Software and Environments

This section lists software and environments that are compatible with Identity product software:

Operating Systems

Java Support

Application Servers

Repository Database Servers
Sun Identity Manager Gateway
Supported Resources

Browsers

Discontinued Software

NOTE

Because software product developers frequently ship new versions, updates, and
fixes to their software, the information published here changes often. Review the
release notes for updates before proceeding with installation.
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Supported Software and Environments

Operating Systems

This release of Identity Manager supports the following operating systems:

AIX5.2,5Lv5.3

HP-UX 11i v1, 11i v2

Microsoft Windows 2000 SP3, 2000 SP4
Microsoft Windows Server 2003

Solaris 9, 10 Sparc and x86

Red Hat Linux Advanced Server 2.1
Red Hat Linux Enterprise Server 3.x, 4.x

Novell SuSE Linux Enterprise Server 9 SP1

Java Support

Identity Manager requires Java Platform, Standard Edition (SE) 5 or higher.

System Virtualization Support

System virtualization is a technology that enables multiple operating system (OS) instances to
execute independently on shared hardware. Functionally, software deployed to an OS hosted in a
virtualized environment is generally unaware that the underlying platform has been virtualized.
Sun performs testing of its Sun Java System products on select system virtualization and OS
combinations to help validate that the Sun Java System products continue to function on properly
sized and configured virtualized environments as they do on non-virtualized systems. For
information about Sun support for Sun Java System products in virtualized environments, see
http://docs.sun.com/doc/820-4651.
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Application Servers

The application server you use with Identity Manager must be Servlet 2.2-compliant and installed
with the included Java platform (unless noted as follows). Identity Manager requires Java SE
Development Kit (JDK) 5 or 6 on the following application servers, if the application server
supports these versions.

* Apache® Tomcat 5.5.x, 6.0.x

e BEA WebLogic® Server™ 9.1, 9.2, 10

e IBM WebSphere® 6.1

* JBoss Application Server 4.2

* Oracle Application Server Enterprise Edition 10g Release 3 (10.1.3)

¢ Oracle Application Server Standard Edition 10g Release 3 (10.1.3)

¢ SunJava™ System Application Server 9.1 (GlassFish v2 UR1, 32-bit and 64-bit)

™

* Sun Java™ System Application Server Platform Edition 8.1, 8.2, 9.0

™

* SunJava™ System Application Server Enterprise Edition 8.1, 8.2

™

* SunJava™ System Application Server Standard Edition 8.2

NOTE * If your current application server does not support JDK 5, please check with your vendor to
examine the implications of upgrading to one that does before installing Identity Manager

¢ Identity Manager requires a JDK that correctly handles the 2007 adjustments to U.S. Daylight
Savings Time (DST). You must install any relevant DST patches for the JDK version you are using.
For Sun JDK 5, Update 15 contains the necessary DST fixes. All versions of Sun JDK 6 contain the
necessary DST fixes.

* You can run Identity Manager on BEA WebLogic application servers with all WebLogic-supported 5
JDKs.
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Repository Database Servers

Identity Manager supports the following repository database servers:

IBM® DB2® Universal Database for Linux, UNIX®, and Windows®
(Version 8.1, 8.2)

Microsoft SQL Server™ 2005
MySQL™ 5.0, 5.1

NOTE

Identity Manager supports MySQL as a database resource in development
or production deployments. MySQL is only supported as a repository
database server in development deployment.

Oracle 9i® and Oracle Database 10g, 10g Release 1 and 10g Release 2®,11g

NOTE

Oracle RAC (Real Application Cluster) is supported in a two-node
active-passive configuration. That is, a configuration where the
active_instance_count parameter is set to 1. Used in conjunction with
connection failover for the JDBC driver, this provides failover capability for
the repository. (Refer to Oracle documentation for how to configure this in
your environment)

Oracle RAC is not currently supported in any other configuration.

CAUTION

If you are using an Oracle repository . . .

The Identity Manager 8.0 repository DDL uses data types that are not
properly handled by older Oracle JDBC drivers. The JDBC drivers in
ojdbcl4. jar do not properly read all of the columns in the log table.

You must upgrade to the Oracle JDBC drivers for JDK 1.5 for Identity
Manager to work properly.
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Sun Identity Manager Gateway

If you plan to set up Windows Active Directory, Novell NetWare, Remedy, Lotus Notes (Domino)
or RSA ACE/Server resources, you must install the Sun Identity Manager Gateway.

Supported Resources

Identity Manager software supports these resources:
* Customer Relationship Management (CRM)
¢ Databases
¢ Directories
¢ Enterprise Resource Planning (ERP)

e Help Desk

* Message Platforms

¢ Miscellaneous

¢ Operating Systems

* Role Management System
* Security Managers

e  Web Access Control

Customer Relationship Management (CRM)
e Siebel version 7.0.4,7.7,7.8, 8.0 CRM software

Databases
e Generic database table

e IBM® DB2® Universal Database for Linux, UNIX®, and Windows® 8.1, 8.2
*  Microsoft® Identity Integration Server (MIIS) 2003
e  Microsoft SQL Server 2000, 2005
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Supported Software and Environments

MySQL™ 4.x, 5.0,5.1
NOTE Identity Manager supports MySQL as a development and production
database.

Oracle Database 9i®, 10g Release 1®, 10g Release 2°®
Sybase Adaptive Server® 12.x
Scripted JDBC (manages resources using JDBC 3.0 drivers or later)

Directories

LDAP v3

RACF LDAP

Microsoft® Active Directory® 2000, 2003

Microsoft® Active Directory® Application Mode (ADAM) Windows 2003 SP1 and later
Novell® eDirectory 8.7.1, 8.8

Novell NetWare® 6.5

Open LDAP

Sun™ ONE Directory Server 4.x

Sun Java™ System Directory Server 5.x, 6.3

*  While Identity Manager is tested on Sun Java™ System Directory Server and Open LDAP, LDAP
servers that are v3-compliant may work without any changes to the resource adapter.

e Sun Java™ System Directory Server 5 2005Q1 requires a patch to the Directory Server retro
changelog plugin if you are using Active Sync. This patch is required for “regular” replication only
(not for MMR replication)
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Supported Software and Environments

Enterprise Resource Planning (ERP)
e  MySAP ERP 2005 (ECC 6.0) Kernel version 7.00

* Oracle E-Business Suite on Oracle Applications 11.5.9, 11.5.10, 12

* Peoplesoft® PeopleTools 8.1 through 8.4.2

* Peoplesoft PeopleTools HRMS 8.0 through 8.8, 9.0

e SAP®R/3 Enterprise 4.7 (SAP BASIS 6.20)

* SAP® NetWeaver Enterprise Portal 2004 (SAP BASIS 6.40), 2004s (SAP BASIS 7.00)
* SAP® Governance, Risk, and Compliance (GRC) Access Enforcer 5.1, 5.2

Help Desk
* BMC Remedy Action Request System Server 6.0, 6.3, 7.0

¢ BMC Remedy Service Desk Application 7.0
* Remedy Help Desk 6.0

NOTE Many substantial differences between Help Desk 6.0 and Service Desk 7.0 exist in
terms of their sample data, defaults, and out-of-the-box configuration. For example,
the name of the “ticket” schema in Help Desk 6.0 is HPD:HelpDesk, while in Service
Desk 7.0 it has been changed to HPD:Help Desk. Developers should consult the
Remedy product documentation for details when upgrading.

Message Platforms
* Sun Java System Messaging and Calender Service Java Enterprise System 2005Q1 and later

¢ Lotus Notes® (Domino) 6.5, 7.0
*  Microsoft® Exchange 2000, 2003, 2007

NOTE * Microsoft Exchange 2000, 2003, and 2007 are managed through the Active Directory resource
adapter.

* Microsoft Exchange 2007 is supported on Windows 2003 only.

* Novell® GroupWise 7.0 (using the Novell NDS adapter)
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Miscellaneous
e Flat files

* JMS Message Queue Listener (manages any JMS 1.0b or later compliant queue)

¢ Generic UNIX Shell Script

NOTE The Generic UNIX Shell Script adapter runs scripts in supported shell types
on supported UNIX operating systems.

¢ Generic Windows Script Adapter

NOTE The Generic Windows Script adapter runs scripts in the cmd shell on
supported Windows operating systems that host the Sun Identity Manager
Gateway.

Operating Systems
e HPOpenVMS 72,83

e HP-UX11.0,11iv1, 11iv2

e IBM AIX®4.3.3,5.2,5L,5.3

e IBM OS/400® V4r3, V4r5, V5rl, V512, V513, Vbr4
e  Microsoft Windows® 2000, 2003

* Red Hat Linux 9.0

¢ Red Hat Linux Advanced Server 2.1

¢ Red Hat Linux Enterprise Server 3.0, 4.0

e Sun Solaris™9, 10

* SuSE Enterprise 9

NOTE If you manage NIS accounts on Solaris, install patch 126632-01 on the resource to
improve the performance of the logins command and the Solaris adapter.
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Role Management System
* BridgeStream SmartRoles 2.7

Security Managers
o eTrust CA-ACF2® Security

o eTrust CA-Top Secret® Security 5.3

e IBM RACF®

e INISafe Nexess 1.1.5

e RSA ClearTrust 5.5.2,5.5.3

e RSA®SecurID®5.0,6.0,6.1.2

e RSA® SecurID® for UNIX 5.1, 6.0, 6.1.2
* Scripted Host

Web Access Control
e IBM Tivoli® Access Manager 4.x, 5.1, 6.0.0 FP09

* Netegrity® Siteminder® 5.5

¢ RSA®C(ClearTrust®5.0.1

¢ Sun™ ONE Identity Server 6.1, 6.2

* SunJava™ System Identity Server 2004Q2

* Sun Java™ System Access Manager 6 2005Q1, 7 2005Q4 (Realms supported as of 2005Q4),
7.1

Browsers

Identity Manager supports the following browsers:
*  Microsoft Internet Explorer 6.x, 7.x
e Safari 2.0 and later for Mac OS X 10.3.3 and later, 3.0.x
e Firefox 1.04, 1.05, 1.06, 1.5, 2.0.0.4
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Deprecated ldentity Manager Features

The following Identity Manager features are deprecated. Support for these features will continue
until the next major release of Identity Manager. Please contact your Customer Care representative
or Customer Support if you have questions.

Identity Manager Business Process Editor (BPE)

* The Business Process Editor (BPE) is deprecated, and will be removed in the next major
release of Identity Manager. Please use the Identity Manager Integrated Development
Environment (Identity Manager IDE) instead. (ID-17693)

Meta View

* Meta View has been removed from new installations of Identity Manager. Customers who
are using MetaView in a pre-8.0 version of Identity Manager will be able to continue using
it. Please contact your Customer Care representative or Customer Support if you have
questions. (ID-17244)

Discontinued Software

Identity Manager operating systems, application servers, database repositories and managed
resources included in the following tables are deprecated.

Next Major Identity Manager Release

Identity Manager will continue support of deprecated software in the following table until the next
major Identity Manager release. Please contact your Customer Care representative or Customer
Support if you have questions about moving to newer versions of these software packages.

Software Category Software Package

Operating Systems ¢ Red Hat Linux Advanced Server 2.1, 3.0
¢ Red Hat Linux Enterprise Server
e Solaris 8
*  Windows 2000 SP3, 2000 SP4
Application Servers * JBoss Application Server 4.0.x
e Sun Java System Application Server Platform Edition 8.0

Repository Database Servers e Oracle 9i
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Software Category Software Package

Resources * BridgeStream SmartRoles
e HP OpenVMS 7.2
e IBMAIX4.3.3
e IBM Tivoli Access Manager 4.x
* INISafe Nexess
¢ Microsoft Active Directory 2000
* Microsoft Exchange 2000
e Microsoft SQL Server 2000
* Microsoft Windows Server 2000
e MySQL 4.x
* Lotus Notes 6.5
e Oracle 9i
¢ Red Hat Linux Enterprise Server
e SAP Governance, Risk and Compliance Access Enforcer 5.1
e SecurlD 5.0, 5.1
e Siebel 7.0.4
e Solaris 8
* Sun Access Manager 6 (2005Q1)
e Sun Java system Identity Server 2004Q2
e Sun ONE Identity Server 6.1, 6.2
e Sun ONE Directory Server 4.x
e Windows 2000 SP3, 2000 SP4
Browsers e Firefox 1.0.x

e Mozilla

Identity Manager 8.0

Identity Manager 8.0 does not support the following discontinued software packages:

Software Category Software Package
Operating Systems e [IBMAIX4.33
e Solaris 7
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Software Category

Software Package

Application Servers

Repository Database Servers

Resources

Browsers

Apache Tomcat 4.1.x, 5.0.x

BEA Weblogic Express 7, 8.1

BEA Weblogic Server 7, 8.1

IBM Websphere Application Server - Express Version 5.1.1
IBM Websphere 4, 4.5, 5, 6.0

iPlanet 6.5

Sun ONE Application Server 7

IBM DB2 Universal Database for Linux, UNIX, and Windows 7.x
Microsoft SQL 2000

MySQL 4.1

Oracle 8i

SQL Server 2000

ActivCard 5.0

Blackberry RIM Enterprise Server 4+ (uses generic Windows script adapter)
and Blackberry Enterprise Server scripts

IBM DB2 7.x

Lotus Notes (Domino) 5.0, 6.0.x

Microsoft Exchange 5.5

Microsoft Windows NT 4.0

MySQL 4.1

Natural

Novell® GroupWise 5.x, 6.0, 6.5

Novell® eDirectory on Novell NetWare 5.1, 6.0
Oracle 8i (through the Oracle resource adapter)
Red Hat Linux 8.0

Remedy® Help Desk 4.5, 5.0.

SAP R/3v4.5,v4.6

Siebel 6.2

Sun Identity Manager Gateway running on Microsoft Windows NT 4.0
Sun ONE Identity Server 6.0

Internet Explorer 5.x

Safari 1.2.1+
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API Support

The Identity Manager 8.0 Application Programming Interface (API) includes any public class (and
any public or protected method or field of a public class) listed in the following table.

NOTE The com.waveset.object.RepositoryProxy is intended for internal use only.
API Type Class Names
Session com.waveset.msgcat.*

com.waveset.util.”
com.waveset.object.”
com.waveset.exception.*
com.waveset.expression.”
com.waveset.config.”
com.waveset.session.SessionUtil
com.waveset.session.ScriptSession
com.waveset.session.SessionFactory
com.waveset.session.Session
com.waveset.session.UserViewConstants

Adapter com.waveset.adapter.”
com.waveset.util. Trace

Policy com.waveset.policy.Policylmplementation
com.waveset.policy.StringQualityPolicy

Report com.waveset.report.BaseReportTask

Task com.waveset.task.Executor
com.waveset.task. TaskContext

ul com.waveset.ui.FormUtil
com.waveset.ui.util. RequestState
com.waveset.ui.util.html.*

Workflow com.waveset.provision.WorkflowServices
com.waveset.session.WorkflowServices
com.waveset.workflow.WorkflowApplication

com.waveset.workflow.WorkflowContext
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Identity Manager SPE additionally includes the public classes listed in the following table.

API Type Class Names

SPE com.sun.idm.idmx.api.*
com.sun.idm.idmx.txn.TransactionPersistentStore
com.sun.idm.idmx.txn.TransactionQuery

com.sun.idm.idmx.txn.TransactionSummary

These classes are the only classes that are officially supported. If you are using classes that do not
appear in these tables, contact Customer Support to determine whether you will be required to
migrate to a supported class.

Deprecated APIs

The “Deprecated APIs” section in these Release Notes lists all Identity Manager Application
Programming Interfaces (APIs) deprecated in this release and their replacements (if available).
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Upgrade Paths and Support Policies

Upgrade Paths and Support Policies

This section provides information about the upgrade paths you should follow when upgrading
Identity Manager, and describes Identity Manager’s End of Service Life (EOSL) policy for the

products software support.

|dentity Manager Upgrade Paths

Use the following to determine the upgrade path you must follow when upgrading to a newer

version of Identity Manager.

NOTE

Upgrading to Identity Manager 8.0 is recommended. When you upgrade to the

latest software release, you get the latest new features, bug fixes, and supported
resource versions.

Current Identity

Target Identity Manager Version

Manager Version 2005Q3M1  2005Q4M3 7.0 741 7.1 Update 1 8.0
Identity Manager 5.0 SPx 2005Q4M3 > 2005Q4M3 >
2005Q3M1  2005Q4M3 5000504'\"3 > 5010504'\"3 > 71> 71>
’ ’ 7.1 Update 1 8.0
Identity Manager 2005Q4M3 > 2005Q4M3 >
2005Q1M3 2005Q3M1  2005Q4M3 3000504'\"3 > 3010504'\"3 > 71> 71>
Identity Auditor 1.0 ' ' 7.1 Update 1 8.0
Identity Manager 2005Q4M3 > 2005Q4M3 >
7.0 71
Identity Manager 5.5 7.1 Update 1 8.0
Identity Manager 2005Q4M3 > 2005Q4M3 >
7.0 71
Identity Manager SPE 1.0 7.1 Update 1 8.0
2005Q4M3 (6.0) 71>
7.0 71 7.1 Update 1 7.1>8.0
Identity Manager 7.0 71>
7 7.1 Update1 o0
Identity Manager 7.1 7.1 Update 1 8.0
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NOTE e When upgrading Identity Manager, you do not have to install Updates (formerly
called Service Packs or SPs) within a major release to upgrade to the next major
release. For example, when upgrading from Identity Manager 5.0 to 6.0, you do
not have to install any of the 5.0 Service Packs.

e Updates for a major release are cumulative. After upgrading to the major release,
you can install the latest Update without having to install all of the Updates (or
Service Packs) for that release. For example, if you upgraded to Identity Manager
5.0, installing SP6 gives you all of the functionality provided in SP1 through SP5.

¢ Identity Manager Installation Pack 2005Q4M3 (version 6.0) was a major release.
If you are upgrading from a pre-6.0 version of Identity Manager, Identity
Auditor, or Identity Manager Service Provider, you must upgrade to Identity
Manager Installation Pack 2005Q4M3 before advancing to later releases.

Updates to the Identity Manager documentation are provided as follows:

* For Every release (including Service Packs): Release Notes are provided to describe bug
fixes, product enhancements, new functionality, and other important information.

* For Major releases (x.0): The complete Identity Manager documentation set is updated and
republished.

* For Minor releases and updates: Individual publications are updated and republished or
Documentation Addendum are provided.

End of Service Life for Software Support

During the End of Service Life (EOSL) period, Identity Manager software support is offered in two
phases:

®  Phase 1: Full Support
®  Phase 2: Limited Support

NOTE The length of the Full Support Phase varies by product.

Full Support Phase

During the Full Support Phase, Sun Microsystems, Inc. provides software support in accordance
with the customer's support contract with Sun (including the applicable Service Listing) as set
forth at:
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http://www.sun.com/service/servicelist/

However, when a software product’s EOL date is announced, customers will no longer have access
to software updates and upgrades for that software product.

Limited Support Phase

During the Limited Support Phase, Sun Microsystems, Inc. provides software support in
accordance with the customer's support contract with Sun (including the applicable Service Listing)
as set forth at:

http://www.sun.com/service/servicelist/

However, customers are not entitled to submit bugs or to receive new patches from Sun
Microsystems, Inc. As with Full Support Phase, after the software product’s announced EOL date,
customers will no longer have access to software updates and upgrades for that software product.

The following table provides information about the EOSL and EOL dates for older versions of
Identity Manager.

Product Last Phase 1 Phase 2 EOL
Product Name Status Ship Date End Date End Date (EOSL) Announcement
Sun Java System Identity Post-RR
Manager 7.0
Sun Java System I|dentity Post-RR 05/25/2007 05/25/2008  05/2012 11/20/06
Manager 6.0 2005Q4
Sun Java System Post-RR 02/02/2007 02/2008 02/2012 08/01/06
Identity Auditor 1.0 2005Q1
Sun Java System Post-RR 02/02/2007 02/2008 02/2012 08/01/06
Identity Manager Service
Provider Edition 1.0 2005Q3
Sun Java System EOL 08/11/2006 08/2007 08/2011 02/07/06
Identity Manager 5.0 2004Q3
Sun Java System Identity EOL 08/11/2006 08/2007 08/2011 02/07/06
Manager 5.0 SPx 2004Q3
Sun Java System EOL 08/11/2006 08/2007 08/2011 02/07/06
Identity Manager 5.5
Waveset Lighthouse 4.1 03/2006 03/2010
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|dentity Manager’s Deprecation Policy

See Identity Manager Upgrade for a complete description of Identity Manager’s deprecation policy
for removing interfaces or changing behaviors.

Redistributable Files

Sun Java System Identity Manager 8.0 does not contain any files that you can redistribute.

How to Report Problems and Provide Feedback

If you have problems with Sun Java System Identity Manager, contact Sun customer support using
one of the following mechanisms:

Sun Software Support services online at
http://www.sun.com/service/sunone/software

This site has links to the Knowledge Base, Online Support Center, and ProductTracker, as
well as to maintenance programs and support contact numbers.

The telephone dispatch number associated with your maintenance contract

So that we can best assist you in resolving problems, please have the following information
available when you contact support:

Description of the problem, including the situation where the problem occurs and its
impact on your operation

Machine type, operating system version, and product version, including any patches and
other software that might be affecting the problem

Detailed steps on the methods you have used to reproduce the problem

Any error logs or core dumps
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Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and suggestions.

To share your comments, go to http://docs. sun.com and click Send Comments. In the online form,
provide the document title and part number. The part number is a seven-digit or nine-digit number
that can be found on the title page of the book or at the top of the document. For example, the title
of this book is Sun Java System Identity Manager May 2008 Release Notes, and the part number is
820-2958-10.

Additional Sun Resources

Useful Sun Java System information can be found at the following Internet locations:

¢ Documentation for Sun™ Identity Manager
http://docs. sun.com/app/docs/prod/ident .mgr#hic

* Sun Java System Documentation
http://docs.sun.com/prod/java.sys

* Sun Java System Professional Services
http://www.sun.com/service/sunps/sunone

* SunJava System Software Products and Service
http://www.sun.com/software

* Sun Java System Software Support Services
http://www.sun.com/service/sunone/software

* Sun Java System Support and Knowledge Base
http://www.sun.com/service/support/software

* Sun Support and Training Services
http://training.sun.com

* Sun Java System Consulting and Professional Services
http://www.sun.com/service/sunps/sunone

* Sun Java System Developer Information
http://developers.sun.com
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Sun Developer Support Services
http://www.sun.com/developers/support

Sun Java System Software Training
http://www.sun.com/software/training

Sun Software Data Sheets
http://wwws . sun.com/software
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|dentity Manager 8.0 Features

This section of the Identity Manager 8.0 Release Notes provides information about

What’s New in This Release

Bugs Fixed in This Release

What's New in This Release

This section provides additional information about the new features provided in Identity
Manager 8.0, and the information is organized into the following sections:

Major Features

Administrator and User Interfaces

Auditing

Data Exporter

Forms

Identity Manager Business Process Editor (BPE)
Identity Manager Integrated Development Environment (Identity Manager IDE)
Installation

Password Synchronization

Reports

Repository

Resources

Roles

Scenarios

Security

Server

SPML

Synchronization

Other
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What's New in This Release

Sun’s New Patch Process

Beginning with the release of Identity Manager 7.1 Update 1, updates containing major and critical
customer-reported bug fixes are now delivered through a patch process, which replaces the older
hot-fix process.

Patches are developed, tested, and released in six-week intervals. These patches have a GUI
installer as well as a manual installation option, and they update the files in /WEB-INF/1ib.
Instructions for installing the patch will be included in the patch Release Notes, which are
distributed in PDF format. Any fixes to the Gateway or to Password Sync will be described in the
Release Notes and will require updating with the installation of the patch.

Identity Manager patches are cumulative, so you can expect fewer problems with unique fixes. You
should plan to update to the latest patch level when installing or upgrading to a major or minor
release. For example, if patch 3 is available when you install or upgrade to 8.0, you should apply
patch 3 after installing or upgrading to 8.0. You would not be required to install patches 1 and 2
because patch 3 contains all the functionality in the previous patches.

The patch process also makes it easier for you to track a fix by its actual bug number. However, it is
still possible that a fix made against an older version may not yet be available in a newer version.
Regardless of which process your current version of Identity Manager follows, you must confirm
that the new, target Identity Manager version contains all of the bug fixes that you need.

When a new patch is released, an announcement is sent to all of customer support. Patches are
available through customer support. Please contact Sun customer support at
http: //www.sun.com/service/online/us for the latest patch available.

Major Features

Identity Manager 8.0 provides the following major new features:
¢ Role Enhancements
e Enhanced Reporting with Data Exporter

¢ Attribute Configuration

Role Enhancements

Identity Manager 8.0 adds Role life cycle management providing the ability to require change
approval on Role creates, edits and deletes as well as apply Role changes to all assigned Users. In
addition, User-to-Role Life cycle management has been improved enabling support for future and
temporary Role assignments. Role types with configurable features, including by default, Business
Roles, IT Roles, Applications, and Assets, are now provided to encourage best practices with
regards to Role management. For example, Business Roles can contain roles required by all,
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conditional for some, and optional (by request and may require approval) for others. This enables
the ability for the Business Role designer to define coarse grain access, while delegating to the user
or the user's manager the ability to fine tune the access assigned to each user, within the scope of a
single Business Role.

Enhanced Reporting with Data Exporter

The Data Exporter feature has been added to allow the operational data used and produced by
Identity Manager to become available for use by other processes and applications . Data Exporter
allows data held by and flowing through Identity Manager to be periodically exported to a
customer-managed data warehouse or third-party business intelligence and reporting tools. Data
Exporting is optional, and when enabled customers can configured when and what data is
exported. The exported data can be used to answer historical questions regarding 'Who had access
to Resource X, and who approved that access?'. It can also be used to provide reports on IdM's
operational behavior over time, such as Provision Operations by Resource' and 'Workflow Manual
Action Response Times'. Decoupling the operational data (held inside the Identity Manager
repository) and the historical data (exported by Data Exporter) gives the user explicit control over
the lifecycle of this data. Providing the data in a documented, schema-conformant manner gives the
user the ability to construct and execute analysis processes that will remain valid across future
releases of Identity Manager.

Attribute Configuration

Extended, queryable, and summary attributes can now be configured for roles as well as users. The
new extended attribute configuration supports specification of value syntax (STRING, INT, DATE,
or BOOLEAN), whether the attribute can have a single or multiple values, and a text description for
the attribute.

Administrator and User Interfaces

¢ Users now can specify a custom form for the Question Login form and Anonymous Login
form through the Configure Form and Process Mappings page. (ID-4697)

* The role administration interface has been enhanced to support the new roles functionality.
See the “Roles and Resources” chapter in the Identity Manager Administration 8.0 publication
for details. (ID-15518)

¢ By default, process diagrams have been turned off in this release of Identity Manager.
Process diagrams can be turned on by modifying the System Configuration object and
restarting your application server(s). For instructions, see the “Enabling Process Diagrams”
section in Identity Manager Administration 8.0. (ID-16337)
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An optional safe-guard has been added to the Edit Reconciliation Policy page. This option
evaluates the number of missing accounts on a resource and, if a threshold is exceeded,
prevents the reconciler from unlinking them. See the “Data Loading and Synchronization”
chapter in the Identity Manager Administration 8.0 publication for details. (ID-16391)

Identity Manager's behavior has changed with regards to users with pending work items
who need to be deleted from Identity Manager. For details, see Identity Manager
Administration 8.0, "Administration" chapter, "Managing Work Items" section, "Delegations
to Deleted Users" subsection. (ID-16417)

When defining an AdminRole, the scope of control can be specified to exclude all
controlled child organizations and their contained objects by selecting the Exclude All
Controlled Child Organizations and Contained Objects checkbox. If not selected, a user
assigned the AdminRole will be granted the associated capabilities on all child
organizations and their contents. (ID-16859)

Admin roles now will be displayed as names in search results. (ID-17130)

Identity Manager 8.0 simplified the results pages in the End User Interface to display a
status message. The default upgrade setting is to retain the original process diagrams,
while new installations display the status message. The process diagram option can be set
to default by clicking Configure->User Interface and enabling the Enable End-User Process
Diagrams setting.

To enable process diagrams for the end user interface, process diagrams must be enabled
for the product as a whole. For more information on enabling process diagrams for the
product as a whole, please reference ID-16337 in Administrator and User Interfaces.
(ID-17365)

The end-user login form has been simplified and rearranged to improve usability.
The JSP user/login.jsp has been modified, so any user customizations to this file will
need to be manually merged on upgrade. (ID-17368)

The new default End User Password Change form allows users to change their password.
The password policies for all resources assigned to the user are aggregated and
summarized in this form, and password changes apply to all assigned resources. The
original Basic Change Password form should be specified for deployments in which the
user needs to select which resources to apply the password change. (ID-17371)

The error message presented to users at login indicating the need to answer authentication
questions is now rendered as a warning. (ID-17549)

When the Anonymous Enrollment feature is enabled, the end-user User Interface no longer
displays a "Request Account" button. Instead, the text "First time user?" displays, followed
by a "Request Account” link. Additional information is displayed below the link. The text
on this page is customizable. See the Identity Manager Technical Deployment Overview
publication for details. (ID-17582)
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The DatePicker display component now has a disableTextInput property that can be
utilized to prevent user input via a text field, which forces the user to select a date via the
pop-up calendar. (ID-17586)

Auditing

Audit log entries that describe resource account provisioning actions will now be visible to
audit administrators in the object groups that contain the affected resources, whether or not
these groups contain the user that is the subject of the action. (ID-17724)

Email notification events are now audited. In the Administrator interface, there is a new
Audit Group on the Audit Configuration page (Configure > Audit) named Event
Management. (ID-17734)

Data Exporter

Data Exporter allows Identity Manager data to be periodically exported to a
customer-managed data warehouse for further processing.

Forms

Fields having a “confirm” property value referring to a source component (for example, the
Confirm Password field of the tabbed user form) no longer have their values automatically
set to the source component’s value when the form is submitted to the server and the
confirm component’s value is null. Because of this change, ensure that any source/confirm
field pairs having a default expression apply the expression to both the source field as well
as the confirm field. (ID-17838)

|dentity Manager Business Process Editor (BPE)

The Business Process Editor (BPE) is deprecated, and will be removed in the next major
release of Identity Manager. Please use the Identity Manager Integrated Development
Environment (Identity Manager IDE) instead. (ID-17510)
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|ldentity Manager Integrated Development
Environment (Identity Manager IDE)

The Identity Manager Integrated Development Environment (Identity Manager IDE)
application is now provided on https://identitymanageride.dev.java.net. Instructions for
installing, configuring, and migrating projects are also provided on this site. (ID-17700)

Installation

This version of Identity Manager no longer supports the following application servers:
(ID-16369)

o  Apache Tomcat Version 4.1.x

o BEA Weblogic Express 8.1

o BEA Weblogic Server 8.1

o IBM Websphere Application Server - Express Version 5.1.1
o IBM Websphere 6.0

o Sun ONE Application Server 7

Password Synchronization

28

Versions of PasswordSync that are older than version 7.1.1 should be updated to at least
version 7.1.1 on all domain controllers.

Support for the rpcrouter?2 servlet has been deprecated in version 8.0 and will be removed
in a future release. PasswordSync versions 7.1.1 and newer support the new protocol.

See the Identity Manager Administration book for information on how to install
PasswordSync.

There are separate installers for the 32-bit and 64-bit versions of PasswordSync. The 32-bit
installer will now only run on 32-bit versions of Windows, and the 64-bit version will only
run on 64-bit versions of windows. Attempting to run the incorrect version of the installer
will cause an error. (ID-17290)
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Reports

Identity Manager Usage Reports and Identity Auditor Policy Violation Reports now
include charts when downloaded in PDF format. (ID-10719)

A new report named “Individual User Audit Log Report" is now available. As with the
AuditLog reports, the Individual User AuditLog report is based on events captured in the
system audit log. This report, however, prompts for a user to report on, and returns a list of
activities that have been performed on that user. For more information, see the “Reporting”
chapter in the Identity Manager Administration 8.0 publication. (ID-16976)

The AuditReportTask (and any report that uses the LogRecordFormatter) can now select
which columns appear on the report. Use the useCustomColumns and customColumns
attributes in the TaskDefinition and the TaskTemplate. (ID-17712)

You can now customize reports so that administrators who have only run-report
capabilities can specify report parameters before running a report. (ID-17733) This change
allows these administrators to set the report parameters before running the report or before
downloading a .csv or .pdf file. Identity Manager does not save changes to the report
definition that are generated this way.

To use this feature for existing reports, add alwaysProcessForm (set to true) to the
TaskTemplate. To add this feature to new reports other than the Individual User Auditlog
Report, add a field named alwaysProcessForm (set to true) to the TaskDefinition launch
form.

The administrator who is executing a report with alwaysProcessForm (set to true), should
have the appropriate capabilities to fetch the desired data from the repository. For example,
if the report will report on roles, the administrator must have the capability to obtain a list
of available roles.

You can select which columns appear in the Individual User Audit Report Task report (and
any report whose executor is com.waveset.report. AuditReportTask) by working with the
useCustomColumns and customColumns attributes in the Task Definition and the Task
Template. Any report other than the Individual User Audit Report will require
taskDefinition and TaskTemplate objects to be updated to include the customColumns
feature. (ID-17744)

o useCustomColumns -- (Boolean) Specifies whether the custom column feature is on.

o customColumns -- (Map) Specifies the columns to include in the report, where key
identifies the Message Catalog key, and value represents the Message Catalog value.

See the Individual User Audit Report for an example.

The Download buttons are now available on the main Reports page for an IDM
administrator who has only Run Audit Report capability. (ID-17881)
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Repository

Identity Manager installations that use Oracle as the repository have the option of
converting the accountAttrChanges field in the audit log table from VARCHAR (4000) to CLOB.
This change is optional, and should only be performed if you have noticed truncation
errors in the audit log. The sample DDL script is in
web/sample/convert_log_acctAttrChangesCHAR2CLOB.oracle.sql. Be sure to back up the
affected tables before running the conversion script. (ID-17343)

Resources

New Resource Adapters

The following new resource versions have been added this release:

The Sybase ASE resource adapter replaces the deprecated Sybase resource adapter. The
Sybase ASE adapter provides the ability to manage users in multiple databases. (ID-16872)

Resource Adapter Updates

The mainframe adapters support IBM Host on Demand V10. (ID-6419)

The Microsoft SQL Server adapter resource wizard now simplifies the selection of
databases and automatically maintains the userName$ (dbname) and roles$ (dbname)
attributes in the schema accordingly. (ID-8546)

The SAP adapters can now display internationalized messages. (ID-9077)

The com.waveset.adapter.AttrParse class has been removed. Use
com.waveset.object.AttrParse instead. (D-11870)

The UNIX adapters now support SSHPubKey connections. This new feature allows users to
connect to remote hosts without entering a password for a trusted workstation. (ID-11959)

The SAP adapter can provision to any SAP table called by BAPI_USER_CREATE1 and
BAPI_USER_CHANGE, most notably the GROUPS and PARAMETER tables. (ID-12217)

The name of an Account can now include "@" symbols as long as the resource that defines
the account allows this. (ID-12383)

Resource names and resource IDs must not include "@" symbols. A resource name or a
resource IDs that contains an "@" symbol will cause Identity Manager to parse the View ID
incorrectly.
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A new boolean account attribute TSO.Delete Segment has been added to the RACF and
RACF_LDAP resources. If this Attribute is set to true, the TSO Segment will be deleted
from the RACF user. (ID-13347)

If you are upgrading and want to include this attribute, add the following element to the
AccountAttributes section of the Resource definition:

<AccountAttributeType id='<next ID in sequence>' name='Delete TSO Segment'
syntax='boolean' mapName='TSO.Delete Segment' mapType='boolean' writeOnly='true'>

The RACF and RACF LDAP adapters can be configured to support attributes that are not in
the segments supported by default. (ID-13351)

The SAP Resource Adapter now returns the list of available user types and user groups.
(ID-16123)

The same gateway can now be used for provisioning and pass-through authentication.
NetWare accounts. See the Identity Manager Resources Reference for information about
implementing this feature. (ID-16584)

The Ignore Siebel 8.0 nextRecord() Error resource parameter allows the Siebel CRM
adapter to ignore the nextRecord() error that occurs on Siebel 8.0. For more information
about this error, refer to Siebel Alert 1315. (ID-16779, 18159)

The SAP adapter does not attempt to rename accounts when the Enable CUA resource
attribute is set to true. (SAP does not support renames when in CUA mode.) (ID-16986)

The database table resource adapter now supports renaming accounts. (ID-16993)

Added the Number of Users Read per Connection resource parameter to the SAP adapter.
This parameter ensures that memory is being released in a timely manner. (ID-17017)

The Solaris resource adapter can now force users to change their passwords upon next
login. To enable this feature, add expirePassword to the Identity System User Attribute
column of the schema map and force_change to the Resource User Attribute column. This
attribute type must be set to string. (ID-17032)

The SAP, SAP HR, and AccessEnforcer (underlying SAP implementation) adapters now
support Secure Network Communications (SNC). See the Identity Manager Resources
Reference for information about implementing this feature. (ID-17059)

The built-in Identity Manager pool for JDBC connections has been improved to support a
maximum idle timeout. Connections which are held unused in the pool longer than the
maximum idle timeout are closed and discarded. (ID-17107)

During an upgrade to 8.0, existing resource instances of the following adapters will be
altered to use a setting of 600 seconds (10 minutes) for the maximum idle timeout:

o Database Table
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o  Microsoft SQL Server
o MIIS

o  Oracle ERP

o Oracle

o  Scripted JDBC

o Sybase ASE

Custom resource adapters that extend JdbcResourceApapter can also take advantage of the
new feature by adding a new resource attribute named idleTimeout.

The debug/show_JDBC. jsp page has been enhanced to display additional related to idle
timeouts.

Identity Manager SAP adapter now provides the accountLockedNoPwd and
accountLockedWrngPwd account attributes. The accountLockedNoPwd attribute indicates
whether the account is locked because the user has no password. The
accountLockedWrngPwd attribute indicates whether the account is locked because of
failed login attempts. (ID-17296)

The sendKeys (EncryptedData) method has been added to the HostAccess class and can be
used to avoid logging passwords. (ID-17544)

The database table adapter handles the Oracle timestamp datatype properly if you select
the Native Timestamps check box on the Resource Parameters page. (ID-17551)

A new resource parameter, Receive Timeout, is now available on the JMS Listener adapter.
It allows you to configure how long the adapter will wait for an incoming message before
terminating the poll. It is defaulted to 10 seconds. (ID-17935)

The JMS Listener adapter now establishes a new connection for each poll. (ID-17941)

The JMS Listener adapter can now be monitored with Java Management Extensions (JMX).
(ID-17943)

Password updates to NDS Groupwise now handle encrypted passwords correctly.
(ID-18020)

A resource parameter, Search Scope, has been added for Sun Access Manager resources in
legacy mode. This attribute specifies the scope for searches of Access Manager objects.
Valid values are oneLevel and subTree. subTree is the default value. (ID-18079)
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Roles

Owners can be specified for each role either statically or dynamically with a rule.
(ID-10602)

When you import roles containing links to back to existing super roles, Identity Manager
now updates the existing roles with links back to the newly imported roles. (ID-15482)

Identity Manager detects and creates links from existing super roles back to the subroles
that reference them. During upgrade, Identity Manager invokes the RoleUpdater class used
to repair the roles.

You can update roles outside the upgrade process by importing a new RoleUpdater.xml
file found in sample/forms/RoleUpdater.xml. By default, Identity Manager adds the
subrole links during upgrade or when you import RoleUpdater . xml.

To disable this new functionality, set the RoleUpdater attribute nofixsubrolelinks to true.
For example,

<MapEntry key='nofixsubrolelinks' value='true' />
See ID-15053 for related information about automatically updating roles during import.

Role management in Identity Manager has undergone a major revision. New functionality
has been added that greatly enhances the ability to do Role life-cycle management, as well
as User-to-Role life-cycle management. Identity Manager now supports four role types:
Business Roles, IT Roles, Applications, and Assets. Organizations that upgrade from an
earlier version of Identity Manager to version 8.0 will automatically have their legacy roles
converted to IT Roles. For detailed information on how roles work in Identity Manager 8.0,
see the “Roles and Resources” chapter in Identity Manager Administration 8.0. (ID-17677)

The role administration interface now supports the ability to apply role changes to assigned
users. (ID-17719)

The user summary and role reports now report more information about roles and role
assignments. (ID-17751)

Identity Manager now supports extended attribute values on roles. (ID-17770)

Scenarios

Identity Manager 8.0 does not include the Sun Communications Services scenario
previously located in idm/sample/scenariol, and the HR Database/Active Directory
Deployment scenario previously located in idm/sample/scenario2. References to these
scenarios are no longer included in the Identity Manager Technical Deployment Overview.
(ID-18519)
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The question login interface now works naturally when used with pass-through
authentication using LDAP and AD resources. Previously, when users forgot their
passwords, they were required to enter their Identity Manager account ID (which they
might not have known) instead of the resource account ID. The interactive challenge page
now requires the user to re-enter both their resource account ID and password, where
previously only the password was required. (ID-9616)

SSH authentication now allows private/public key pairings. This new feature allows users
to connect to remote hosts without entering a password for a trusted workstation.
(ID-11959)

Passwords stored in the password history section of the user object will now be stored in
original case. The comparison made during enforcement of the password policy remains
case-insensitive, so this change will not affect product behavior. (ID-12705)

This release includes a security feature to prevent Cross-site Request Forgery (CSRF)
attacks. The feature is not enabled by default. Cookies are required to use this feature. If
you have cookies disabled for security reasons, do not enable this feature as it will prevent
you from using Identity Manager. There is no user-sensitive data present in the cookie, and
it only lives in memory during a user's session. (ID-16703)

To enable the security guard, edit the system configuration object and change
security.csrfGuardToken.enable to true. See Identity Manager Administration 8.0 for
instructions on how to edit the system configuration object.

Identity Manager now includes a new task-based capability named Debug that the Identity
Manager debug pages require before users can access and execute operations. Previously,
users with certain capabilities could potentially access and execute operations from the
debug pages without proper permissions. Now, users who do not have the Debug
capability will be sent to an error page. By default, the administrator and configurator users
are assigned this capability. Additionally, the Waveset Administrator and Security
Administrator capabilities include this new Debug capability. (ID-16999)

The ability to set an expiration period for accounts that have been locked due to multiple
errors in answering questions to login has been added. To implement this feature select the
following options:

o Under Security / Policies, select a policy to edit.

o Under "User Account Policy Options" see the new option: "Account lock created by
failed question logins expires in" which can have a value and a time unit set. A value of
0 means that question locks will never expire. (ID-17139)
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Failed password and question login counters are not cleared during automatic account
lockout expiry. Both failed password and failed question login attempts are correctly
displayed in end-user and administrator interfaces. (ID-17412)

Waveset.properties now includes the ui.web.baseHrefURL property to support
configuration using relative URLs. (ID-17763)

Identity Manager now supports configuration of PKCS#11 keystores. To incorporate the
keystores, it was necessary to make a non-backwards-compatible change to the
TransactionSigner HTML component. (ID-17769)

The display property supportedKeyStoreTypes is no longer supported. There is now a
single-valued supportedKeyStoreType. This can be one of the following: JKS, PKCS12,
PKCS11. The default is determined by the system configuration property
security.nonrepudiation.defaultKeystoreType. In general, it should be sufficient to
simply set the system-wide property security.nonrepudiation.defaultKeystoreType.

In order to add PKCS11 signing support, the TransactionSigner applet must use
functionality only available in JRE 1.5. Any clients using the TransactionSigner applet
must have JRE1.5 installed and configured as the JRE for their browser.

Identity Manager now provides support for relative URLs. (ID-18507)

To implement this feature, set the following values in the Waveset.properties file:
o  Set the ui.web.relativeURL property to true.

o Setui.web.useBaseHref property to false.

o Setui.web.baseHrefURL property the context where Identity Manager is deployed in
the form of /IDM/ (for example, ui.web.basehrefURL=/1idm/ ).

Server

Performance now significantly increases as the number of users that are dynamic members
of an object group increases. (ID-17561)

Identity Manager 8.0 consolidates the locations where an administrator specifies extended,
queryable, and summary attributes for user objects into the new IDM Schema
Configuration object. (ID-17784) In prior versions of Identity Manager, an administrator
edited the User Extended Attributes configuration object to add extended attributes for
user objects and the UserUIConfig configuration object to specify additional queryable or
summary attributes for user objects. An administrator now edits the IDM Schema
Configuration object for these purposes.
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Changes to the IDM Schema Configuration object are not effective for an Identity Manager
server until the next time the server starts. The presence of the IDM Schema Configuration
object inhibits re-conversion. For more information, see the “Upgrade Issues” section of the
Release Notes.

SPML

The OpenSPML implementation now includes a SPML timeout setting for Web Service
calls. (ID-17687)

Those who used SPMLv?2 in previous releases, and depended on the value of the
"objectclass” attribute, should be aware that the value of that attribute is now maintained
under the "spml2ObjectClass" attribute. (ID-17757)

Synchronization

Previously, the idmManager attribute was not showing up under the activesync namespace
on certain adapters during Active Sync form processing. In this release, the toHashMap
method has been modified to append the idmManager attribute to the returned Map so
that it can be synced against during Active Sync. (ID-16717)

Other

The com.waveset.server.Server functions public Map getResourceObjectListCache ()
and public Map getResourceObjectGetCache () have been deprecated. These caches are

internal data structures. Code depending on these structures will no longer function.
(ID-14790)

Identity Manager now has a product registration feature. To register, you will need a Sun
Online Account and password. If you do not have a Sun Online Account, you can register
for one by completing the form at this address: (ID-17133)

https://reg.sun.com/register

Identity Manager can be registered from the console or by using the Administrator
interface. Registering from the console allows you to also create a local service tag, which
can be used with Sun Service Tag software to track your inventory of Sun systems,
software, and services. For more information, see the “Registering Identity Manager”
section in Identity Manager Administration 8.0.
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When using the Product Registration feature, if your application server is not configured to
allow outgoing SSL connections, you may receive the following error message: (ID-18546)

Failed to register on Sun Connection server due to invalid Sun Online Account
user/password.

To resolve this issue, add the appropriate trusted root certificate(s) to your application
server's keystore. Consult your application server's documentation for details.

When using the Product Registration feature, if old versions of xml-apis.jar and
xercesImpl.jar are present in your application server's classpath, you may receive the
following error message:

java.lang.NoSuchMethodError:org.w3c.dom.Node.getTextContent () Ljava/lang/String;

To resolve this problem, modify the classpath so that only the most recent versions of
xml-apis.jar and xercesImpl.jar are present. (ID-18547)

When using the Product Registration feature, Java on your Identity Manager server(s) must
be properly configured for SSL. All JARs referenced in your java.security file (or
equivalent) need to be present. (ID-18548)
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Bugs Fixed in This Release

This section describe the bugs fixed in Identity Manager 8.0, and the information is organized as
follows:

e Administrator and User Interfaces
e Auditing

¢ Delegations

e Forms

e Installation

e ]h Console

¢ Logging

¢ Organizations

* Provisioning

* Reports

* Repository

* Resources

* Roles

* Security

* Server

e Service Provider

* Synchronization

e Workflow

e Additional Defects Fixed
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Administrator and User Interfaces

Users now can specify a custom form for the Question Login form and Anonymous Login
form through the Configure Form and Process Mappings page. (ID-4697)

The DatePicker form UI component now supports action=true. (ID-4930)
The NetCharts applet has been replaced by a JGraph image. (ID-14736)
The Server Tasks table now sorts correctly based on type. (ID-14850)

When enforcing a password policy, Identity Manager was not including the initial user
password in the password history. Instead, only changed password values were being
tracked. This meant that if a policy stated that the past three passwords could not be
reused, and a user had only changed their password twice, Identity Manager would still
allow the initial password to be reused. This bug has been fixed in this release. (ID-15026)

When unassigning resource accounts from a user using the Edit User functionality in the
UL, the SITUATION of the accounts in the account index are now properly updated in all
cases. (ID-15310)

Previously, the end-user interface menu that allowed approval work-items to be forwarded
to another approver was not populated correctly. This has been fixed. Now this list is
populated with a list of approvers that is within the scope of control of the user logged into
the end-user interface. (ID-15935)

Previously, when a timeout occured on a ManualAction Workltem, the timeout error was
not returned to the user. Instead, the user would receive a stale workflow process diagram
that would give the impression that the form was processed correctly. This has been fixed.
Now, the user is redirected to the workItemTimeout.jsp page unless the IgnoreTimeout
option is enabled. (ID-16467)

You can now edit and save current or previous workltem delegations. (ID-16564)

When an administrator creates delegations on behalf of a user, the administrator cannot
select delegates outside of the user's scope of control. The administrator’s scope of control
is now the same as the user on whose behalf the delegation is being made. Previously,
when creating delegations on behalf of a user, administrators could select delegates that
users could not. (ID-16561)

The Ul will now display failed password login and failed authentication question login
numbers when Sun Identity Manager is unable to authenticate a user. (ID-17188)

Sorting in the user interface Pending Approvals table works correctly. (ID-17304)

The results page following an operation now always includes an OK button. (ID-17482)
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A confirmation page indicting success or failure always displays after setting a password
through the Forgot My Password button for new installations and upgrades where the
System Configuration.forgotPasswordChangeResults.User hasnotbeen explicitly set. If
the System Configuration.forgotPasswordChangeResults.User was explictly set, the
behavior remains unchanged. (ID-17619)

Drop-down boxes for month values now display a complete list of months in all browsers.
(ID-17740)

Several cross-site scripting (XSS) vulnerabilities are now fixed. (ID-17748, 18054)

Tables generated by the SimpleTable Ul display component and the gentable.jsp file now
correctly close <TH> tags in the rendered HTML. (ID-17945)

When a single browser is connected to both the end user interface and the administrative
interface, forms are now displayed only at the appropriate interface. (ID-18039)

JavaScript is not allowed in the Status column of the resource lists, but safe HTML markup
is allowed in the string content and is now displayed correctly. (ID-18050)

An error in the bulk operations Form now generates an InlineAlert without visible HTML
markup. (ID-18338)

A directory traversal vulnerability has been fixed in the Ul, which allowed users to gain
unauthorized access to files residing on the Identity Manager server. (ID-18653)

The List Accounts page now displays in more quickly. (ID-18751)

Auditing
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The Audit log now properly logs “Prioritize” actions. (ID-16924)

Previously, when creating an Audit Policy where the policy is restricted to a resource with
an account type, a NullPointerException would occur in the user interface. This problem
has been fixed. (ID-16977)

Previously, creating an Audit Policy rule using “isTrue” would result in an error stating the
rule requires a comparison value. This problem has been fixed. (ID-17041)

Attestation comment text is no longer cleared inappropriately. (ID-17418)
Email notification events are now audited. (ID-17708)

Duplicate database keys are now removed from the audit log. The duplicate keys are
extended type (AV) and extended action (PE). (ID-18642)
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The actions that are logged with the PE key are EndProcess and PreOperation. The
PreOperation action now uses a DB key of PP. The types that are logged with AV are
AccessReview and AccessReviewWorkflow. The AccessReviewWorkflow type now uses a
DB key of AW.

Existing audit records with PE are interpreted as EndProcess actions by auditlog reports.
Existing records with AV are now interpreted as AccessReview.

Updating audit records in the database with SQL can be a security concern (because the
records will appear to have been tampered with), so it is recommended that these records
(with PE or AV as the logDb Key) created before version 8.0 be ignored.

Delegations

* Delegation cycles are now checked at execution time and at creation time. (ID-17387)

¢ Inatwo-hop delegation, any existing remediation work items now revert back to the first
delegator when the first delegator ends the delegation for remediation work items.
(ID-18435)

* All possible work item types that can be delegated now appear in the drop down list when
delegation is being configured. In the Administrator Ul, the delegation drop down no
longer filters the work item types that appear, so all possible work item types that can be
delegated are now listed. In the end user Ul, only the five basic work item types are listed
in the drop down list. (ID-18496)

¢ Identity Manager 8.0 added role type and role change approvals (including role type
specific change approval), along with the ability to delegate these work item types. Support
was also added to allow specific roles to be designated when delegating new role type or
role change work item types. (ID-18558)

Forms

* MultiSelect supports a new property, displayCase, which can be set to either upper or
lower. This convenience feature is equivalent to a defined valueMap that maps each of the
allowed values to their uppercase or lowercase equivalents. (ID-8356)

Installation

¢ If you are upgrading from 6.0 or 7.0 to version 7.1 or 8.0, and using LocalFiles, you must
export all of your data before upgrading and then re-import the data afterdoing a clean
installation of 7.1 or 8.0. (ID-15366)
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Ih Console

¢ The lh syslog command now correctly returns matching records when a very large number
of days is specified. (ID-17844)

Logging

* The com.waveset.ui.FormUtil class now prints a brief message to the application server
log that refers to the system log when ClassNotFoundException errors (and other errors,
when encountered in this class) occur. The System log now contains the details of the error.

Previously, the stack traces of these exceptions were printed the application server log.
(ID-18473)

Organizations

* The User and ObjectGroup objects were enhanced (defect 14973) to support multiple
per-user / per-objectgroup custom forms, extending the two (View User, Edit User) that
they previously supported. These new forms are stored in a <CustomForms> element in the
XML for both User and ObjectGroup. waveset .dtd did not declare <CustomForms> as an
element of <ObjectGroup>, so an ObjectGroup XML with custom forms would not validate.
This defect adds <CustomForms> as an element to waveset.dtd. (ID-17812)

Provisioning

e If multiple resources fail to provision on the initial provisioning attempt and they have
different retry periods, all resources where provisioning failed are now retried as specified
by retry period and retry count. Previously, only the resources with the shortest retry
period were actually retried. (ID-18190)

Reports

* The ReportsConfig and TrackedEvents objects are now preserved when upgrading from a
previous release. (ID-17363).

To overwrite the existing "Reports Configuration" objects (ReportsConfig and
TrackedEvents), after the upgrade process is complete, remove the following text below
from the top of the reportConfig.xml file, and import the file into the Identity Manager
Repository.

42 Sun Identity Manager 8.0 * Release Notes



Bugs Fixed in This Release

<ImportCommand type='preserve'>
<ObjectRef type='Configuration' id='#ID#Configuration:ReportsConfig'/>
<ObjectRef type='Configuration' id='#ID#Configuration:TrackedEvents'/>
</ ImportCommand>

You can now concurrently execute Reports that have the same Task name by clicking the
Allow Reports to Execute Concurrently? checkbox on the Report page. (ID-14631)

When editing a report, the report can now be executed with the Run button without the
side effect of saving the report changes automatically. Use the Save button to save the
changes to a report. (ID-17212)

Some html email reports now correctly contain non-null column headings (Empty links in
these columns have been removed). (ID-17369)

Audit Log reports show all relevant records when a date range is selected for Report
Timeline. (ID-17621)

Generating Group Reports for Active Directory servers that contain security groups with
an ampersand (&) in their names now render as expected, without an
XMLParserException. (ID-17942)

The Resource User Report, Resource Group Report, and User Access Report (and any
custom reports that use com.waveset.report.IndividualUserReport or
com.waveset.report.GroupMemberReport) no longer print "No records were found"
between report entries. (ID-18049)

Report viewer now processes the form property refType correctly when a report is edited
and then executed with the "Run" button. The refType property in the form tells the viewer
to create an ObjectRef with the type specified in the value of the refType property. This
ObjectRef is used as the value as the attribute value for the query instead of the object
name. (ID-18107)

The reports that use IndividualUserReport.java (Resource User Report and Detailed User
Report) now obtain reports correctly when the username field is set to a correct value
(ID-18260)

The Access Review Summary Report now uses the parInstanceName attribute instead of
the parTaskInstanceName attribute in the conditions for obtaining the list of Access
Reviews. Also, the report now correctly reports that no records are found when no Access
Review objects are selected. (ID-18282)

The Individual User AuditLog Report now has a help page. (ID-18539)

Reports with long non-ASCII task names now download with the correct filename.
(ID-18550)
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The Recent Sytem Messages report now truncates the data to 128 characters for display in
the main report table to produce a more readable report when the message column
contains much data. The details of the report record still contains all the data as before. This
fix also applies to any reports that use com.waveset.report.SyslogReportTask as the
executor in the TaskDefinition. (ID-18657)

Repository

When role is configured as a summary attribute in the UserUIConfig object, only three
roles will be included in the summary string by default. Use the
SummaryAttrrResourceCountLimit attribute in UserUIConfig to change the default value.
(ID-13291)

Identity Manager no longer closes and removes valid connections from the connection
pool. Previously, a non-fatal exception could cause Identity Manager to close a working
connection. (ID-13719)

Fixed the NullPointerException (NPE) in Today/Weekly Activity audit report for CLOB
log.acctAttrChanges. (ID-17346)

An Audit Log with a large table size no longer causes a significant performance impact
when writing audit events. (ID-18053)

Resources

44

The getResourceObjects () method of com.waveset.ui.FormUtil properly returns
multi-value attributes for an Active Directory resource when invoked from XPRESS.
(ID-11965)

The skeleton test included with the Resource Extension Facility (REF) kit no longer
depends on classes not delivered with the product. Previously, the skeleton test depended
on com.waveset .junit.WavesetRunner and com.waveset.junit.WavesetSuite (which
were not included with the product), but the test has been refactored to eliminate this
dependency. (ID-12370)

The Resource.getAccountAttributeType (name, mapName) method now functions correctly
when the name or mapName attribute is null. (ID-13598)

When you cancel "Edit Synchronization Policy” for a resource, Identity Manager no longer
creates artifacts in the repository and an error no longer occurs for Remedy resources.
(ID-14356)

Identity Manager displays an error message if an invalid group name is specified when
updating Solaris NIS accounts. (ID-15841)

Sun Identity Manager 8.0 ¢ Release Notes



Bugs Fixed in This Release

Previously, users of the ExampleSPML2ResourceAdapter have reported that Modify
Requests are not executed. Now the SPML v2 Modification Request is processed when the
change elements are nested in data elements. (ID-16646)

Previously, error handling for LDAP Resource Adapters used a number of hardcoded
strings and message formats. In this release error messages that originate in exceptions by
LDAP-based resource adapters are localized. (ID-16721)

A possible buffer overrun in the gateway trace module has been fixed. (ID-17093)

If the Copy Realm Configuration option is set in the Sun Access Manager data store, the
admin user for a sub-realm (instead of amAdmin) provisions to that sub-realm. This is
because when this option is set, identities technically exist only the realm or sub-realm in
which they are created. (ID-17101)

There is no single-threaded mode for the 8.0 version of the Identity Manager NDS gateway,
so the ExclusiveNDSContext Registry key is no longer used. This eliminates the error that
was formerly seen when provisioning GroupWise users through a single-threaded NDS
gateway. (ID-17144)

The LDAP resource adapter will not cause an IndexOutOfBoundsException during
reconciliation. (ID-17454)

The Scripted Gateway adapter does not support password changes. The adapter now
blocks attempts to circumvent this if you add a password account attribute to the schema
map. (ID-17533)

Fixed an issue where turning tracing on for the LDAPResourceAdapterBase class would

throw a null pointer exception. (ID-17588)

Referencing accounts[0s400] .accountId will no longer return waveset.accountId. It will
instead return the correct value for the accountId of the OS400 account. (ID-17632)

The SAP resource adapter no longer throws a JCO_ERROR_FUNCTION_NOT_FOUND
error when the SAP system that it is connecting with does not contain the
PASSWORD_FORMAL_CHECK function module. (ID-17665)

In addition, Identity Manager now uses the BAPI_USER_EXISTENCE_CHECK (instead of
BAPI_USER_GET_DETAIL) during password synchronization with SAP R/3 4.6C systems.

You can now successfully connect to a VMS resource via SSH. If you are upgrading, you
must either run update.xml or re-import resourcelWizardForms.xml for changes to apply to
VMS resource wizard. (ID-17695)

The Shell Script resource adapter now honors exit codes for Disable, Enable and Rename
operations. (ID-17749)

When shut down properly, Identity Manager Gateway no longer triggers an "abnormal
termination" message to appear in Domino 7.x Server Console logs. (ID-17782)
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The UNIX resource adapters have been modified so that they create temporary files with
user read /write permissions only. (ID-17835)

Encrypted passwords for Netware NDS GroupWise accounts are now updated correctly.
(ID-18020)

Roles

Rules used to calculate resource attributes from roles are no longer applied when a user
logs into the End User page. (ID-13338)

Based on the Ul logged into, all possible work item types that can be delegated now appear
in the drop down list when delegation is being configured. In the Administrator Ul, the
delegation drop down no longer filters the work item types that appear, so all possible
work item types that can be delegated are now listed. In the end user Ul, only the five basic
work item types are listed in the drop down list. (ID-18496)

Security

A user must now have the appropriate rights to delete another user's account, otherwise an
exception will be thrown and the account deletion will be prevented. In addition, an audit
record containing the details of the attempted deletion will be logged. (ID-15552)

Setting a correlation rule with X509 Login Module will no longer cause an error during
login. (ID-17128)

This release includes fixes for several cross-site scripting (XSS) bugs. (ID-17830, 18015)

Server

Timestamps are no longer ambiguous and now use timezone specifications like GMT +/-
<num>. (ID-8297)

The default LocalFiles repository now works under GlassFish. (ID-15589)

A problem that was causing repository deadlocks during end-user approvals and
administrator edit operations has been resolved. (ID-16926)

Application servers no longer log a warning message if the Character Encoding is set after
calling getReader(). (ID-17900)

A user view no longer contains work items for the subject obtaining the view if the subject
is not the user in the view. (ID-18430)
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Service Provider

The Service Provider Basic User Search page (ID-11245) now reports

A search value must be supplied.

when the search value is not specified, rather than
javax.naming.CommunicationException: [LDAP: error code 2 - Bad search filter]
or

java.lang.IndexOutOfBoundsException: Posn: -1, Size: 0

If a user authenticates to a single sign-on (SSO) realm configured for use with a Service
Provider Edition instance, but the user does not exist in the Server Provider Edition
instance, the user will be presented with an appropriate error message. Previously, the user
would be presented with the Service Provider Edition home page, but would be unable to
perform any of the listed actions. (ID-13194)

When Service Provider is configured, the export all command of lh console no longer fails
with java.lang.UnsupportedOperationException. In the debug page, IDMXUser is no
longer displayed as an option for List Objects. (ID-16141)

Previously, two login audit events would be submitted when a service provider user
logged on to the service provider end-user interface. This has been fixed so that only a
single audit event is submitted. (ID-16742)

Prior to this release, audit records did not track attribute-level changes for Service Provider
users. Identity Manager now audits changes to Service Provider attributes, the name of the
server where the transaction was executed, and the login interface name. (ID-16837)

Note that unlike Identity Manager, Service Provider does not record the old values for
attribute changes, only attempted and new values. Service Provider does not record
changes to resource assignments and authentication answers either.

Previously, when tracked events were enabled, the task table in the repository would grow
very large. This problem has been corrected. (ID-16923)

Service Provider Service Provisioning Markup Language (SPML) modify requests no
longer delete extended attributes that have not been specified in the request. (ID-17145)

Transaction data in memory and in the persistent data store are now correctly
synchronized. (ID-17384)
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Synchronization

Identity Manager logs an error when you delete a non-existent user, but does not create an
audit event for reporting. Now, Identity Manager logs a delete operation of a non-existent
user accordingly. Note that this log is available in the system logs and the audit log reports
in versions 6.0 SP4 and later. (ID-13284)

The AD Sync Recovery Collector Task works correctly on Global Catalog servers (ID-17851)

When a Global Catalog is used for Active Sync against an Active Directory resource, each
hostname in the AD Sync Recovery Collector Task, against that Active Directory resource,
is now considered to be a Global Catalog. (ID-18597)

Workflow

Sunrise date now properly calculates the past time. (ID-11247)

Fixed a java.lang.NullPointerException error in the post-reconciliation workflow.
(ID-16893)

The sample post-reconcile workflow, Notify Reconcile Finish, has been changed to remove
the waitForCompletion option from the call to getView on the ReconcileStatus view.
(ID-17151) Customers should also remove the waitForCompletion option in any
post-reconcile workflows. This option is never needed from within the workflows, because
the reconciler flushes results prior to launching the workflow. If a post-reconcile workflow
does set waitForCompletion=true, the workflow will hang.

Additional Defects Fixed

17111, 17242, 17269, 17414, 17668, 18555
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This section of the Release Notes lists known issues and workarounds for Identity Manager 8.0

Known Issues

This section of the Identity Manager 8.0 Release Notes lists known issues and workarounds:

General

Install and Update

Auditing

Data Exporter

Identity Manager Service Provider
Login Configuration
Organizations

Policies and Capabilities
Reconcile and Import Users
Reports

Resources

Server

Sun Identity Manager Gateway
Tasks

Workflow, Forms, Rules, and XPRESS

General

Required fields set on the resource schema map are only checked when a user account is
created (ID-220). If a field is to be required on user updates, then the user form should be
configured to ensure that the field is required.
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No checking is done on organization name, administrator name, account name, user
attribute name (left hand side of schema map), or task names for invalid characters
(ID-1145, 1206, 1679, 1734, 1767, 2413, 3331). You cannot use a dollar ($), a comma (,), a
period (.), an apostrophe ('), an ampersand (&), a left bracket ([), a right bracket (]), or a
colon (:) in the name for these types of objects.

A misleading error message is given on the account page if you try to perform an action
after your session has timed out (ID-1223).

The calendar object is not fully viewable if the browser is using large fonts (ID-2120).

The Select All checkbox on the Find Results page and the List Task page does not become
un-selected if one of the items in the list is un-selected (ID-5090). The selectAll checkbox is
ignored during the resulting action if not all of the members in the list have their checkbox
selected.

If you make a change to a custom message catalog, it is necessary to restart the server in
order to see your changes. (ID-6792)

The current mechanism for detecting a failed Server assumes that all the systems in an
Identity Manager cluster are synchronized with respect to time. (ID-7064) With the default
failure interval of five minutes, if one server is five minutes out of sync with another, the
server that is ahead will declare the server that is behind to be dead, causing unpredictable
results.

Workaround: Maintain better time synchronization or increase the failover interval.

On Windows, if you are logging in as a user whose name contains double-byte characters
and the default encoding for the machine only supports single-byte characters, you must
set the USER_JPI_PROFILE environment variable to an existing directory whose name
contains only single byte characters. (ID-8540)

If you extract a resource to an XML file using the File Format as XML option, and then
select CSV File Format from the dropdown list, the following message dialog is displayed:

The form has already been submitted

Workaround: To avoid this message, click Accounts > Extract to File > Choose a Resource >
Choose CSV File Format. Click Download to download the resource account details in .csv
file format. (ID-10847)

If an expanded node contains less than one page of data and you insert a new child of that
node (for example, if you are creating a User in the organization) before the first record on
the page, Identity Manager will insert a page with one item before the current page on the
subsequent refresh. (ID-12151)

Workaround: To realign the pages, click the First Page button.
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If you modify a Role form to change the showSuperAndSubRoles variable from 0 to 1, and
then import a super role object definition file containing existing subroles from the
Configure tab; those subroles will not be modified to include the <SuperRoles> section.
However, if you use the Identity Manager graphic user interface to create a super role, the
subroles referenced by that super role will be updated. (ID-15053)

This issue can occur with roles created outside Identity Manager that have references to
existing roles (either subroles or super roles) already in the system.

When importing these roles, the roles that already exist in the system are not updated to
reflect the new relationships; for example, referential integrity is not maintained. Use the
RoleUpdater to check and correct the referential integrity if roles are imported in this way.

Workaround: See ID-15482, described in Roles.

Editing the AdminRole object can throw an ItemNotFound exception for some non-ASCII
characters. (ID-15782)

Workarounds:

o Edit adminrolemodify. jsp to stop passing id as a query string.

<%
String bodyAttributes = “onload=\"selectFirstEditField();\"";
try {
String id = requestState.getParameter (“id”);
if (id == null) {

}

else {
form.setTitle (Messages.UI_ADMIN_ROLES_JSP_EDIT ROLE_TITLE) ;
form.setSubTitle (Messages.UI_ADMIN_ ROLES_JSP_EDIT_ROLE_SUBTITLE) ;
// stop passing id as a query string

//form.setPostURL (response.encodeURL (“security/adminrolemodify.jsp?id="+id)) ;
form.setPostURL (response.encodeURL (“security/adminrolemodify.jsp”) ) ;
}
o Edit adminrolemodify.jsp to encode the id query parameter value.

oe

<
String bodyAttributes = “onload=\"selectFirstEditField();\"";
try {
String id = requestState.getParameter (“id”);
if (id == null) {

}

else {
form.setTitle (Messages.UI_ADMIN_ROLES_JSP_EDIT ROLE_TITLE) ;
form.setSubTitle (Messages.UI_ADMIN_ROLES_JSP_EDIT ROLE_SUBTITLE) ;
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// encode id query parameter value

//form.setPostURL (response.encodeURL (“security/adminrolemodify.jsp?id="+id
)i
form.setPostURL (response.encodeURL (“security/adminrolemodify.jsp”?id="
+ com.waveset.util.URLUTF8Encoder.encode(id)));

}

If you modify settings (such as adding additional column attributes) on an existing
changelog, these modifications might not appear in a pre-existing changelog CSV file.
(ID-15973)

Some of the words on the tab of “Edit User” screen could wrap around in multi-language
mode. (ID-16054)

Workaround: To ensure words in tabs are displayed without being wrapped, add the
following to $WSHOME/styles/customStyle.css:

table.Tab2TblNew td

{background-image:url (../images/tabs/level2_deselect.jpg) ;background-repeat:repeat-x;b
ackground-position:left top;background-color:#C4CBD1;border:solid lpx
#8£989f;white-space:nowrap}

table.Tab2TblNew td.Tab2TblSelTd

{border-bottom:none;background-image:url (../images/tabs/level3_selected. jpg) ; backgroun
d-repeat : repeat-x;background-position:left

bottom;background-color: #F2F4F3;border-left:solid 1lpx #8f989f;border-right:solid lpx
#8£989f;border-top:solid lpx #8f989f;white-space:nowrap}

While in a localized Identity Manager session, users might encounter partial localization (a
mix of English and the selected language) in Process Diagram applets. (ID-16139)

The Repository Configuration object has an attribute named maxAttrvalLength. The value
of this attribute is ignored, and is always 255. (ID-16261)

Direct-mode password synchronization requires SimpleRpcHandler to be configured in the
web.xml file. By default, this handler is not provided as a handler for the rpcrouter2 servlet.
(ID-16469) To use direct-mode password synchronization, set the handlers initialization
parameter in the following way:

<init-param>
<param-name>handlers</param-name>
<param-value>com.waveset.rpc.SimpleRpcHandler, com.waveset . rpc.PasswordSyncHandler
</param-value>

</init-param>

Note that SimpleRpcHandler is known to interfere with certain RemoteSession calls. If you
plan on using RemoteSession as well as direct-mode password synchronization, configure
a separate servlet for handling RemoteSession calls.
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When editing or updating a user, if you try to assign an idmManager that is assigned to
another idmManager that does not yet exist (for example, the idmManager is missing), you
will see the following error message and the change cannot be saved. (ID-17339)

'Ttem User: [idmManager that doesn't exist] was not found in the repository, it may have
been deleted in another session'

You do not see this problem when creating a new user.

Accounts > Extract to File saves XML and CSV file formats as .dat extensions, rather than
the expected .xml and . csv extensions. (ID-17521)

Workaround: The saved files can be manually renamed with the appropriate file
extensions.

The String Quality Policy page displays text in vertical lines. (ID-18551)

Role type delegations will override role approval delegations made for a specific role.
(ID-18559) For example, if future role work item types for one or more specific roles are
delegated to user one, while all future business role work items are delegated to user two,
the specific roles from the first delegation will be delegated to user two rather than user
one. The scenario delegation summary follows:

o Delegate role approval for business role 1 to user one
o  Delegate business role approval to user two

In all requests where a user was assigned a business role approval, the business role will be
delegated to user two.

Enabling a role does not give the user an option to update assigned roles. (ID-18647)

Workarounds: Manually update the assigned users, or update the assigned users from the
List/Find Roles pages.

Roles contained by other roles can now be conditionally assigned to users when their
parent role is assigned. A condition can be specified on the association between the parent
and contained role when editing the parent role. A condition can be created or can
reference a rule. If a rule is specified, all user view attributes required for the evaluation of
the rule must be specified via rule argument. (ID-18734)

The data warehouse message catalog, WICMessages . properties, is loaded based on the
server location instead of the user's location. (ID-18898) For example, if an application
server is running in a Japanese locale, the query attributes will be displayed in Japanese,
even if the user's interface is normally in English.

Workaround: Restart the application server in a locale with a UTF-8 variant that
corresponds to the browser's language setting.
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Identity Manager 8.0 added a new queryable attribute, assighedRoles, which references all
direct and indirect roles assigned to a user. (ID-18921) Prior releases contain the still
available queryable attribute, role, which only contains roles directly assigned to users. The
upgrade process only automatically refreshes users with indirect roles to enable population
of assignedRoles. A report for users Assigned a Role will not return all users assigned to a
role in an upgraded environment until all users have been refreshed.

Workarounds:
o Refresh all users.
o Create a report for users with directly assigned roles.

Three reference attributes from the Principal objectclass are not able to be exposed on User
for data export in 8.0: Member AdminGroups, adminRoles, and adminGroupsRule.

The MemberAdminGroups and adminRoles attributes are queryable attributes of User,
even though not displayed as such in the objectclass schema. (ID-18536))

Install and Update

54

The Identity Manager installer may not run with a 64-bit JDK. (ID-18534)
Workarounds:

o Install manually.

o Use a 32-bit version JDK to run the installer.

o Setos.arch=ppc by setting JAVA_OPTS (used by install script) to get through the install.
For example,

export JAVA_OPTS="-Dos.arch=ppc”
install

o Or, if JAVA_OPTS already contains needed options:
export JAVA_OPTS="S$JAVA_OPTS -Dos.arch=ppc”
install

If the upgrade process fails to log in with the default configurator account and password,
the log file logs the error, but does not log anything after the error. (ID-18929)
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The update.xml file is imported during the upgrade process. The import attempts to log in
as configurator with the default password. If the login fails, an error is displayed, and the
upgrade program prompts you for the correct login information. If you provide the correct
information, the upgrade continues. When looking through the log file for the upgrade
process, you can see the error message when the default log in fails, but you do not see any
further information about the upgrade in the log file. This issue does not affect the upgrade,
only the log file.

The upgradeto80from71.mysql script has an error that causes the script to abort in the
middle. (ID-18874, 18977)

To prevent the error, you must edit the script and change the following line:
INSERT INTO waveset.roleobj SELECT * from waveset.object where type = 'Role’;
Modify the line to read as follows:

INSERT INTO waveset.roleobj (SELECT id, type, name, lockinfo, modified,
repomod, summary, attrl, attr2, attr3, attrd, attr5, counter, xmlSize, xml FROM
waveset.object WHERE type='Role');

The explicit column names are necessary because the columns in an upgraded 7.1 database
are in a different order.

Auditing

During a scan, there is no support for retrying user accounts that could not be fetched from
resources, or where other failures occur. These failures are reported when the scan is
complete, but there is no automated way to rescan the accounts. (ID-9112)

Identity Auditor attempts to keep users in compliance between policy scans by enforcing
policy whenever the user is edited. If editing a user that has assigned audit policies and
also is in violation of a policy, you cannot save changes to the user, even if the change is as
simple as moving a user to another organization. (ID-9504)

Workaround: Use the right-click move (or find then move) functionality on the user applet,
or temporarily disable the audit policy checks.

To disable the auditor policy checks, edit the system configuration and remove
userViewValidators property. This property which has a value of a List of strings is added
during the import of init.xml or upgrade.xml.

Logarithmic scaling on Audit Policy reports is not implemented. (ID-9522)
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Currently, the Auditor Access Scan Report administrator cannot schedule an Audit Policy
Scan. An error, Error message: Create access denied to Subject auditadmin on type
TaskSchedule is displayed. To schedule any task, administrators must have create
privileges for the TaskSchedule authType. (ID-14713)

Workaround: Edit the administrator to assign the create privilege for the TaskSchedule, or
specify a user with at least the Auditor Administrator or Waveset Adminsistrator
capabilities.

When running Audit Scans that produce multiple violations, Auditor might create a
remediation workflow to manage processing of the violations. (ID-15830) The default
MySQL setting for max_allowed packet (1M) is too small for a workflow with dozens of
violations. If this limit is reached, Auditor will not start the remediation workflow.

Workaround: For heavy use of Auditor, this value should be much larger. To address this
issue, add max_allowed packet = 32Mto the MySQL configuration file (my.cnf) and restart
the database server.

Changing severity and priority values for Compliance Violation remediations can be
misleading. The initial values in the form are not the current values of the Compliance
Violations. They are the last values set when making a change. It is important that you
know what severity/priority value you want while still viewing the list view, because you
cannot determine the current values when on the page that lets you change the values.
(ID-16040)

Audit policy names cannot contain these characters: ' (apostrophe), . (period), | (line), [ (left
bracket), ] (right bracket), , (comma), : (colon), $ (dollar sign), " (double quote), = (equals
sign). (ID-16078)

ComplianceViolations created before the IdM 7.1 upgrade will not allow the severity or
priority to be set. The error message returned indicates that the Compliance Violation no
longer exists, but this is incorrect. The violation does exist, but IdM is unable to set the
severity or priority. (ID-16420)

Data Exporter
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The Data Exporter can be configured to run as any Identity Manager administrator with the
appropriate capabilities. The export task runs as a daemon, and is started and monitored
by the Identity Manager scheduler. Audit records created by the Data Exporter will show
the subject of the Identity Manager scheduler (Scheduler:IDMServer), rather than the
subject the task is configured to use. (ID-18055)

Forensic query does not support Edit/Modify actions against role types. (ID-18769)
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|dentity Manager Service Provider

Identity Manager Service Provider and Sun Java System Portal Server may not be
compatible; there is a problem related to the encrypted libraries. (ID-10744)

This problem may be corrected by setting the following values in Portal Server’s
/etc/opt/SUNWam/config/AMConfig.properties file, and then restarting the web
container:

com. iplanet.security.encryptor=com.iplanet.services.util.JCEEncryption

com. iplanet.security.SSLSocketFactoryImpl=netscape.ldap.factory.
JSSESocketFactory

com.iplanet.security.SecureRandomFactoryImpl=com.iplanet.am.util.
SecureRandomFactoryImpl

Some configuration options that appear in the Identity Manager Administrator interface
are not used with Identity Manager Service Provider. (ID-10843). Among these are:

o Resource options: exclude accounts rule, approvers, and the organization that the
resource is assigned to.

o Role attributes

By default, auditing is not performed when using the checkinObject and deleteObject
IDMXContext API calls. Auditing has to be explicitly requested by setting the
IDMXContext .OP_AUDIT key to true in the option map passed to these methods. The
createAndLinkUser () method in the ApiUsage class shows how to request auditing.
(ID-11261)

The default Service Provider login module group expects the Service Provider resource to

be named 'SPE End-User Directory'. If the name of the resource is different, then the Service
Provider end-user login page will not function properly. The page will not show the login

related fields. (ID-14891)

Workaround: Update the resource name in the UI_LOGIN_MOD_GRP_DEFAULT_SPE_PWD
LoginModGroup object to reference the correct resource name.

The SPE Sync task is a scheduled task, so stopping it from the Tasks page will not stop
synchronization. To stop it, you can disable the schedule itself. (ID-16000)

Workaround: The preferred method of starting and stopping is either through the product
interface on the Resource page, or programmatically (for example, from a workflow)
through the SessionUtil methods to start and stop SPE Sync. To prevent SPE Sync from
starting automatically whenever an Identity Manager server instance is started, you must
disable it from the Synchronization Policy for the resource. Stopping SPE Sync through the
UI or SessionUtil method will merely stop synchronization until another Identity Manager
server instance is started.
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A javax.servlet.UnavailableException occurs when you use the Identity Manager SPE
End User Login page in WebSphere, and a 404 error displays in the browser. (ID-16001)

Workaround: You must set the following properties in the IBM 1.5 JDK:

a. In the was-install/java/jre/1ib directory, rename the jaxb.properties.sample to
jax.properties and uncomment these two lines:

javax.xml.parsers.SAXParserFactory=
org.apache.xerces. jaxp.SAXParserFactoryImpl
javax.xml.parsers.DocumentBuilderFactory=
org.apache.xerces.jaxp.DocumentBuilderFactoryImpl

b. Save the file and restart the application server.

Login Configuration

Pass-through authentication module does not work for the Domino resource (ID-1646).

Changes made to the Administrator Login Setup and User Login Setup pages are not
visible to other administrators logged in (ID-3487). To see the changes, the other
administrators will need to log out of the Administrator Interface and log back in.

If an Administrator logs in and selects Change My Password, and then selects another tab,
their account is locked until the lock expires. (ID-3705)

If another Administrator attempts to edit that locked Administrator, the following message
displays:

com.waveset.util.WavesetException: Unable to access account #ID#Configurator at this
time. Please try again later.

If that Administrator clicks OK, the workflow process diagram from the last action is
displayed.

Organizations
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Renaming an organization when there are provisioning requests pending that have users
belonging to the organization will cause the provision request to fail (ID-564).

Workaround: Ensure there are no outstanding requests before renaming an organization.

When creating a new organization, if the User Member Rules option is selected before
specifying an org name, when the page is refreshed, an organization ID will appear in the
Organization name field (ID-6302). The name can still be set prior to saving the new
organization.
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() - Warning: Parenthesized values in field 'Approvers’ do not match any of the allowed values.

Policies and Capabilities

The Identity Manager account policy attribute Reset Notification Option has a value option
of “administrator” that has no effect (ID-944). The only viable options are “immediate” and
“user”.

When deleting multiple roles, if an error is encountered, the entire operation will stop
instead of continuing to the other roles (ID-1168).

The minimum number of questions a user must answer can be set to a value greater than
the number of defined questions (ID-1834). If this situation occurs, the user will not be able
to log in using the “Forgot My Password” option.

The Default Lighthouse Account Policy cannot be cloned by editing the policy, changing
the name, and selecting to create a new object (ID-5147).

Workaround: Create a new account policy.

Audit scan has an option in the Task Launch form to send an email to a specified email
address with a violation report. This email will not be sent if no violations are found.
(ID-18773)

Reconcile and Import Users

When a full reconciliation is canceled, the error message displays:

Canceled the incremental reconciliation of [resource] running on [server]
The message should read:

Canceled the full reconciliation of [resource] running on [server] (ID-14554)

The value of the waitForCompletion attribute in the Notify Reconcile Finish workflow
must be changed to false to prevent hanging during reconciliation. The waitForCompletion
attribute will be removed in the next major Identity Manager release. (ID-16888)

Workarounds:
o Import the <idm_root>/sample/wfrecon.xml file by using 1h console.

o Manually change the Notify Reconcile Finish workflow by using 1h config.
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When executing Load From Resource, and the resource supports
ACCOUNT_CASE_INSENSITIVE_IDS, if the user's accountld differs in case from the accountld
stored in Identity Manager’s ResourceInfo user object, a second ResourceInfo will be
added to the user object with the accountld in the same case as reported by the resource.

Workaround: Ensure that the accountld in the Identity Manager ResourceInfo object in the
user object is the same case as that reported by the resource. (ID-17377)

If you disabled the MultiSelect display component applet (and are using the HTML version
instead), and edit the reconciliation policy of a particular resource instance, you can get an
error when you uncheck the Inherit resource type policy checkbox. (ID-18964)

Workaround: Re-enable the MultiSelect applets.

Reports
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Risk analysis reports can be viewed by administrators other than report administrators
(ID-1224).

Report results that are emailed with the plain text option are not formatted (ID-2191).
Workaround: Use HTML option for the email.

Numbers display in the Priority and Severity columns of the Violation Summary Report
instead of text descriptions. (ID-16932)

The Violation Summary Report does not include fixed violations. The report only includes
violations that are currently active (new or recurring) or mitigated. (ID-16933)

The Violation State column in the Violation Summary Report should be localized.
(ID-17011)

Add an EXEMPTED option to the Possible States drop-down menu in the Violation
Summary Report. (ID-17042)

When several conditions are specified to generate a usage report, the graph displays
correctly on the Report Result page, but the fixed line width will truncate the conditional
text. (ID-17224)

All Inactive Account Scan reports do not display their results on the View Risk Analysis
page. To view the result from these reports, go to the Server Tasks page. (ID-17255)

The User Question report does not display the report title when Question Policy is not
configured. (ID-17415)

The Resource User report lists Reset Administrator as a user, but Reset Administrator is a
hidden user that should not be displayed. (ID-17650)
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Resources

Resource test button does not test all fields. (ID-51)
Resource port assignments can be set to values greater than 65535. (ID-59)

Bad error message displayed when setting incorrect Active Directory group name. (ID-393)
If you attempt to set an Active Directory group name to “groupname” instead of
“cn=groupname,cn=builtin,dc=waveset,dc=com” an error message stating “array index
out of bounds” is displayed.

Required account attributes are sometimes ignored if there is another resource with the
same account attribute name that does not have the required flag set. (ID-1161)

If an administrator attempts to add an organization to a resource that he does not have
rights over, an error will appear. The edit of the resource must then be canceled and the
resource edited again to make any other changes to the resource. (ID-1274)

The error message when a resource account password or username is not correct on a
PeopleSoft resource is not clear. (ID-2235) The error message states:

bea.jolt.ApplicationException: TPESVCFAIL - application level service failure

Windows Active Directory resource actions that use the $DISPLAY_INFO_CODE$ exit status
cause the action to fail with errors. (ID-2827)

Setting a user's primary group ID on Active Directory cannot be done when creating the
user. (ID-3221)

Workaround: Create the user without setting the primary group ID, then edit the user and
set the value. The primary group ID is also set by number and not by the distinguished
name (DN) of the group.

Resource IP addresses are cached in the JVM after the hostname is resolved to an IP
address. If a resource IP address is changed, the application server must be restarted for
Identity Manager to detect the change. (ID-3635) This is a setting in the Sun JDK (version
1.3 and higher) and can be controlled with the sun.net.inetaddr. ttl property, which is
typically set in jre/lib/security/java.security.

You cannot create multiple accounts for a single user on Oracle resources. (ID-3832)
End-users cannot use the self-discovery feature for Domino resource accounts. (ID-4775)

If a user is moved from or to a sub-container within the Active Directory organization, the
Active Sync adapter will detect the change, but when you view the user on the edit page,
(or make a change and view the confirmation page) the user's accountld is still displayed as
the original DN (distinguished name). (ID-4950) Because we use GUID to modify the user,
this will not cause any operational problems. Running a reconcile against the resource will
fix the problem.
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If a user is moved from an Organization (OU) to a sub-organization, the LDAP ChangeLog
adapter will not recognize the change and assumes the user has been deleted. The user
object is then locked in Identity Manager (if that is the current setting), and a new account is
not created for the moved account. (ID-4953)

The pooled connections used by the UNIX resource adapters can be left in an
undetermined state if an error occurs while executing a command or script. (ID-5406)

NDS organizations can be created in the top level of the tree only by setting the Base
Context for the resource to "[ROOT]". (ID-5509)

On NDS, if you edit a field (such Grace Login Limit) on the initial provision, and do not
provide values for the boolean fields, all the boolean fields are set to false. (ID-6770) This
prevents you from setting the other fields on the restriction tab which require certain check
box values to be true. To avoid this, always ensure all your boolean fields are true when
you expect them to be, so they are properly pushed when editing other fields.

If you change the password for a UNIX machine using the Manage Connection --> Change
Resource Password feature, the task name that appears is:

_FM_PASSWORD_CHANGING_TASK null:null

A user-friendly name should be displayed. (ID-6947)

When updating users by selecting update from an Identity Manager organization, users
with a Sun One ID Server account will get an error if those users were created natively and
loaded into Identity Manager. (ID-7094) The work around is to update those users
individually.

Identity Manager still contains the following deprecated classes:
o com.waveset.object.IAPI

o com.waveset.object.IAPIProcess

o com.waveset.object.IAPIUser

Custom adapter classes should no longer refer to these classes, and should instead refer to
the corresponding classes in package com.waveset.adapter.iapi. (ID-8246)

If you leave the New Resource Object wizard without clicking the Save or Cancel button,
the abandoned form may not be destroyed and may interfere with the creation of
subsequent new resource objects. (ID-11033) This leads to an error that says

No resource form id found in options or view.

Workaround: Always use the Cancel button to abandon the New Resource Object wizard.
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If you edit a user while you are also running Active Sync as a different administrator, an
Active Sync exception occurs. Because the user is locked by another administrator, Active
Sync cannot retry the process. (ID-11255)

Workaround: To enable Active Sync retry for a resource, update the resource XML to
include these two additional resource attributes, in the following format:

<ResourceAttribute name='syncRetryCountLimit' type='string' multi='false’
facets='activesync' value='180"'/>

<ResourceAttribute name='syncRetryInterval' type='string' multi='false'
facets='activesync' value='10000"'/>

Where:
o syncRetryCountLimit is the number of times to retry the update.
o syncRetryInterval is the number of milliseconds to wait between retries.

Subsequently, these values will appear as custom resource settings when you configure
Active Sync. Specifying a displayName is advisable; using a custom catalog key if
localization is necessary.

There are two known issues with the Remedy Integration template editor. (ID-14729)

o The default Remedy Schema value "HPD:HelpDesk" is not appropriate for later
versions of BMC Remedy. Later versions do contain a schema "HPE:Help Desk".

o The Choices columns is not displayed for some fields. This does not affect the ability to
use Remedy templates.

A regression causes Identity Manager password synchronization to fail when used with
Sun Java™ System Directory Server Enterprise Edition 6.0, 6.1, and 6.2. The failure will be
corrected in the Directory Server 6.3 release. If versions 6.0, 6.1, or 6.2 are required to work
with Identity Manager, please request a Directory Server hotfix from Support, referencing
Directory Server bug 6604342. (ID-14895)

When you expand the resource objects of a Sun Java™ System Access Manager 7.0 resource
from the Resources tab, you might see the following error: (ID-15525)

Error listing objects. ==> com.waveset.util.WavesetException: Error trying to get
attribute value for attribute 'guid'. ==> java.lang.IllegalAccessError: tried to access
method com.sun.identity.idm.AMIdentity.getUniversalId()Ljava/lang/String; from class
com.waveset .adapter.SunAccessManagerRealmResourceAdapter

This error occurs on Access Manager 7.0 resources that have not had any patches applied.
To fix this problem, you must apply at least Patch 1 of Access Manager, and then rebuild
and redeploy the Access Manager client SDK.
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Due to interoperability issues between WebSphere data sources and Oracle JDBC drivers,
Oracle customers who want to use a WebSphere data source with Identity Manager must
use Oracle 10g R2 and the corresponding JDBC driver. (The Oracle 9 JDBC driver will not
work with a WebSphere data source and Identity Manager.) (ID-16167)

If you have a version of Oracle prior to 10g R2 and cannot upgrade Oracle to 10g R2, then
configure the Identity Manager repository so that it connects to the Oracle database using
Oracle's JDBC Driver Manager (and not a WebSphere data source).

See the following URL or more information:
http://www-1.1ibm.com/support/docview.wss?uid=swg21225859

NDS/Groupwise users created by Identity Manager that possess the Access and
AccountID fields can appear to not have their corresponding values saved when inspected
by certain viewers within the NDS Console 1 application (for example, by selecting user's
properties and then selecting the Groupwise tab).

However, if the user's Groupwise Diagnostic -> Display Object "viewer" is used instead, the
field are then seen. Updates made by Identity Manager to the aforementioned fields do not
seem to be affected by this "viewer" bug. (ID-16330)

WRQ looks though the classpath to discover its own entry. From that entry, WRQ
computes the directory where the JaR is stored, and then uses that directory to read the
.JAW (licensing file). However, both BEA and WebSphere use non-standard protocol names
(BEA uses zip, and WebSphere uses wsjar) rather than the standard JaAR, which is the
protocol the WRQ code assumes exists. (ID-16709, 17319)

Workarounds:
o  For BEA, add the following option to the java command in the startWeblogic. sh file:
-Dcom.wrq.profile.dir="DirectoryContainingLibraries"

o  For WebSphere, add the property com.wrq.profile.dir=DirectoryContainingLibraries
to the WebSphere/AppServer/configuration/config.ini file.

A Sealing violation exception might occur when you use Identity Manager 7.1 or 8.0 with
Oracle 10g on Sun Java™ System Application Server Enterprise Edition 8.2. The problem
can be caused by having more than one Oracle JDBC JAR file in the CLASSPATH or by having
an incompatible version of the JDBC JAR file in the CLASSPATH. (ID-17311)

Be sure there is only one Oracle JDBC JAR file in the CLASSPATH and that it is a compatible
version, such as the JAR file supplied during the Oracle install.

Before creating a new resource, be sure to enable the resource type in the list of configured
types. Otherwise, the newly created resource object may not have all the required fields.
(ID-17324)
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¢ The default value of the Create Directory attribute is inconsistent among Unix OS
resources. (ID-18301)

¢ When Identity Manager is using a locale with a multibyte character set, the bulk action
results do not generate the CSV filename correctly. (ID-18661)

Roles

* The date picker pop-up, used to specify future activation and deactivation dates for roles
assigned to users, is not functional when a role's name contains an apostrophe. (ID-18941)

Workaround: Type the activation or deactivation date in the text box next to the date
picker icon.

¢ When manually entering activation or deactivation dates for a user's roles, the fields
automatically submit when you click out or tab out of the field. This behavior causes a
"Form Already Submitted" message to display if you click Save after manually changing
the date in the activation or deactivation fields. (ID-18927)

¢ Deleting a role should check for references to it as a contained role and then by users. If the
process finds either of these references, then an error is thrown and the role is not deleted.
(ID-18981)

However, the process has a problem checking for references by other roles, where the role
is removed from its parent roles even though it should not be removed. The role is not
deleted because it is still refererenced by users. References to the contained role remain on
the User object, even though the parent role no longer contains that role.

Before deleting a role, you must verify that the role is not contained by any roles or
assigned to any users, either directly or indirectly.

Server

¢ The ticker will not display when selected if there are organizations with apostrophes (') in
their name. (ID-5653)

Sun ldentity Manager Gateway

* The Sun Identity Manager Gateway occasionally will not stop when the Stop button is
pressed on the Windows Services screen. (ID-590)
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Workaround: Cancel the stop service request (if it is still hanging) and stop the service
again, or exit the Windows services dialog and re-enter and attempt the stop operation
again.

The gateway occasionally will not stop when using 'net stop “Sun Identity Manager
Gateway”' (ID-2337).

The Sun Identity Manager gateway leaks memory when Exchange 2007 support is enabled
on the Active Directory resource adapter causing the process to grow over time. (ID-18854)

Workaround: Monitor the gateway service process, and restart the service before memory
usage reaches the limit.

Tasks

The Find Task page does not display the number of tasks matching the search criteria
(ID-5152).

Delegated administrators who do not control Top can schedule tasks and view the task
results, but cannot view the task after it has been created (ID-6659). The scheduled task was
placed in Top and the delegated administrator does not have rights to view the object.

A field named Deferred Tasks was added to the library. It provides the ability to list
deferred tasks on a user. To implement this field, the following line must be added the
Tabbed User Form and Tabbed View User Form (ID-7660).

<FieldRef name='Deferred Tasks'/>

Workflow, Forms, Rules, and XPRESS

You cannot use the XPRESS <eg> function to compare Boolean values to TRUE or FALSE
strings or to the integers 1 or 2. (ID-3904)

Workaround: Use the following:

<cond>
<isTrue><ref>Boolean_ variable</ref></isTrue>
<s>True action</s>
<s>False action</s>

</cond>

Path expressions do not work when iterating a list of generic objects via a dolist. (ID-4920)

<dolist name='genericObj'>
<ref>1istOfGenericObjects</ref>
<ref>genericObj.name</ref>
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</dolist>
Workaround: Use <get> / <set> as shown:

<dolist name='genericObj'>
<ref>1istOfGenericObjects</ref>
<get><ref>genericObject</ref><s>name</s>
</dolist>

If you use global.attrname variables for fields in your user form, and the attribute is shared
among more than one resource, you should also define a Derivation rule. (ID-5074)
Otherwise, if the attribute has been changed natively on one of the resources, the attribute
may or may not be picked up and propagated to the other resources.

Cannot use special strings beginning with & in HTML components of forms. For example,
&nbsp; will no longer appear as a space. This issue was introduced because of a change to
support special characters (&\<>") in Select lists. (ID-5548)

Form, workflow and rule comments contained in <Comment> tags have &#xA; strings in
them representing the line feed character. (ID-6243) These characters are only seen when
viewing the XML for these objects; the Identity Manager server and Business Process Editor
will process these characters properly.

If you use the Resource Table User Form for editing users, when editing a user's resource,
the resource attributes are not fetched when the form first appears.

Workaround: Click the Refresh button, which will fetch the attribute data. (ID-10551)

If Identity Manager is protected by a Sun Access Manager Policy Agent, workflow process
diagrams might render incompletely. (ID-18304)
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This section provides information related to installing or updating Identity Manager, and the
information is organized as follows:

e Installation Notes

* Upgrade Notes

NOTE For Known Issues related to the installation and upgrade process, please refer to the
Install and Update section of this document.

Installation Notes

The following information relates to the product installation process:

¢  When installing PasswordSync, you must use the appropriate binary file for the operating
system on which you are installing. The binary for 32-bit Windows is called
IdmPwSync_x86.msi and the binary for 64-bit WINDOWS is called IdmPwSync_x64 .msi.

When uninstalling PasswordSync, use the add/modify programs feature from the
Windows Control Panel to ensure correct removal. Installing the wrong binary might
appear to succeed, but PasswordSync will not operate properly. (ID-17290)

*  You must manually install Identity Manager on HP-UX.

* The Identity Manager installation utility can now install or update to any installation
directory name. You must create this directory prior to starting the installation process, or
select to create the directory from the setup panel.

* Running the Sun Identity Manager Gateway on a Windows system requires the Microsoft
Active Directory Client extension. The DSClient can be found at the following location:

http://support.microsoft.com/default.aspx?scid=kb;en-us; 0288358

NOTE Refer to the Sun Identity Manager Installation publication for detailed product
installation instructions.
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Upgrade Notes

This section contains information and known issues related to upgrading Identity Manager from
version 6.0 or version 7.0 to version 8.0.

The information in this section is organized as follows:
* Before You Begin
¢ Upgrade Issues
* Refreshing User Objects

NOTES *  See Identity Manager Upgrade for upgrade instructions and information.

*  When upgrading Identity Manager, be sure to review the installation section for
your application server in Sun Identity Manager Installation for application
server-specific instructions.

¢ If your current Identity Manager installation has a large amount of custom
work, you should contact Sun Professional Services for assistance with planning
and executing your upgrade.

Before You Begin

You must be aware of the following information before starting the upgrade process:

CAUTION If you are using an Oracle repository, the Identity Manager 8.0 repository
DDL uses data types that are not properly handled by older Oracle JDBC
drivers. The JDBC drivers in ojdbc14 . jar do not properly read all of the
columns in the log table.

You must upgrade to the oraclellg_jdbc.jar drivers for Identity Manager
to work properly.

¢ Identity Manager 8.0 dedicates some new tables for Roles objects. You must use the sample
scripts provided in the db_scripts directory to make the schema changes, create the new
table structures, and move your existing data.
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NOTE

* Before updating the repository database table definitions, make a full backup of
your repository tables.

* Refer to the db_scripts/upgradeto8.0from71. DBMSName script for more
information.

If you are upgrading to Identity Manager 8.0, and have any custom code that calls
UserUIConfig#getRepoIndexAttributes (), you must remove the code or change it to call
Type.USER#getInlineAttributeNames ().

Importing update.xml converts the values from the UserUIConfig RepoIndexAttrs into
values of XML attributes on the TypeDataStore element for Type.USER within the
RepositoryConfiguration object. The update.xml file includes the
UserUIConfigUpdater.xml file, which contains an Import command that invokes
UserUIConfigUpdater to convert RepoIndexAttrs. Conversion also sets a flag in
SystemConfiguration that inhibits reconversion.

Any future changes to the inline attributes for Type.USER should be made by editing the
RepositoryConfiguration object. If you change the inline attributes for Type.USER, you
generally must refresh all Type .USER objects.

NOTE Changes to RepositoryConfiguration do not affect an Identity Manager
server until you restart that server.

Be sure to use only one Identity Manager server to import update.xml and that only one
Identity Manager server is running during the upgrade. If you start any other Identity
Manager servers during the upgrade, you must stop and restart those servers before
making them available.

Be careful when you edit the super role field in the Role form because the super role itself
may be a nested role. The super roles and subroles fields indicate a nesting of roles and
their associated resources or resource groups. When applied to a user, the super role
includes the resources associated with any designated subrole. The super role field is
displayed to indicate the roles that include the displayed role.

During the upgrade process, Identity Manager analyzes all roles on the system and then
updates any missing subroles and super roles links using the RoleUpdater class.

To check and upgrade roles outside of the upgrade process, you can import the new
RoleUpdater configuration object that is provided in sample/forms/RoleUpdater.xml.
For example:
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<?xml version='1.0' encoding='UTF-8'?>
<!DOCTYPE Waveset PUBLIC 'waveset.dtd' 'waveset.dtd'>
<Waveset>
<ImportCommand class='com.waveset.session.RoleUpdater' >
<Map>
<MapEntry key='verbose' value='true' />
<MapEntry key='noupdate' value='false' />
<MapEntry key='nofixsubrolelinks' value='false' />
</Map>
</ ImportCommand>
</Waveset>
Where:

o verbose: Provides verbose output when updating roles. Specify false to enable a silent
update of roles.

o noupdate: Determines whether the roles are updated. Specify false to get a report that
only lists which roles will be updated.

o nofixsubrolelinks: Determines whether super roles are updated with missing subrole
links. This value is set to false by default and links will be repaired.

*  Administrators who need to view or edit the Identity Manager schema for Users or Roles
must be in the IDM Schema Configuration AdminGroup and must have the IDM Schema
Configuration capability.

¢ The SPML 2.0 implementation in Identity Manager has changed in Identity Manager 8.0.
In previous releases, the SPML objectclass attribute used in SPML messages was mapped
directly to the objectclass attribute of Identity Manager User objects. The objectclass
attribute is now mapped internally to the spml20bjectClass attribute and is used
internally for other purposes.

During the upgrade process the objectclass attribute value is automatically renamed for
existing users. If your SPML 2.0 configuration contains forms that reference the
objectclass attribute, you must manually change those references to spml20bjectClass.

Identity Manager does not replace the sample spml12.xml configuration file during an
upgrade. If you used the spm12.xml configuration file as a starting point, be aware that this
file contains a form with references to objectclass that you must change to
spml120bjectClass. Change the objectclass attribute in forms (where it is used internally),
but do not change the objectclass attribute in the target schema (where the attribute is
exposed externally).
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For UNIX environments, be sure that an install directory exists in one of the following
locations, and that you can write to it:

o  For Linux/HP-UX: /var/opt/sun/install

o For Solaris: /var/sadm/install

Upgrade Notes

Any previously installed hotfixes are archived to the following directory:

SWSHOME/patches/Hot fixName

Upgrade Issues

After upgrading, the changedFileList and notRestoredFileLists will contain the
following files. These files should not display, and no action is required. (ID-9228)

bin/winnt/nsprd.dll
bin/winnt/jdic.dll
bin/winnt/MozEmbed. exe
bin/winnt/IeEmbed.exe
bin/winnt/AceApi.dll
bin/winnt/DominoAPIWrapper.dll
bin/winnt/DotNetWrapper.dll
bin/winnt/gateway.exe
bin/winnt/lhpwic.dll
bin/winnt/msems.inf
bin/winnt/pwicsvc.exe
bin/winnt/remedy.dll

bin/solaris/libjdic.so

bin/solaris/mozembed-solaris-gtk2

bin/linux/librfccm.so
bin/linux/libsapjcorfc.so
bin/linux/libjdic.so

bin/linux/mozembed-1inux-gtk2

Identity Manager’s User Extended Attributes now fully supports multi-valued attributes.

(ID-14863)
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NOTE You can add a multi-valued user extended attribute to the accounts list
table, and it will render the list without error. However, attempting to sort
on that column will yield the following error:

java.lang.ClassCastException: java.util.ArrayList

An attribute condition that refers to a multi-valued extended attribute will evaluate
correctly for a user object only after that user object has been re-serialized. If you want such
an attribute condition to evaluate correctly for all user objects, then you must re-serialize all
user objects. See “Refreshing User Objects” on page 76 for instructions.

If you are upgrading from an Identity Manager version 6.x installation to version 7.x to
version 8.0, and you want to start using the new Identity Manager end-user pages, you
must manually change the system configuration ui.web.user.showMenu to true for the
horizontal navigation bar to display. (ID-14901)

Also, if you want the new end user dashboard to display on the end-user home page, you
must manually change the end user form mapping for Form Type 'endUserMenu'. Go to
Configure > Form and Process Mapping > for Form Type 'endUserMenu’ change the Form
Name Mapped To to be 'End User Dashboard'.

You should also update the mapping for Form Type 'endUserWorkItemListExt'. Change
the Form Name Mapped To to be 'End User Approvals List'.

NOTE If you are upgrading directly from Identity Manager version 7.x to
version 8.0, the preceding modifications are unnecessary.

If you are upgrading from version 6.0 or 7.0 to version 7.1 or version 8.0, and using
LocalFiles, you must export all of your data before upgrading and then re-import the data
after doing a clean installation of 7.1 or 8.0. (ID-15366)

If your installation contains a Remedy resource, you must place Remedy API libraries in
the directory where the Gateway is installed. These libraries can be found on the Remedy
server.
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Table 1 Remedy API Libraries

Remedy 4.x and 5.x Remedy 6.3 Remedy 7.0

e arapiXX.dll * arapi63.dll * arapi70.dll

e arrpcXX.dll ® arrpc63.dll ® arrpc70.dll

e  arutlXX.dll e arutle3.dll * arutl70.d1l

where XX matches the version of Remedy. e icudt20.d1l e icudt32.dll

For example, arapi45.d11 on Remedy 4.5. e icuin20.dil e icuin32.dil
e icuuc20.d1ll ¢ icuuc32.dll

* Upgrading to Identity Manager 8.0 automatically converts the User Extended Attributes
object and QueryableAttrNames and SummaryAttrNames elements of the UserUIConfig
object into the IDM Schema Configuration object. (ID-17784) The sample update.xml script
contains an import command that invokes IDMSchemaConfigurationUpdater to convert
legacy user schema configuration objects. Successful conversion of legacy user schema
configuration objects performs the following:

o]

Creates within IDM Schema Configuration an IDMObjectClassAttribute element for
each extended attribute name from User Extended Attributes.

Flags as ‘summary’ any IDMObjectClassAttribute that corresponds to each value
from the SummaryAttrNames element within UserUIConfig.

Flags as ‘queryable’” any IDMObjectClassAttribute that corresponds to each value
from the QueryableAttrNames element within UserUIConfig.

Empties the SummaryAttrNames element within UserUIConfig.
Empties the QueryableAttrNames element within UserUIConfig.

Renames any extended attribute named objectClass to spml20bjectClass. Legacy
attributes named objectClass conflict with a core attribute in the Identity Manager 8.0
schema.

¢ When you are upgrading to Identity Manager 8.0, and have any custom code that calls
UserUIConfig#getRepoIndexAttributes (), you must remove the code or change it to call
Type.USER#getInlineAttributeNames (). (ID-18051)
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Importing update.xml converts the values from the UserUIConfig RepoIndexAttrs into
values of XML attributes on the TypeDataStore element for Type.USER within the
RepositoryConfiguration object. The update.xml file includes the
UserUIConfigUpdater.xml file, which contains an import command that invokes
UserUIConfigUpdater to convert RepoIndexAttrs. Conversion also sets a flag in
SystemConfiguration that inhibits reconversion.

Any future changes to the inline attributes for Type.USER should be made by editing the
RepositoryConfiguration object. If you change the inline attributes for Type.USER, you
generally must refresh all Type.USER objects.

NOTE Changes to RepositoryConfiguration do not affect an Identity Manager
server until you restart that server.

* Be sure to use only one Identity Manager server to import update.xml and have only one
Identity Manager server running during the upgrade. (ID-18051)

If you start any other Identity Manager servers during the upgrade, you must stop and
restart that server before making it available.

*  When upgrading to Identity Manager 8.0 from any Identity Manager release prior to
Identity Manager 7.1, there might be ItemNotFound Exceptions in the upgrade log due to
Identity Manager Service Provider Edition (SPE) objects being renamed to Identity
Manager Service Provider within Identity Manager 8.0. (ID-18860)

Deprecated Features

¢ Identity Manager 8.0 changed the display method of charts and graphs in reports. Reports
created prior to Identity Manager 8.0 will display as expected in the Identity Manger 8.0
release; however, reports will not display as expected in subsequent major releases and
patches. For example, a report created in Identity Manager 7.1 will display as expected in
Identity Manager 8.0 and Identity Manager 8.0 Patch 1, but not in Identity Manager 9.0.
(ID-17636)

Refreshing User Objects

Certain types of changes require an administrator to refresh all User objects. For example, you must
refresh all User objects when you change the inline attributes for Type.USER in
RepositoryConfiguration. Whenever you mark an attribute as queryable or summary in the
IDMSchemaConfiguration object, you must refresh all User objects for the change to affect older,
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unmodified objects. The same logic applies when a new version of Identity Manager adds a new
attribute, or when a new version of Identity Manager changes the values of an existing attribute —
the upgrade process or an administrator must refresh all User objects for the change to affect older,
unmodified objects.

There are three ways to reserialize existing users:

Modify an individual User object during normal operations.

For example, opening a user account through the user interface and saving it with or
without modifications.

Disadvantage: This method is time-consuming, and the administrator must be meticulous
to ensure all existing users are reserialized.

Use the 1h refreshType utility to reserialize all users. The refreshType utility’s output is a
refreshed list of users.

1h console
refreshType User

Disadvantage: Because the refreshType utility runs in the foreground and not the
background, this process can be time-consuming. If you have a lot of users, reserializing
them all takes a long time.

Use the Deferred Task Scanner.

NOTE

Before running the Deferred Task Scanner process, you must edit the System
Configuration object using the Identity Manager Integrated Development
Environment (Identity Manager IDE) or some other method.

Search for 'refreshOfType' and remove the attributes for
'200504M3refreshOfTypeUserIsComplete' and
'200504M3refreshOfTypeUserUpperBound'.

After editing the System Configuration object, you must import that object to
repository for your changes to be present.

Disadvantage: This method causes the next Deferred Task Scanner run to take a long time
because it examines and rewrites almost every User object. However, subsequent Deferred
Task Scanner runs should execute at normal speed and duration.
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This section lists all Identity Manager Application Programming Interfaces (APIs) deprecated since
Identity Manager 6.0 20056Q4M3 and their replacements (if available). This information is organized

into the following sections:
* Deprecated Java Classes, Methods, and Fields
¢ Deprecated JSP Files and URLs
* Deprecated Configuration Objects

* Deprecated Views and Path Expressions

NOTE MultiSelect and TreeTable applet support will be discontinued in the next major
Identity Manager release; however, similar functionality will be maintained.
(ID-18785)

Deprecated Java Classes, Methods, and Fields

The following table lists deprecated classes, methods, and fields and their replacements, when
available. The table is sorted by class name, and all classes, methods, and fields are listed using
JavaDoc syntax.

Deprecated Replacement

com.sun.idm.idmx.IDMXContext com.waveset.object.LighthouseContext
com.sun.idm.idmx.IDMXContextFactory com.waveset.session.SessionFactory
com.sun.idm.idmx.sync.util.CaselnsensitiveString java.lang.String. CASE_INSENSITIVE_ORDER
Comparator

com.waveset.adapter.AccessManagerResourceAdapter# com.waveset.adapter.
handlePDException(Exception) AccessManagerResourceAdapter#

handlePDException(PDException)

com.waveset.adapter. ACF2ResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.ActivCardResourceAdapter
com.waveset.adapter.ActiveDirectoryActiveSyncAdapter com.waveset.adapter. ADSIResourceAdapter

com.waveset.adapter.ActiveSync#
RA_PARAMETERIZED_INPUT_FORM
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Deprecated

Replacement

com.waveset.adapter.ActiveSync#
RA_SYNC_CONFIG_MODE

com.waveset.adapter.ActiveSync#
RA_SYNC_POST_PROCESS_FORM

com.waveset.adapter.ActiveSync#
RA_UPDATE_IF_DELETE

com.waveset.adapter.ActiveSync#RA_USE_INPUT_FORM
com.waveset.adapter.ActiveSyncUTtil#getLogFileFullPath()

com.waveset.adapter.AD_LDAPResourceAdapter

com.waveset.adapter. ADSIResourceAdapter#
buildEvent(UpdateRow)

com.waveset.adapter. ADSIResourceAdapter#
getBaseContextAttrName()

com.waveset.adapter. ADSIResourceAdapter#
RA_UPDATE_IF_DELETE

com.waveset.adapter.AgentResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.AIXResourceAdapter.BlockAcctlter

com.waveset.adapter.AuthSSOResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.BlackberryResourceAdapter

com.waveset.adapter.ClearTrustResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.ConfirmedSync

com.waveset.adapter.DatabaseTableResourceAdapter#
RA_PROCESS_NAME

com.waveset.adapter.DblBuflterator

com.waveset.adapter.LDAPResourceAdapter

com.waveset.adapter.iapi.lAPIFactory#
getlAPI(Map,Map,ResourceAdapterBase)

com.waveset.adapter.ResourceAdapter#
getBaseContexts()

com.waveset.adapter.ActiveSync#
RA_DELETE_RULE

References to this class should be replaced with an
Accountlterator based on the Supplier model. For
example BufferedAccountQueue(new
AlXAccountSupplier).

com.waveset.adapter.ScriptedGatewayResource
Adapter

References to this class should be replaced with an
Accountlterator based on the Supplier model. For
example BufferedAccountQueue(new
LinuxAccountSupplier).

com.waveset.adapter.ActiveSync#
RA_PROCESS_RULE

com.waveset.util.Bufferedlterator
com.waveset.util.Blocklterator

com.waveset.adapter.AccountlteratorWrapper
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Deprecated

Replacement

com.waveset.adapter.DB2ResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.DominoActiveSyncAdapter

com.waveset.adapter.DominoResourceAdapter#
buildEvent(UpdateRow)

com.waveset.adapter.DominoResourceAdapter#
RA_UPDATE_IF_DELETE

com.waveset.adapter.DominoResourceAdapterBase#
getAccountAttributes(String)

com.waveset.adapter.Exchange55ResourceAdapter

com.waveset.adapter.ExampleTableResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.GenericScriptResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.GetAccessResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.HostConnectionPool#
getConnectionHostAccessLogin)

com.waveset.adapter.HostConnectionPool#
releaseConnection(HostAccess)

com.waveset.adapter.HostConnectionPool#
releaseConnection(IHostAccess)

com.waveset.adapter.HostConnPool#
getConnection(HostAccessLogin)

com.waveset.adapter.HostConnPool#putFree()
com.waveset.adapter.HostConnPool#putFree(IHostAccess)

com.waveset.adapter.iapi.lAPIFactory#
getlAPIProcess(Map,Map,String,Resource)

com.waveset.adapter.iapi.|APIFactory#
getlAPIProcess(Element)

com.waveset.adapter.iapi.|APIFactory#
getlAPIUser(Element)

com.waveset.adapter.iapi.|APIFactory#
getlAPIUser(Map,Map,String,Map)

com.waveset.adapter.iapi.|APIFactory#
getlAPIUser(Map,Map,String,Resource)

com.waveset.adapter.DominoResourceAdapter

com.waveset.adapter.iapi.|lAPIFactory#
getlAPI(Map,Map,ResourceAdapterBase)

com.waveset.adapter.ActiveSync#
RA_DELETE_RULE

com.waveset.adapter.HostConnPool#
getAffinityConnection(HostAccessLogin)

com.waveset.adapter.HostConnPool#
releaseConnection(HostAccess)

com.waveset.adapter.HostConnPool#
releaseConnection(IHostAccess)

com.waveset.adapter.HostConnPool#
getAffinityConnection(HostAccessLogin)

com.waveset.adapter.HostConnPool#putAffinityFree

com.waveset.adapter.iapi.lAPIFactory#
getlAPI(Map,Map,String,ResourceAdapterBase)

com.waveset.adapter.iapi.|APIFactory#
getlAPI(Map, Map, String, ResourceAdapterBase)

com.waveset.adapter.iapi.|lAPIFactory#
getlAPI(Map,Map,String,ResourceAdapterBase)
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Deprecated

Replacement

com.waveset.adapter.IDMResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.INISafeNexessResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.LDAPChangelLogActiveSyncAdapter

com.waveset.adapter.LDAPListenerActiveSyncAdapter

com.waveset.adapter.LDAPResourceAdapterBase#
addUserToGroup(LDAPODbject,String,String)

com.waveset.adapter.LDAPResourceAdapterBase#
buildBaseUrl()

com.waveset.adapter.LDAPResourceAdapterBase#
buildBaseUrl(String)

com.waveset.adapter.LDAPResourceAdapterBase#
buildEvent(UpdateRow)

com.waveset.adapter.LDAPResourceAdapterBase#
getAccountAttributes(String)

com.waveset.adapter.LDAPResourceAdapterBase#
getBaseContextAttrName()

com.waveset.adapter.LDAPResourceAdapterBase#
getGroups(Name,String,Vector,Vector)

com.waveset.adapter.LDAPResourceAdapterBase#
getLDAPAttributes(String,DirContext[],String)

com.waveset.adapter.LDAPResourceAdapterBase#
getLDAPAttributes(String,DirContext[])

com.waveset.adapter.LDAPResourceAdapterBase#
RA_PROCESS_NAME

com.waveset.adapter.LDAPResourceAdapterBase#
removeNameFromAttribute(DirContext,Name,Attribute)

com.waveset.adapter.LDAPResourceAdapterBase#
removeUserFromAllGroups(Name,String, WavesetResult)

com.waveset.adapter.LDAPResourceAdapterBase#
removeUserFromGroup(DirContext,Name,String,String,
Attributes)

com.waveset.adapter.LDAPResourceAdapter

com.waveset.adapter.LDAPChangelLogActiveSync
Adapter

com.waveset.adapter.LDAPResourceAdapterBase#
addUserToGroup(String,String,String)

com.waveset.adapter.ResourceAdapter#
getBaseContexts()

com.waveset.adapter.LDAPResourceAdapterBase#
getGroups(String,String, Vector,Vector)

com.waveset.adapter.LDAPResourceAdapterBase#
getLDAPAttributes(String,DirContext,String,String([])

com.waveset.adapter.LDAPResourceAdapterBase#
getLDAPALttributes(String,DirContext,String, String[])

com.waveset.adapter.ActiveSync#
RA_PROCESS_RULE

com.waveset.adapter.LDAPResourceAdapterBase#
removeNameFromAttribute(DirContext,String,
boolean,Attribute)

com.waveset.adapter.LDAPResourceAdapterBase#
removeUserFromAllGroups(String,boolean,String,
WavesetResult)

com.waveset.adapter.LDAPResourceAdapterBase#
removeUserFromGroup(DirContext,String,boolean,
String,String,Attributes)
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Deprecated

Replacement

com.waveset.adapter.LDAPResourceAdapterBase#
removeUserFromGroups(Name,Vector,String,
WavesetResult)

com.waveset.adapter.LinuxResourceAdapter.BlockAcctlter

com.waveset.adapter.MySQLResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.NaturalResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.NaturalResourceAdapter.getUser()

com.waveset.adapter.NaturalResourceAdapter.login
(IHostAccess)

com.waveset.adapter.NDSActiveSyncAdapter

com.waveset.adapter. NDSResourceAdapter#
buildEvent(UpdateRow)

com.waveset.adapter. NDSResourceAdapter#
getBaseContextAttrName()

com.waveset.adapter.NISResourceAdapter

com.waveset.adapter.NTResourceAdapter

com.waveset.adapter. ONTDirectorySmartResourceAdapter#

getAccountAttributes(String)

com.waveset.adapter.OS400ResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#DEFAULT_AUDIT_STAMP_FORMAT

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#DEFAULT_AUDIT_STAMP_START_DATE

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#getAccountAttributes(String)

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#getUpdateRows(UpdateRow)

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#RA_AUDIT_STAMP_FORMAT

com.waveset.adapter.PeopleSoftResourceAdapter

com.waveset.adapter. RACFResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.LDAPResourceAdapterBase#
removeUserFromGroups(String,
boolean,Vector,String, WavesetResult)

com.waveset.adapter.NaturalResourceAdapter#
affinity

com.waveset.adapter.NaturalResourceAdapter#
login(IHostAccess,ServerAffinity)

com.waveset.adapter.NDSResourceAdapter

com.waveset.adapter.ResourceAdapter#
getBaseContexts()

com.waveset.adapter.PeopleSoftComponentActive
SyncAdapter#getUpdateRows(UpdateRow)
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Deprecated

Replacement

com.waveset.adapter.RASecureConnection#
ExchangeAuth(boolean)

com.waveset.adapter.RemedyActiveSyncResourceAdapter

com.waveset.adapter.RequestResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.ResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.ResourceAdapter#
getBaseContextAttrName()

com.waveset.adapter.ResourceAdapterBase#
getAccountAttributes(String)

com.waveset.adapter.ResourceAdapterBase#
getAdapter(Resource,LighthouseContext)

com.waveset.adapter.ResourceAdapterBase#
getAdapter(Resource,ObjectCache,WSUser)

com.waveset.adapter.ResourceAdapterBase#
getAdapter(Resource,ObjectCache)

com.waveset.adapter.ResourceAdapterBase#
getBaseContextAttrName()

com.waveset.adapter.ResourceAdapterBase#
isExcludedAccount(String,Rule)

com.waveset.adapter.ResourceAdapterBase#
isExcludedAccount(String)

com.waveset.adapter.ResourceAdapterBase.SimpleAccount
Iterator

com.waveset.adapter.ResourceAdapterProxy#
getAccountAttributes(String)

com.waveset.adapter.ResourceAdapterProxy#
getBaseContextAttrName()

com.waveset.adapter.ResourceManager#
getResourceTypes()

com.waveset.adapter.RASecureConnection#
ExchangeAuth(boolean,bytel])

com.waveset.adapter.RemedyResourceAdapter

com.waveset.adapter.ResourceAdapter#
getBaseContexts()

com.waveset.adapter.ResourceAdapterBase#
getAdapterProxy(Resource,LighthouseContext)

com.waveset.adapter.ResourceAdapterBase#
getAdapterProxy(Resource,ObjectCache)

com.waveset.adapter.ResourceAdapterBase#
getBaseContexts()

com.waveset.adapter.ResourceAdapterProxy#
isExcludedAccount(String,Map,ResourceOperation,
Rule)

com.waveset.adapter.ResourceAdapterProxy#
isExcludedAccount(String,Map,ResourceOperation,
Rule)

Users of this class should switch to using the supplier
model for account iteration. A direct replacement for
this class would be: new BufferedAccountQueue(new
SimpleAccountSupplier(accounts));

com.waveset.adapter.ResourceAdapterProxy#
getBaseContexts()

com.waveset.adapter.ResourceManager#
getResourcePrototypes()

com.waveset.adapter.ResourceManager#
getResourcePrototypes(ObjectCache,boolean)
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Deprecated

Replacement

com.waveset.adapter.ResourceManager#
getResourceTypeStrings()

com.waveset.adapter. SAPHRActiveSyncAdapter#
RA_PROCESS_NAME

com.waveset.adapter. SAPResourceAdapter#
reverseMapMultiAttr(String, Object, WSUser)

com.waveset.adapter. SAPResourceAdapter#
setUserField(JCO.Function, String)

com.waveset.adapter. SAPResourceAdapter#
unexpirePassword(String, WavesetResult)

com.waveset.adapter. SAPResourceAdapter#
unexpirePassword(WSUser,WavesetResult)

com.waveset.adapter.ScriptedConnection.Script#
hasNextToken()

com.waveset.adapter.ScriptedConnection.Script#
nextToken()

com.waveset.adapter.ScriptedConnection.ScriptedConnecti
on#disConnect()

com.waveset.adapter.ScriptedConnection.ScriptedConnecti
onFactory#getScriptedConnection(String,HashMap)

com.waveset.adapter.ScriptedConnection.SSHConnection#
disConnect()

com.waveset.adapter.ScriptedConnection.TelnetConnection
#disConnect()

com.waveset.adapter.ScriptedHostResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.SkeletonActiveSyncAdapter
com.waveset.adapter.SkeletonResourceAdapter

com.waveset.adapter.SkeletonResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter. SMEResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.SQLServerResourceAdapter

com.waveset.adapter.SunAccessManagerResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.ResourceManager#
getResourcePrototypeNames(ObjectCache)

com.waveset.adapter.ActiveSync#
RA_PROCESS_RULE

Function#setUserField(String)

com.waveset.adapter.SAPResourceAdapter#
unexpirePassword(String,String,String,
WavesetResult)

com.waveset.adapter.SAPResourceAdapter#
unexpirePassword(String,String,String,
WavesetResult)

com.waveset.adapter.ResourceConnection#
disconnect()

com.waveset.adapter.ScriptedConnectionPool#
getConnection(HashMap, String,long,boolean)

com.waveset.adapter.ScriptedConnection.
SSHConnection#disconnect()

com.waveset.adapter.ScriptedConnection.
TelnetConnection#disconnect()

com.waveset.adapter.MSSQLServerResource
Adapter
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Deprecated

Replacement

com.waveset.adapter.SunAccessManagerResourceAdapter
#getBaseContextAttrName()

com.waveset.adapter.SVIDResourceAdapter.BlockAcctlter

com.waveset.adapter.SybaseResourceAdapter

com.waveset.adapter.TestResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter.TopSecretActiveSyncAdapter

com.waveset.adapter. TopSecretResourceAdapter#
hasError(String,String)

com.waveset.adapter.TopSecretResourceAdapter#
login(HostAccess hostAccess)

com.waveset.adapter. TopSecretResourceAdapter#
login(IHostAccess hostAccess)

com.waveset.adapter.VerityResourceAdapter#
getAccountAttributes(String)

com.waveset.adapter. XMLResourceAdapter#
getAccountAttributes(String)

com.waveset.exception.ConfigurationError
com.waveset.exception.|OException
com.waveset.exception.XmlParseException
com.waveset.extractor.CSVFormatter

com.waveset.msgcat.Catalog#getMessage(String,Object[],L
ocale)

com.waveset.msgcat.Catalog#getMessage(Locale,String,Ob
ject(])

com.waveset.msgcat.Catalog#getMessage(Locale,String)
com.waveset.msgcat.Catalog#getMessage(String,Locale)

com.waveset.msgcat.Catalog#getMessage(String,Object[])

com.waveset.object.Account#getUnowned()
com.waveset.object.Account#setUnowned(boolean)

com.waveset.object.AccountAttribute Type#getAttrType()

com.waveset.adapter.ResourceAdapter#
getBaseContexts()

References to this class should be replaced with an
Accountlterator based on the Supplier model. For
example BufferedAccountQueue(new
SVIDAccountSupplier).

com.waveset.adapter.SybaseASEResourceAdapter

com.waveset.adapter.TopSecretResourceAdapter

com.waveset.adapter. TopSecretResourceAdapter#
hasError(String,String, String)

com.waveset.adapter.TopSecretResourceAdapter#
login(HostAccess,ServerAffinity)

com.waveset.adapter. TopSecretResourceAdapter#
login(IHostAccess hostAccess,ServerAffinity affinity)

com.waveset.util.ConfigurationError
com.waveset.util.IOException
com.waveset.util. XmlParseException
com.sun.idm.changelog.CSVFormatter

com.waveset.msgcat.Catalog#
format (Locale,String,Object[])

com.waveset.msgcat.Catalog#format
(Locale,String,Object[])

fcom.waveset.msgcat.Catalog#format (Locale,String)
com.waveset.msgcat.Catalog#format (Locale,String)

com.waveset.msgcat.Catalog#
format (Locale,String,Object[])

com.waveset.object.Account#hasOwner()
com.waveset.object.Account#setOwner(WSUser)

com.waveset.object.AccountAttribute Type#
getSyntax()
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Deprecated

Replacement

com.waveset.object.AccountAttribute Type#
setAttrType(String)

com.waveset.object.Attribute#BLOCK_SIZE

com.waveset.object.Attribute#EVENTDATE
com.waveset.object.Attribute#EVENTTIME
com.waveset.object.Attribute#getDbColumnLength()
com.waveset.object.Attribute#getDbColumnName()

com.waveset.object.Attribute#STARTUP_TYPE_AUTO

com.waveset.object.Attribute#
STARTUP_TYPE_AUTO_FAILOVER

com.waveset.object.Attribute#STARTUP_TYPE_DISABLED

com.waveset.object.Attribute#STARTUP_TYPE_MANUAL

com.waveset.object.Attribute#STARTUP_TYPES

com.waveset.object.Attribute#
STARTUP_TYPES_DISPLAY_NAMES

com.waveset.object.AttributeDefinition#
AttributeDefinition(String,String)

com.waveset.object.AttributeDefinition#
setAttrType(String)

com.waveset.object. AuditEvent#setAttributeMap(Map)

com.waveset.object. AuditEvent#
addAuditableAttributes(AccountAttribute Type[],
WSAttributes)

com.waveset.object. AuditEvent#getAttributeMap()

com.waveset.object. AuditEvent#getAttributeValue(String)

com.waveset.object. AuditEvent#
setAccountAttributesBlob(Map)

com.waveset.object.AccountAttribute Type#
setSyntax(String)

com.waveset.object.AccountAttribute Type#
setSyntax(Syntax)

com.waveset.object.Attribute#BLOCK_ROWS_GET
com.waveset.object.Attribute#BLOCK_ROWS_LIST
com.waveset.object. Attribute#EVENT_DATETIME
com.waveset.object.Attribute#EVENT_DATETIME

com.waveset.object.Resource#
STARTUP_TYPE_AUTO

com.waveset.object.Resource#
STARTUP_TYPE_AUTO_FAILOVER

com.waveset.object.Resource#
STARTUP_TYPE_DISABLED

com.waveset.object.Resource#
STARTUP_TYPE_MANUAL

com.waveset.object.Resource#STARTUP_TYPES

com.waveset.object.Resource#
STARTUP_TYPES_DISPLAY_NAMES

com.waveset.object.AttributeDefinition#
AttributeDefinition(String,Syntax)

com.waveset.object.AttributeDefinition#
setSyntax(Syntax)

com.waveset.object.AuditEvent#
setAuditableAttributes(Map)

com.waveset.object. AuditEvent#
setAuditableAttributes(Map)

com.waveset.object. AuditEvent#
getAuditableAttributes()

com.waveset.object. AuditEvent#
getAuditableAttributes()

com.waveset.object. AuditEvent#
setAccountAttributesBlob(Map,Map)

Deprecated APIs 87



Deprecated Java Classes, Methods, and Fields

Deprecated

Replacement

com.waveset.object. AuditEvent#
setAccountAttributesBlob(WSAttributes, List)

com.waveset.object. AuditEvent.setAccountAttributesBlob
(List)

com.waveset.object. AuditEvent.setAccountAttributesBlob
(Map, Map)

com.waveset.object. AuditEvent.setAccountAttributesBlob
(Map,Map,Set)

com.waveset.object.CacheManager#
getAllObjects(Type,AttributeCondition[])

com.waveset.object.CacheManager#
getAllObjects(Type, WSAttributes)

com.waveset.object.CacheManager#
getAllObjects(Type)

com.waveset.object.Constants#
MAX_SUMMARY_STRING_LENGTH

com.waveset.object.EmailTemplate#setToAddress(String)
com.waveset.object.EmailTemplate#getFromAddress()
com.waveset.object.EmailTemplate#getToAddress()
com.waveset.object.EmailTemplate#setFromAddress(String)

com.waveset.object.EmailTemplate#VAR_FROM_ADDRES
S

com.waveset.object.EmailTemplate#VAR_TO_ADDRESS
com.waveset.object.Form#EL_HELP
com.waveset.object.Form#getDefaultDataType()
com.waveset.object.Form#getType()
com.waveset.object.Form#setType(String)
com.waveset.object.GenericObject.addAlias(String,String)
com.waveset.object. GenericObject#toMap(boolean)
com.waveset.object. GenericObject#toMap(String,boolean)

com.waveset.object.IAPI|

com.waveset.object. AuditEvent#
setAccountAttributesBlob(WSAttributes,
WSAttributes, List)

Use one of the other forms of
setAccountAttributesBlob (to allow for new,
attempted, or old values).

Put the list of attributes into name=value;; format,
which in turn will be stored in a blob. The delimiter ;;
will be filtered.

Use one of the other forms of setAccountAttributes
Blob (to allow for new, attempted, or old attribute
values).

com.waveset.object.CacheManager#
listObjects(Type,AttributeCondition[])

com.waveset.object.CacheManager#
listObjects(Type,WSAttributes)

com.waveset.object.CacheManager#
listObjects(Type)

com.waveset.object. EmailTemplate#setTo(String)
com.waveset.object.EmailTemplate#getFrom()
com.waveset.object.EmailTemplate#getTo()
com.waveset.object. EmailTemplate#setFrom(String)

com.waveset.object.EmailTemplate#VAR_FROM

com.waveset.object.EmailTemplate#VAR_TO
com.waveset.object. GenericObject#toMap(int)
com.waveset.object.Form#getDefaultSyntax()
com.waveset.object.Form#getSyntax()

com.waveset.object.Form#setSyntax(Syntax)

com.waveset.object.GenericObject#toMap(String,int)

com.waveset.adapter.iapi.|API
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Deprecated

Replacement

com.waveset.object.|IAPIProcess
com.waveset.object.IAPIUser
com.waveset.object.LighthouseContext#OP_NO_RESULT
com.waveset.object.LoginConfig#getApp(String)

com.waveset.object.MessageUtil#
getActionDisplayKey(String)

com.waveset.object.MessageUtil#
getEventParmDisplayKey(String)

com.waveset.object.MessageUtil#
getResultDisplayKey(String)

com.waveset.object.MessageUtil#
getTypeDisplayKey(String)

com.waveset.object.PersistentObject()

com.waveset.object.PersistentObject.fakeld(Type,String)

com.waveset.object.PersistentObject.isld(String)
com.waveset.object.Principal()
com.waveset.object.Principal(String)
com.waveset.object. RemedyTemplate

com.waveset.object.ReportCounter

com.waveset.object.RepositoryProxy.sort(RepositoryResult)

com.waveset.object.RepositoryResult#get(int)
com.waveset.object.RepositoryResult#getld(int)
com.waveset.object.RepositoryResult#getName(int)
com.waveset.object.RepositoryResult#getObject(int)
com.waveset.object.RepositoryResult#getRowCount()
com.waveset.object.RepositoryResult#getRows()

com.waveset.object.RepositoryResult#seek(int)

com.waveset.object.RepositoryResult#sort()

com.waveset.object.RepositoryResult. Row#
getSummaryAttributes()

com.waveset.adapter.iapi.lAPIFactory

com.waveset.adapter.iapi.|APIUser

com.waveset.object.LoginConfig#
getLoginApp(String)

com.waveset.ui.FormUtil#
getTypeDisplayName(LighthouseContext,String)

com.waveset.object.PersistentObject(ObjectClass)

com.waveset.object.IDFactory.fakelD(type,name).to
String()

com.waveset.object.IDFactory.isValidID(id)
com.waveset.object.Principal(ObjectClass)

com.waveset.object.Principal(ObjectClass,String)

com.waveset.object.RepositoryResult#hasNext()

com.waveset.object.RepositoryResult#next()

com.waveset.object.RepositoryResult. Row#
getAttributes()
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Deprecated
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com.waveset.object.ResourceAttribute#setType(String)

com.waveset.object.Role()
com.waveset.object.Service()
com.waveset.object.SourceManager
com.waveset.object.Syntax.getDescription()

com.waveset.object. Taskinstance#DATE_FORMAT

com.waveset.object. Taskinstance#VAR_RESULT_LIMIT

com.waveset.object. Taskinstance#VAR_TASK_STATUS

com.waveset.object. TaskTemplate#setMode(String)

com.waveset.object. TaskTemplate#
setMode(TaskDefinition.ExecMode)

com.waveset.object. Type#AUDIT_CONFIG
com.waveset.object. Type#AUDIT_PRUNER_TASK
com.waveset.object. Type#AUDIT_QUERY
com.waveset.object. Type#DISCOVERY
com.waveset.object. Type#getSubtypes()
com.waveset.object. Type#NOTIFY_CONFIG
com.waveset.object. Type#REPORT_COUNTER
com.waveset.object. Type#SUMMARY_REPORT_TASK
com.waveset.object. Type#USAGE_REPORT
com.waveset.object. Type#USAGE_REPORT_TASK

com.waveset.object.UserUIConfig.emptyQueryable
AttributeNames()

com.waveset.object.UserUIConfig.emptyRepolndex
Attributes()

com.waveset.object.ResourceAttribute#
setSyntax(Syntax)

com.waveset.object.Role(ObjectClass)
com.waveset.object.Service(ObjectClass)

com.waveset.view.SourceAdapterManageView

com.waveset.util.Util#stringToDate(String,String)
com.waveset.util.Util#getCanonicalDate(Date)

com.waveset.util. Util#
getCanonicalDate(Date, TimeZone)

com.waveset.util.Util#getCanonicalDate(long)
com.waveset.object. TaskInstance#setResultLimit(int)

com.waveset.object. Tasklnstance#getResultLimit()

com.waveset.object. TaskTemplate#
setExecMode(String)

com.waveset.object. TaskTemplate#
setExecMode(TaskDefinition,ExecMode)

com.waveset.object. Type#getLegacyTypes()
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Deprecated Replacement

com.waveset.object.UserUIConfig.emptySummary
AttributeNames()

com.waveset.object.UserUIConfig#getAppletColumns() com.waveset.object.UserUIConfig#
getAppletColumnDefs()

com.waveset.object.UserUIConfig#
getFindMatchOperatorDisplayNameKeys()

com.waveset.object.UserUIConfig#getFindMatchOperators()
com.waveset.object.UserUIConfig#getFindResultsColumns()

com.waveset.object.UserUIConfig#
getFindResultsSortColumn()

com.waveset.object.UserUIConfig#
getFindUserDefaultSearchAttribute()

com.waveset.object.UserUIConfig#
getFindUserSearchAttributes()

com.waveset.object.UserUIConfig#
getFindUserShowAttribute(int)

com.waveset.object.UserUIConfig#
getFindUserShowCapabilitiesSearch(int)

com.waveset.object.UserUIConfig#
getFindUserShowDisabled(int)

com.waveset.object.UserUIConfig#
getFindUserShowOrganizationSearch(int)

com.waveset.object.UserUIConfig#
getFindUserShowProvisioningSearch(int)

com.waveset.object.UserUIConfig#
getFindUserShowResourcesSearch(int)

com.waveset.object.UserUIConfig#
getFindUserShowRoleSearch(int)

com.waveset.object.UserUIConfig# com.waveset.object.IDMSchema.get
getQueryableAttributeNames QueryableAttributeNames(String ocName)

com.waveset.object.UserUIConfig.getRepolndexAttributes()

com.waveset.object.UserUIConfig.getSummary com.waveset.object.IDMSchema#getSummary
AttributeNames() AttributeNames(String name)

com.waveset.object.UserUIConfig.getSummary com.waveset.object. WSUser#getSummary
AttributeTypes() AttributeTypes()

com.waveset.object.UserUIConfig#
SUMMARY_ATTTR_TYPES_WRAPPER
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Deprecated

Replacement

com.waveset.object.ViewMaster()
com.waveset.object.ViewMaster.ViewMaster(String,String)
com.waveset.object.ViewMaster.ViewMaster(Subject,String)
com.waveset.object.Workltem.getDelegator()
com.waveset.object.Workltem.setDelegator(String)
com.waveset.object. WSUser.clearExtendedAttributes()

com.waveset.object. WSUser#getApproverDelegate()

com.waveset.object. WSUser.getCurrentServiceRefs()

com.waveset.object. WSUser#getDelegateHistory()

com.waveset.object. WSUser.getRoleAttributeRefs()

com.waveset.object. WSUser#
setApproverDelegate(WSUser.Delegate)

com.waveset.object. WSUser#setDelegateHistory(List)

com.waveset.rpc.SimpleRpcHandler
com.waveset.security.authn.EncryptedData
com.waveset.security.authn.Encryptor
com.waveset.security.authn.LoginInfo
com.waveset.security.authn.SignedString
com.waveset.security.authn.Subject
com.waveset.security.authz.Permission
com.waveset.security.authz.Right
com.waveset.server.Server#getResourceObjectGetCache()
com.waveset.server.Server#getResourceObjectListCache()

com.waveset.session.LocalSession#
deleteAccountimmediate()

com.waveset.session.LocalSession#getAdministrators(Map)

com.waveset.session.Session#listApprovers()

com.waveset.session#listControlledApprovers()

com.waveset.object. WSUser#
getWorkltemDelegate(String workltemType)

com.waveset.object. WSUser#
getWorkltemDelegateHistory()

com.waveset.object. WSUser#
addWorkltemDelegate(Delegate workltemDelegate)

com.waveset.object. WSUser#
setWorkltemDelegateHistory
(ListworkltemDelegateHistory)

com.waveset.object.LoginInfo
com.waveset.util.SignedString
com.waveset.object.Subject
com.waveset.object.Permission

com.waveset.object.Right

com.waveset.view.WorkltemUtil#getAdministrators

com.waveset.session.Session#
getAdministrators(Map)

com.waveset.session#getAdministrators(Map)
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Deprecated

Replacement

com.waveset.session#
listSimilarApprovers(String adminName)

com.waveset.session.SessionFactory#getApp(String)

com.waveset.session#getApps()
com.waveset.session.WorkflowServices#ARG_TASK_DATE
com.waveset.task. TaskContext#getAccessPolicy()
com.waveset.task. TaskContext#getRepository()
com.waveset.ui.SearchTableBase

com.waveset.ui.util. FormUtil#getAdministrators(Session,List)

com.waveset.ui.util. FormUtil#
getAdministrators(Session,Map)

com.waveset.ui.util. FormUtil#
getApplications(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getApplications(LighthouseContext)

com.waveset.ui.util. FormUtil#
getApproverNames(Session,List)

com.waveset.ui.util. FormUtil#getApproverNames(Session)

com.waveset.ui.util. FormUtil#getApprovers(Session, List)

com.waveset.ui.util. FormUtil#getApprovers(Session)

com.waveset.ui.util. FormUtil#
getCapabilities(LighthouseContext,List,Map)

com.waveset.ui.util. FormUtil#
getCapabilities(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getCapabilities(LighthouseContext,String,String)

com.waveset.ui.util. FormUtil#
getCapabilities(LighthouseContext)

com.waveset.ui.util. FormUtil#
getObjectNames(LighthouseContext,String,List,Map)

com.waveset.ui.util. FormUtil#
getObjectNames(LighthouseContext,String,List)

com.waveset.session#getAdministrators(Map)

com.waveset.session.SessionFactory#
getLoginApp(String)

com.waveset.session#getLoginApps()

com.waveset.object.Attribute#DATE

com.waveset.ui.util. FormUtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getApplications(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getApplications(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getCapabilities(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getCapabilities(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getCapabilities(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getCapabilities(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getObjectNames(LighthouseContext,String,Map)

com.waveset.ui.util. FormUtil#
getObjectNames(LighthouseContext,String,Map)
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Deprecated

Replacement

com.waveset.ui.util. FormUtil#
getObjectNames
(LighthouseContext,String,String,String,List,Map)

com.waveset.ui.util. FormUtil#
getObjectNames
(LighthouseContext,String,String,String, List)

com.waveset.ui.util. FormUtil#
getObjectNames
(LighthouseContext, Type,String,String, List,Map)

com.waveset.ui.util. FormUtil#
getObjectNames(LighthouseContext, Type,String,String,List)

com.waveset.ui.util. FormUtil#
getOrganizations(LighthouseContext,boolean,List)

com.waveset.ui.util. FormUtil#
getOrganizations(LighthouseContext,boolean)

com.waveset.ui.util. FormUtil#
getOrganizations(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getOrganizations(LighthouseContext)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames(LighthouseContext,boolean,
List)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames(LighthouseContext,boolean)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames(LighthouseContext)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNamesWithPrefixes
(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNamesWithPrefixes
(LighthouseContext)

com.waveset.ui.util. FormUtil#
getOrganizationsWithPrefixes(LighthouseContext,List)

com.waveset.ui.util. FormUTtil#
getObjectNames(LighthouseContext,String,Map)

com.waveset.ui.util. FormUTtil#
getObjectNames(LighthouseContext,String,Map)

com.waveset.ui.util. FormUTtil#
getObjectNames(LighthouseContext,String,Map)

com.waveset.ui.util. FormUTtil#
getObjectNames(LighthouseContext,String,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)
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Deprecated

Replacement

com.waveset.ui.util. FormUtil#
getOrganizationsWithPrefixes(LighthouseContext)

com.waveset.ui.util. FormUtil#
getSimilarApproverNames(Session,String)

com.waveset.ui.util. FormUtil#
getSimilarApproverNames(Session)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizations(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizations(LighthouseContext)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizationsDisplayNames
(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizationsDisplayNames
(LighthouseContext)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizationsDisplayNamesWithPrefixes
(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizationsDisplayNamesWithPrefixes
(LighthouseContext)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizationsWithPrefixes
(LighthouseContext,List)

com.waveset.ui.util. FormUtil#
getUnassignedOrganizationsWithPrefixes
(LighthouseContext)

com.waveset.ui.util. FormUtil#
getUnassignedResources(LighthouseContext,List,List)

com.waveset.ui.util. FormUtil#
getUnassignedResources(LighthouseContext,String)

com.waveset.ui.util. FormUtil#
getUnassignedResources(LighthouseContext,String,List)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getUsers(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getOrganizationsDisplayNames
(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getUnassignedResources(LighthouseContext,Map)

com.waveset.ui.util. FormUtil#
getUnassignedResources(LighthouseContext,Map)

com.waveset.ui.util. FormUTtil#
getUnassignedResources(LighthouseContext,Map)
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com.waveset.ui.util.html.Component#isNoWrap()
com.waveset.ui.util.html.HtmIHeader#NORMAL_BODY
com.waveset.ui.util.html.MultiSelect#isLockhart()
com.waveset.ui.util.html#setHelpKey(String)
com.waveset.ui.util.html#setLockhart(boolean)
com.waveset.ui.util.html#setNoWrap(boolean)

com.waveset.ui.util.html. TransactionSigner.getSupported
KeyStoreTypes()

com.waveset.ui.util.html. TransactionSigner.setSupported
KeyStoreTypes(String)

com.waveset.ui.util.ntml.WizardPanel#
setPreviousLabel(String)

com.waveset.ui.web.account.SearchForm
com.waveset.ui.web.account.SearchTable
com.waveset.ui.web.account.UserAppletTable
com.waveset.ui.web.resources.ResourceAppletTable
com.waveset.ui.web.roles.SearchRoleForm
com.waveset.ui.web.roles.SearchRoleTable

com.waveset.util. ArgumentsParser.parse(String[])

com.waveset.util. CaselnsensitiveStringComparator

com.waveset.util. ConnectionPool.getConnection(String,
String,String,boolean,String)

com.waveset.util. ConnectionPool.getConnection(String,
String,String, String)

com.waveset.util. ConnectionPool.getConnection
(String,String,String, String,String,boolean)

com.waveset.util. CSVParser
com.waveset.util.Debug
com.waveset.util.HtmIUtil

com.waveset.util. JSSSE#installlfAvailable()

com.waveset.ui.util.html.TransactionSigner.get
SupportedKeyStoreType

com.waveset.ui.util.html. TransactionSigner.set
SupportedKeyStoreType

com.waveset.ui.util.html.WizardPanel#
setPrevLabel(String)

com.waveset.util. ArgumentsParser.parse
(String[] args,List additionalArguments,boolean
ignorelncorrectUsage)

java.lang.String. CASE_INSENSITIVE_ORDER

com.waveset.util. ConnectionPooll#getConnection
(String,String,String,boolean,String)

com.waveset.util. ConnectionPooll#getConnection(Str
ing,String,String, String)

com.waveset.util. ConnectionPooll#getConnection
(String driverClass,String driverPrefix,String url,
String user,String password,

boolean checkConnection,String validationSql)

com.waveset.util. ConfigurableDelimitedFileParser
com.sun.idm.logging.Trace

com.waveset.ui.util.html.HtmIUtil

96  Sun Identity Manager 8.0 * Release Notes



Deprecated Java Classes, Methods, and Fields

Deprecated
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com.waveset.util.ITrace
com.waveset.util.PipeDelimitedParser

com.waveset.util.PdfReportRenderer#
render(Element,boolean,String,OutputStream)

com.waveset.util.PdfReportRenderer#
render(Element,boolean,String)

com.waveset.util.PdfReportRenderer#
render(Report,boolean,String,OutputStream)

com.waveset.util.PdfReportRenderer#
render(Report,boolean,String)

com.waveset.util.PooledConnection.isValid()
com.waveset.util. Quota#getQuota()

com.waveset.util. ReportRenderer#
renderToPdf(Report,boolean,String,OutputStream)
com.waveset.util. ReportRenderer#
renderToPdf(Report,boolean,String)

com.waveset.util. Trace#data(long,Object,String,byte[])

com.waveset.util. Trace#entry(long,Object,String,Object[])

com.waveset.util. Trace#entry(long,Object,String,String)
com.waveset.util. Trace#entry(long,Object,String)

com.waveset.util. Trace#exception(long,Object,String,t)

com.waveset.util. Trace#exit(long,Object,String,boolean)

com.waveset.util. Trace#exit(long,Object,String,int)

com.waveset.util. Trace#exit(long,Object,String,long)

com.waveset.util. Trace#exit(long,Object,String,Object)

com.waveset.util. Trace#exit(long,Object,String)

com.sun.idm.logging.Trace
com.waveset.util. ConfigurableDelimitedFileParser

com.waveset.util.PdfReportRenderer#
render(Element,boolean,String,OutputStream,
String,boolean)

com.waveset.util.PdfReportRenderer#
render(Element,boolean,String,String,boolean)

com.waveset.util.PdfReportRenderer#
render(Report,boolean,String,OutputStream,
String,boolean)

com.waveset.util.PdfReportRenderer#
render(String,boolean,String,String,boolean)

isValid(String SQL)

com.waveset.util. ReportRenderer#
renderToPdf(Report,boolean,String,OutputStream,
String,boolean)

com.waveset.util. ReportRenderer#
renderToPdf(Report,boolean,String,String,boolean)

com.sun.idm.logging.trace.Trace#
data(long,String,byte[])

com.sun.idm.logging.trace.Trace#
entry(long,String,Object[])

com.sun.idm.logging.trace.Trace#entry(long,String)
com.sun.idm.logging.trace.Trace#entry(long,String)

com.sun.idm.logging.trace.Trace#
throwing(long,String, Throwable)

com.sun.idm.logging.trace.Trace#
caught(long,String, Throwable)

com.sun.idm.logging.trace.Trace#
exit(long,String,boolean)

com.sun.idm.logging.trace. Trace#exit(long,String,int)

com.sun.idm.logging.trace.Trace#
exit(long,String,long)

com.sun.idm.logging.trace.Trace#
exit(long,String,Object)

com.sun.idm.logging.trace. Trace#exit(long,String)
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com.waveset.util. Trace#getTrace()

com.waveset.util. Trace#getTrace(Class)

com.waveset.util. Trace#getTrace(String)

com.waveset.util. Trace#level1(Class,String)
com.waveset.util. Trace#level1(Object,String)
com.waveset.util. Trace#level2(Class,String)
com.waveset.util. Trace#level2(Object,String)
com.waveset.util. Trace#level3(Class,String)
com.waveset.util. Trace#level3(Object,String)
com.waveset.util. Trace#level4(Class,String)
com.waveset.util. Trace#level4(Object,String)

com.waveset.util. Trace#
variable(long,Object,String,String,boolean)

com.waveset.util. Trace#
variable(long,Object,String,String,int)

com.waveset.util. Trace#
variable(long,Object,String,String,long)

com.waveset.util. Trace#
variable(long,Object,String,String,Object)

com.waveset.util. Trace#void info(long,Object,String,String)

com.waveset.util. Util#DATE_FORMAT_CANONICAL

com.waveset.util.Util#debug(Object)

com.waveset.util. Util#getCanonicalDateFormat()

com.sun.idm.logging.trace.TraceManager#
getTrace(String)

com.sun.idm.logging.trace.TraceManager#
getTrace(String)

com.sun.idm.logging.trace.TraceManager#
getTrace(String)

com.sun.idm.logging.trace. Trace#level1 (String)
com.sun.idm.logging.trace.Trace#level1(String)
com.sun.idm.logging.trace.Trace#level2(String)
com.sun.idm.logging.trace. Trace#level2(String)
com.sun.idm.logging.trace. Trace#level3(String)
com.sun.idm.logging.trace.Trace#level3(String)
com.sun.idm.logging.trace.Trace#level4(String)
com.sun.idm.logging.trace. Trace#level4(String)

com.sun.idm.logging.trace.Trace#
variable(long,String,String,boolean)

com.sun.idm.logging.trace.Trace#
variable(long,String,String,int)

com.sun.idm.logging.trace.Trace#
variable(long,String,String,long)

com.sun.idm.logging.trace.Trace#
variable(long,String,String,Object)

com.sun.idm.logging.trace.Trace#
info(long,String,String)

com.waveset.util. Util#stringToDate(String,String)
com.waveset.util. Util#getCanonicalDate(Date)

com.waveset.util. Util#
getCanonicalDate(Date, TimeZone)

com.waveset.util. Util#getCanonicalDate(long)

com.waveset.util. Util#stringToDate(String, String)
com.waveset.util.Util#getCanonicalDate(Date)

com.waveset.util. Util#
getCanonicalDate(Date, TimeZone)

com.waveset.util.Util#getCanonicalDate(long)

98  Sun Identity Manager 8.0 * Release Notes



Deprecated JSP Files and URLs

Deprecated

Replacement

com.waveset.util. Util#getLocalHostName()

com.waveset.util. Util#
getOldCanonicalDateString(Date,boolean)

com.waveset.util.Util.getUniqueld()

com.waveset.util. Util#rfc2396 URLPieceEncode(String)

com.waveset.util. Util#
rfc2396URLPieceEncode(String,String)

com.waveset.view.ViewUtil.getExtendedAttributes
(LighthouseContext)

com.waveset.view.ViewUtil.isExtendedAttribute
(ViewMaster vm, String name)

com.waveset.view.ViewUTtil.reloadExtendedAttributes()

com.waveset.view.ViewUtil.setExtendedAttributes
(LighthouseContext, List attributes)

com.waveset.workflow.WorkflowContext#
VAR_CASE_TERMINATED

#getServerld() (to get a unique server identifier)

com.waveset.util. Util#getCanonicalDateString(Date)

com.waveset.util.Util.generateGUID()

com.waveset.util. RFC2396URLPieceEncode#
encode(String)

com.waveset.util. RFC2396URLPieceEncode#
encode(String,String)

com.sun.idm.util.ObjectClasses.getExtended
Attributes(ObjectClass)

ObjectClasses.getExtendedAttributes(ObjectClass)

IDMSchemaConfiguration

com.waveset.object. WFProcess#
VAR_CASE_TERMINATED

Deprecated JSP Files and URLs

The following table lists deprecated JSP files and URLs and their replacements, when available.

Deprecated

Replacement

account/listapplet.jsp
resources/listapplet.jsp

resources/reconLinkAccountFilter.jsp

Deprecated APIs
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Deprecated Configuration Objects

The following table lists deprecated configuration objects and their replacements, when available.

Deprecated Replacement
UserExtendedAttributes IDMSchemaConfiguration
UserUIConfig IDMSchemaConfiguration

Deprecated Views and Path Expressions

The following table lists the deprecated views and path expressions within views and their
replacements, when available.

Deprecated Replacement

DelegateApproversViewer DelegateWorkltemsViewer
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Documentation Additions and Corrections

This section contains new and corrected information that was required after the Identity
Manager 8.0 documentation set was published. This information is organized as follows:

¢ Identity Manager 8.0 Administration

¢ Identity Manager Technical Deployment Overview
¢ Identity Manager Workflows, Forms, and Views

¢ Identity Manager Deployment Tools

* Localization Scope

*  Online Help

Identity Manager 8.0 Administration

This section contains a correction for Sun Identity Manager Administration:
*  On page 340, the Administration book contains the following note:

Identity Manager uses email templates to deliver information and requests for action to
administrators, approvers, and users. For more information about Identity Manager
email templates, see the section titled Understanding Email Templates in this guide.

Instead, the note should say "see the section titled "Customizing Email Templates" on page
196."
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Identity Manager Technical Deployment
Overview

This section contains new information and documentation corrections for Sun Identity Manager
Technical Deployment Overview:

The following information will be added to, or corrected in, the “Private Labeling of Identity
Manager” chapter of the Identity Manager Technical Deployment Overview:

* The Lighthouse account is now called the Identity Manager account. You can override this
name change using a custom catalog. The following catalog entries control the display of
the product name:

PRODUCT_NAME=Identity Manager

LIGHTHOUSE_DISPLAY NAME=[PRODUCT NAME]
LIGHTHOUSE_TYPE_DISPLAY_NAME=[PRODUCT_NAME ]

LIGHTHOUSE_DEFAULT POLICY=Default [PRODUCT_NAME] Account Policy

See Appendix B, “Enabling Internationalization” for more information about custom
catalogs.
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The “Changing the Appearance of the User Interface Navigation Menus” section should
include the following information:

For Identity Manager End User pages, the End User Navigation UserForm in enduser.xml
determines how the horizontal navigation bar is displayed. The End User pages contain a
userHeader . jsp that contains another JSP named menuStart . jsp. The menuStart.jsp
accesses two system configuration objects:

o uiweb.user.showMenu — Toggles the display of the navigation menu on and off
(Default is true)

o ui.web.user.menulLayout — Determines whether the menu is rendered as a horizontal
navigation bar (horizontal) with tabs or a vertical tree menu (vertical).
(Default is horizontal.)

The CSS style classes that determine how the menu is rendered are in style.css.

NOTE If you implement custom JavaScript functions in the end user navigation
bar (tabs), you must use endUserNavigation to reference that form
For example

document. forms [ 'endUserNavigation'].elements

You can use CSS to set column widths in the User list and Resource list tables to a fixed
pixel or percentage value. To do so, add the following style classes (commented out by
default) to customStyle.css. You can then edit the values to meet the user's requirements.

th#UserListTreeContent_Col0 {
width: 1px;
}

th#UserListTreeContent_Coll {
width: 1px;
}

th#UserListTreeContent_Col2 {
width: 50%;

}

th#UserListTreeContent_Col3 {
width: 50%;

}
th#ResourceListTreeContent_Col0 {
width: 1px;

}
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th#ResourcelListTreeContent_Coll {
width: 1px;
}

th#ResourceListTreeContent_Col2 {
width: 33%;
}

th#ResourceListTreeContent_Col3 {
width: 33%;
}

th#ResourceListTreeContent_Col4 {
width: 33%;
}

You can also resize table columns by clicking and dragging the right border of the column
header. If you mouse over the right border of the column header, the cursor will change to
a horizontal resize arrow. Left-click and drag the cursor to resize the column. (Resizing
ends when you release the mouse button.)

* Customers who want to use custom JavaScript functions specifically in the end user
navigation bar (tabs) must reference that form using endUserNavigation. For example,
document . forms [ ' endUserNavigation'].elements. (ID-13769)

* The Access Review Dashboard and Access Review Detail Report both show instances of
reviews that are recorded in the audit logs. Without database maintenance, the audit logs
are never trimmed, and the list of reviews grows. Identity Manager provides the ability to
limit the reviews shown to a certain age range. To change this limit, you must customize
compliance/dashboard. jsp (for the dashboard) and sample/auditortasks.xml (for the
Details report). (The default is to show only reviews that are less than 2 years old.)

To restrict the reviews included in the Access Review Dashboard, customize
compliance/dashboard. jsp as follows:

a. Open compliance/dashboard.jsp in either the Identity Manager IDE or editor of your
choice:

b. Change the line: form.setOption("maxAge", "2y"); to form.setOption("maxAge",
"6M") ; to limit the list to reviews run in the last 6 months.

The qualifiers are:
» m-minute

» h-hour

» d-day

»  w-week
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» M-month

» y-year
To show all reviews that still exist in the audit logs, comment out this line.
To restrict the reviews included in the Access Review Detail Report,
a. Open sample/auditortasks.xml in either the IDE or editor of your choice.

b. Change the following line as indicated to limit reviews to the last 6 months. The same
qualifiers as above apply:

<s>maxAge</s>
<s>2y</s>

to

<s>maxAge</s>
<g>6M< /s>

Each Periodic Access Review includes a set of UserEntitlement records that were created
when the review was run. These records, which accumulate over time, provide valuable
historical information about accounts. However, to conserve database space, consider
deleting some records. You can delete a record by executing Server Task > Run Task >
Delete Access Review. Deleting a review adds new audit log entries that indicate the
review is deleted, and deletes all UserEntitlement records associated with the review,
which conserves database space.

In the section “Changing Background Image on the Login Page”, the third line of code
should read:

url (../images/other/login-backimage?2. jpg)

Code Example 5-5 contains information that should appear in Code Example 5-4.
Code Example 5-4 should be as follows:

Code Example 5-4 Customizing Navigation Tabs

/* LEVEL 1 TABS */

.TabLvl1lDiv {
background-image:url (../images/other/dot.gif);
background-repeat :repeat-x;
background-position:left bottom;
background-color:#333366;
padding:6px 10px 0px;

}

a.TabLvllInk:1link, a.TabLvllLnk:visited {
display:block;
padding:4px 10px 3pX;
font: bold 0.95em sans-serif;
color: #FFF;
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Code Example 5-4 Customizing Navigation Tabs (Continued)

text-decoration:none;
text-align:center;

}

table.TabLv11Tbl td {
background-image:url (../images/other/dot.gif);
background-repeat :repeat-x;
background-position:left top;
background-color:#666699;
border:solid lpx #abalb5;

}

table.TabLv11Tbl td.TabLvl11TblSelTd {
background-color:#9999CC;
background-image:url (../images/other/dot.gif);
background-repeat :repeat-x;
background-position:left bottom;
border-bottom:none;

}

/* LEVEL 2 TABS */

.TabLv12Div {
background-image:url (../images/other/dot.gif);
background-repeat :repeat-x;
background-position:left bottom;
background-color:#9999CC;
padding:6px Opx Opx 10px

}

a.TabLvl12Ink:1link, a.TabLvl2Lnk:visited{
display:block;
padding:3px 6px 2pX;
font: 0.8em sans-serif;
color:#333;
text-decoration:none;
text-align:center;

}

table.TabLv12Tbl div.TabLv12SelTxt {
display:block;
padding:3px 6px 2pX;
font: 0.8em sans-serif;
color:#333;
font-weight:normal;
text-align:center;

}

table.TabLv12Tbl td {
background-image:url (../images/other/dot.gif);
background-repeat :repeat-x;
background-position:left top;
background-color: #CCCCFF;
border:solid lpx #abalb5;

}

table.TabLv12Tbl td.TabLv12TblSelTd {
border-bottom:none;
background-image:url (../images/other/dot.gif);
background-repeat :repeat-x;
background-position:left bottom;
background-color: #FFF;
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Code Example 5-4 Customizing Navigation Tabs (Continued)

border-left:solid lpx #abalb5;
border-right:solid 1lpx #abalb5;
border-top:solid 1lpx #abalb5;

Code Example 5.5 should be as follows:

Code Example 5-5 Changing Tab Panel Tabs

table.Tab2TblNew td
{background-image:url (. ./images/other/dot.gif) ;background-repeat:repeat-x;background-positi

on:left top;background-color:#CCCCFF;border:solid lpx #8f989f}
table.Tab2TblNew td.Tab2TblSelTd

{border-bottom:none;background-image:url (../images/other/dot.gif) ;background-repeat:repeat-
X;background-position:left bottom;background-color:#FFF;border-left:solid 1lpx
#8f989f;border-right:solid lpx #8f989f;border-top:solid lpx #8f989f}

¢ In the Identity Manager End User Interface, the horizontal navigation bar is driven by the
End User Navigation UserForm in enduser .xml. (ID-12415)

userHeader . jsp, which is included in all the end user pages, includes another JSP named
menuStart. jsp. This JSP accesses two system configuration objects:

o uil.web.user.showMenu - Toggles the display of the navigation menu on/off (default:
true)

o ui.web.user.menuLayout - Determines whether the menu is rendered as horizontal
navigation bar with tabs (the default: horizontal) or a vertical tree menu (vertical)

The CSS style classes that determine how the menu is rendered are in style.css.

* The code sample included in the section titled “Changing Masthead Appearance”
incorrectly lists the first line as “MstDiv”. This line should read “.MstDiv”. (ID-16072)
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* The section titled “Customizing the Browser Bar” has been revised as follows: (ID-16073)

You can now replace the product name string in the browser title bar with a localizable string of
your choice.

1. Import the following XML file:

Code Example 1 XML to Import

<?xml version='1.0"' encoding='UTF-8'?>
<!DOCTYPE Configuration PUBLIC 'waveset.dtd' 'waveset.dtd'>
<Configuration name='AltMsgCatalog'>

<Extension>

<CustomCatalog id='AltMsgCatalog' enabled='true'>
<MessageSet language='en' country='US'>

<Msg id='UI_BROWSER_TITLE_PROD_NAME_OVERRIDE'>Override Name</Msg>

</MessageSet>

</CustomCatalog>
</Configuration>
</Extension>

2. Using the Identity Manager IDE, load the System Configuration object for editing. Add a
new top-level attribute:

Name = customMessageCatalog
Type = string
Value = AltMsgCatalog

3. Open the ui.web Generic Object and look for the browserTitleProdNameOverride attribute.
Set this value to true.

4. Save this change to the System Configuration object, and restart your application server.
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* The instructions for customizing login pages provided in “Customizing Identity Manager
End User Pages” should now include the following information about message keys.

(ID-16072)

JSP or Identity Manager

Component Interface Affected Message Key
Login Page TITLE Administrator and UI_LOGIN_TITLE_TO_RESOURCE
User UI_LOGIN_CHALLENGE
Login Page SUBTITLE Administrator and Select a key depending on the login mode: Forgot
User Password, Forgot User ID, Login Challenge.
UI_LOGIN_WELCOME3
UI_LOGIN_WELCOME4
UI_LOGIN_WELCOMES
UI_LOGIN_WELCOME6
UI_LOGIN_CHALLENGE_INFO
staticLogout.jsp and Administrator and UI_LOGIN_TITLE
user/staticUserLogout.jsp User
continuelLogin.jsp Administrator UI_LOGIN_IN_PROGRESS_TITLE

UI_LOGIN_WELCOME

The following keys are no longer used:

o UI_LOGIN_TITLE LONG

o UI_LOGIN_WELCOME2

¢ The instructions for “Changing the Default “Logged in as ...” Text” should be corrected as

follows: (ID-18545)

¢ The following note should be added after the bulleted deactivateDate information in the
“features” section of Appendix A, “Editing Configuration Objects.”

NOTE You can set both activateDate and deactivateDate to true, even if
userAssignment .manual is not. If you set both attributes to true for a
roleType, and if the role is contained by another role optionally, then you
can specify activate and deactivate dates when assigning the optional role to

a user.
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Changing the Default “Logged in as ...” Text
1. Import the following XML file:

<?xml version='1.0' encoding='UTF-8'?>
<!DOCTYPE Configuration PUBLIC 'waveset.dtd' 'waveset.dtd'>
<Configuration name='AltMsgCatalog'>
<Extension>
<CustomCatalog id='AltMsgCatalog' enabled='true'>
<MessageSet language='en' country='US'>
<Msg id='UI_NAV_FOOT LOG_AS'>mytext {0}!</Msg>
</MessageSet>
</CustomCatalog>
</Extension>
</Configuration>

2. Add the following line to the System Configuration object within the

<Configuration><Extension><Object> element:

<Attribute name='customMessageCatalog' value='AltMsgCatalog'/>

3. Save change and restart your application server.

Sun Identity Manager 8.0 ¢ Release Notes




Identity Manager Workflows, Forms, and Views

|dentity Manager Workflows, Forms, and Views

This section contains new information and documentation corrections for Sun Identity Manager
Workflows, Forms, and Views.

You can turn off policy checking in your user form by adding the following field to the
form: (ID-13346)

<Field name='viewOptions.CallViewValidators'>
<Display class='Hidden'/>
<Expansion>
<s>false</s>
</Expansion>
</Field>

This field overrides the value in the OP_CALL_VIEW_VALIDATORS field of modify. jsp.

The Identity Manager User Interface pages include a second XPRESS form that implements
the navigation bar. As a result, the rendered page contains two <FORM> tags, each with a
different name attribute:

<form name="endUserNavigation"> and <form name="mainform">

To avoid potential confusion between these two <FORM> elements, make sure you use the
name attribute as follows to distinguish which <FORM> you are referencing:
document .mainform or document .endUserNavigation.

Chapter 1, Identity Manager Workflow

Identity Manager provides the following new sample Access Review workflow in
/sample/workflows. (ID-15393)

Test Auto Attestation

Use to test new Review Determination rules without creating Attestation work items. This
workflow does not create any work items, and simply terminates shortly after it starts. It
leaves all User Entitlement objects in the same state that they were created in by the access
scan. Use the Terminate and Delete options to clean up the results from access scans run
with this workflow.
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You can import this stub workflow as needed. (Identity Manager does not import it
automatically.)

* Identity Manager Compliance uses workflows as integration and customization points for
the application. The default compliance-related workflows are described below. (ID-15447)

Workflow Name Purpose

Remediation Remediation for a single Remediator working with a single
Compliance Violation

Access Review Remediation Remediation for a single remediator working with a single
UserEntitlement

Attestation Attestation for a single Attestor working with a single
UserEntitlement

Multi Remediation Remediation for a single Compliance Violation and multiple
remediators

Update Compliance Violation Mitigates a Compliance Violation

Launch Access Scan Launch an Access Scan task from an Access Review task

Launch Entitlement Rescan Launch a rescan of an Access Scan for a single user

Launch Violation Rescan Launch a rescan of an Audit Policy Scan for a single user

* The description of the maxSteps property has been revised as follows: (ID-15618)

Specifies the maximum number of steps allowed in any workflow process or subprocess.
Once this level is exceeded, Identity Manager terminates the workflow. This setting is used
as a safeguard for detecting when a workflow is stuck in an infinite loop. The default value
set in the workflow itself is 0, which indicates that Identity Manager should pull the actual
setting value from the global setting stored in the SystemConfiguration object's
workflow.maxSteps attribute. The value of this global setting is 5000.

¢ This chapter now contains the following description of the Scripted Task Executor task.
(ID-15258)

Executes Beanshell or JavaScript based on the script provided. As a task, it can be
scheduled to run periodically. For example, you can use it to export data from the
repository to a database for reporting and analysis. Benefits include the ability to write a
custom task without writing custom Java code. (Custom Java code requires a re-compile on
every upgrade and must be deployed to every server because the script is embedded in the
Scripted Task Executor task there is no need to recompile or deploy it.)
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Chapter 2, Workflow Services

e The Arguments table of the createview Session Workflow Service is incorrect. The
following table describes the arguments available in this service.(ID-14201)

Table 1

Name Required  Valid Values Description

op yes createView

viewId yes Specifies the type of view to create.

options no Specifies view-specific options. The values you can pass are
specific to the view being used. The most common is the
User view.

Options can be found in session.UserViewConstants.
The simpler views should declare their option constants in the
Viewer . java file.

Probably the second most common view used from workflow
is ProcessViewer, followed by PasswordViewer,
DisableViewer, EnableViewer, and RenameViewer. These
have comparatively few options

* The description of the disableUser Workflow Service should clarify that the default
behavior of this service is to disable the Identity Manager account as well as the resource
account. (ID-14572) If you do not want to disable the Identity Manager account, pass the
following argument:

<Argument name='doWaveset' value='false'/>

The discussion of this method’s arguments should read as follows:

Name Required Valid Values Description

op yes disableUser

accountld yes Identifies the Identity Manager user to disable accounts for.

doWaveset no true/false If true, the Identity Manager account is disabled for this user.
If not supplied, it defaults to true, and the account is
disabled.

services no Identifies a list of resources to disable. If this argument is not

supplied, all of the user’s resource accounts will be disabled.
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¢ This document incorrectly represents the viewId attribute of the checkoutView and
createView methods as “viewid”. Note that the correct spelling of this parameter is viewld.
(ID-15411)

¢ This chapter now contains the following description of the lock and unlock workflow
services.(ID-17070)

lock Provisioning Workflow Service
Use to lock an object.

Argument Required Description

subject no Indicates the effective subject for the call. If not supplied, Identity Manager uses
the task's subject. If the value of this argument is none, Identity Manager performs
no authorization.

options no (Map) A value map of option name/option value pairs. If not supplied, specific
arguments below are used. If supplied, any specific arguments below will override
the same argument contained in this options map.

accountld no (String) Identifies the name of the Identity Manager user to lock.
adminName no (String) Indicates the name of the administrator performing the operation.
loginAppName no (String) Specifies the login application name.

op yes Valid value is unlock

This method returns a null value.

unlock Workflow Service
Use to unlock a locked object.

Table 1

Argument Required Description

subject no (String) Indicates the effective subject for the call. If not supplied, the
task's subject is used. If the value of this argument is none, then no
authorization is performed.

options no (Map) A value map of option name/option value pairs. If not supplied,
Identity Manager uses the specific arguments below. If supplied, any
specific arguments below will override the same argument contained in
this options map.

accountld no (String) Identifies the name of the Identity Manager user to unlock.

adminName no (String) Indicates the name of the administrator performing the operation
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Table 1

Argument Required Description

loginAppName no (String) Specifies the login application name.

doLighthouse no (Boolean) Indicates whether or not to unlock the Identity Manager

account.

doResources no (Boolean) Indicates whether or not to unlock the user's resources.

doAuthenticators no (Boolean) If true, unlocks all pass-through authentication.

op yes Valid value is unlock.
This method returns a WavesetResult with the result of the operation.

* The description of the removeDeferredTask session workflow service has been revised as

follows: (ID-17302)
Used to remove a deferred task from an Identity Manager object. Identity Manager will
ensure that the administrator that launched the workflow is authorized to remove the
object.

Table 2 removeDeferredTask Method Arguments

Name Required  Valid Values Description

type no valid values are the listof ~ Specifies the type of the object that the deferred task

types will be removed from. If not supplied, the type is
defaulted to user.
name yes Specifies the name of the object that the deferred task
will be removed from.
task Specifies the name of the TaskDefinition to remove.
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Chapter 3, Identity Manager Forms

This chapter now contains the following description of forms used in auditing and
compliance procedures. (ID-15447, 16240)

Identity Manager auditing and compliance forms provide a feature unique among Identity
Manager forms: You can assign a form on a per-user and per-organization basis. Forms
assigned on a per-user basis can boost the efficiency of attestation and remediation
processing.

For example, you can specify the user form that Identity Manager displays for editing a
user in the context of an access review, remediation or a compliance violation remediation.
You can specify this user form at the level of user or organization. When Identity Manager
re-scans a user in context of an access review re-scan or access review remediation, the
re-scan will respect the audit policies as defined in the AccessScan. You can define this to
include the continuous compliance audit policies.

NOTE To configure auditing components, you must be an Identity Manager
administrator with the Configure Audit and Auditor Administrator
capabilities.

Related Information

o See Identity Manager Administration for a discussion of the concepts that support
Identity Manager auditing and compliance features as well as the basic procedures for
implementing the default auditing and compliance features.

o See Identity Manager Rules in Identity Manager Deployment Tools for a general
discussion of rules as well as specific information about remediation rules.

About Auditing-Related Form Processing

116

Much like userForm and viewUserForm, you can set the form on a specific user, or on an
organization, and the user (or all users in the organization) will used that form. If you set a
form on both user and organization, the form set on the user takes precedence. (When
looking up the form, Identity Manager searches organizations upwards.)

Auditing-related forms behave the same way that the User Form and View User Form
work: Each user can designate a specific form to use, and the resolution of which form a
specific user should use will honor the user's organization.
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Specifying User Forms
The Audit Policy List and Access Scan List forms support a fullview property that causes
the form to display a significant amount of data about the elements in the list. Set this
policy to false to improve the performance of the list viewer.

Identity Manager Workflows, Forms, and Views

The Access Approval List form has a similar property named includeUE, and the

Remediation List form uses the includeCV property.

Default Auditing-Related Forms
The following table identifies the default auditing-related forms that ship with Identity

Manager.

Table 2

Form Name

Per-Use

r

Mapped Name Control

General Purpose

Access Approval List

Access Review Delete
Confirmation

Access Review Abort
Confirmation

Access Review
Dashboard

Access Review
Remediation Form

Access Review
Summary

Access Scan Form
Access Scan List

Access Scan Delete
Confirmation

Access Approval List

Attestation Form

UserEntitlementForm

UserEntitlement
Summary Form

accessApprovalList

accessReviewDeleteConfirmation
accessReviewAbortConfirmation
accessReviewDashboard
accessReviewRemediationWorklte  Yes
m

accessReviewSummary

accessScanForm
accessScanlList

accessScanDeleteConfirmation

attestationList Yes
attestationWorkltem Yes
userEntitlementForm

userEntitlementSummaryForm

Display the list of attestation workitems

Confirm the deletion of an access review

Confirm the termination of an access
review

Show the list of all access reviews

renders each UE-based remediation
workitem

Show the details of a specific access
review

Display or edit an access scan
Show the list of all access scans

Confirm the deletion of an access scan

Renders the list of all pending
attestations.

Renders each attestation work item

Display the contents of a
UserEntitlement
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Table 2
Per-Use
r
Form Name Mapped Name Control  General Purpose
Violation Detail Form violationDetailForm Show the details of a compliance
violation
Remediation List remediationList Yes Show a list of remediation work items
Audit Policy List auditPolicyList Show a list of audit policies
Audit Policy Delete auditPolicyDeleteConfirmation Confirm the deletion of an audit policy
Confirmation Form
Conflict Violation conflictViolationDetailsForm Show the SOD violation matrix
Details Form
Compliance Violation complianceViolationSummaryFor
Summary Form m
Remediation Form reviewWorkltem Yes Renders a compliance violation.

Why Customize These Forms?

Attestors and remediators can specify forms that show exactly the detail they need to more
efficiently attest and remediate. For example, a resource attestor could show specific
resource-specific attributes in the list form to allow them to attest without looking at each
specific work item. Because this form would differ depending on the resource type (and
thus attributes) involved, customizing the form on a per-attestor basis makes sense.

During attestation, each attestor can look at entitlements from a unique perspective. For
example, the idmManager attestor may be looking at the user entitlement in a general way,
but a resource attestor is interested only in resource-specific data. Allowing each attestor to
tailor both the Attestation-list form and the AttestationWorkItem form to retrieve and
display only the information they need can boost the efficiency of the product interface.
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Scan Task Variables

The Audit Policy Scan Task and Access Scan Task task definitions both specify the forms to
be used when initiating the task. These forms include fields that allow for most, but not all,
of the scan task variables to be controlled.

Variable Name Default Value Purpose

maxThreads 5 Identifies the number of concurrent users to work at one time for a
single scanner. Increase this value to potentially increase throughput
when scanning users with accounts on very slow resources.

userLock 5000 Indicates time (in mS) spent trying to obtain lock on user to be
scanned. If several concurrent scans are scanning the same user, and
the user has resources that are slow, increasing this value can result in
fewer lock errors, but a slower overall scan.

scanDelay 0 Indicates time (in mS) to delay between issuing new scan threads. Can
be set to a positive number to force Scanner to be less CPU-hungry.

* The description of the Disable element has been revised as follows: (ID-14920)

Calculates a Boolean value. If true, the field and all its nested fields will be ignored during
current form processing.

Do not create potentially long-running activities in Disable elements. These expressions run
each time the form is recalculated. Instead, use a different form element that will not run as
frequently perform this calculation.

* The section titled “Inserting Javascript into a Form” incorrectly states that you can include
JavaScript in your form with a <JavaScript> tag (ID-15741). Alternatively, include
JavaScript as follows:

<Field>
<Expansion>
<script>

NOTE The display.session and display.subject variables are not available to Disable
form elements.

*  You can now insert WARNING), error (ERROR), or informational (OK) alert messages into
an XPRESS form. (ID-14540, ID-14953)
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—

P ® N

NOTE Although this example illustrates how to insert a Warning ErrorMessage
object into a form, you can assign a different severity level.

Use the Identity Manager IDE to open the form to which you want to add the warning.
Add the <Property name='messages'> to the main EditForm or HtmlPage display class.
Add the <defvar name='msgList'> code block from the following sample code.

Substitute the message key that identifies the message text to be displayed in the Alert box
in the code sample string:

<message name='UI_USER_REQUESTS_ACCOUNTID_NOT_ FOUND_ALERT VALUE >

Save and close the file.

Code Example

<Display class='EditForm'>
<Property name='componentTableWidth' value='100%'/>
<Property name='rowPolarity' value='false'/>
<Property name='requiredMarkerLocation' value='left'/>
<Property name='messages'>

</Property>
</Display>
<defvar name='msgList'>
<cond>
<and>

</and>
<list>

</list>
</cond>
</defvar>

<ref>msglList</ref>

<notnull>
<ref>username</ref>

</notnull>

<isnull>
<ref>userview</ref>

</isnull>

<new class='com.waveset.msgcat.ErrorMessage'>
<invoke class='com.waveset.msgcat.Severity' name='fromString'>
<s>warning</s>
</invoke>
<message name='UI_USER_REQUESTS_ACCOUNTID_NOT_FOUND_ALERT_VALUE'>
<ref>username</ref>
</message>
</new>
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To display a severity level other than warning, replace the <s>warning</s> in the
preceding example with either of the these two values:

o error -- Causes Identity Manager to render an InlineAlert with a red "error" icon.

o  ok--Results in an InlineAlert with a blue informational icon for messages that can

indicate either success or another non-critical message.
Identity Manager renders this as an InlineAlert with a warning icon
<invoke class='com.waveset.msgcat.Severity' name='fromString'>
<s>warning</s>
</invoke>

where warning can also be error or ok.

¢ This chapter now contains the following description of the Hidden display component:

The Hidden display class corresponds to the <input type=hidden’/> HTML component.
This component supports only single-valued data types because there is no way to reliably

serialize and deserialize multi-valued data types. (ID-16904)

If you have a List that you want to render it as a string, you must explicitly convert it to a

string. For example:

Code Example 0-1 Rendering Multi-Value Data Type with the Hidden Display Component

<Field name='testHiddenFieldList' >
<Display class='Hidden'/ >
<Derivation>
<invoke name='toString'> <List> <String>aaaa</String> <String>bbbb</String>
</List> </invoke>
</Derivation>
</Field>

*  You can now set the RequiresChallenge property in the End User Interface Change
Password Form to require users to reenter their current password before changing the
password on their account. For an example of how to set this property, see the Basic
Change Password Form in enduser.xml. (ID-17309)
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Chapter 4, Identity Manager Views

* The description of the Org view has been updated as follows: (ID-13584)

Used to specify the type of organization created and options for processing it.

Common Attributes

The high-level attributes of the Org view are listed in the following table.

orgName

Name Editable? Data Type Required?
orgName Read String System-Generated
orgDisplayName Read/Write String Yes

orgType Read/Write String No

orgld Read String System-Generated
orgAction Write String No
orgNewDisplayName Write String No

orgParentName Read/Write String No
orgChildOrgNames Read List System-Generated
orgApprovers Read/Write List No
allowsOrgApprovers Read List System-Generated
allowedOrgApproverIds Read List System-Generated
orgUserForm Read/Write String No
orgViewUserForm Read/Write String No

orgPolicies Read/Write List No
orgAuditPolicies Read/Write List No

renameCreate Read/Write String No

renameSaveAs Read/Write String No

Identifies the UID for the organization.This value differs from most view object names because
organizations can have the same short name, but different parent organizations.

orgDisplayName

Specifies the short name of the organization. This value is used for display purposes only and does

not need to be unique.
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orgType
Defines the organization type where the allowed values are junction or virtual. Organizations
that are not of types junction or virtual have no value.

orgld
Specifies the ID that is used to uniquely identify the organization within Identity Manager.

orgAction

Supported only for directory junctions, virtual organizations, and dynamic organizations. Allowed
value is refresh. When an organization is a directory junction or virtual organization, the behavior
of the refresh operation depends on the value of orgRefreshAllOrgsUserMembers.

orgNewDisplayName

Specifies the new short name when you are renaming the organization.

orgParentName
Identifies the full pathname of the parent organization.

orgChildOrgNames

Lists the Identity Manager interface names of all direct and indirect child organizations.

orgApprovers

Lists the Identity Manager administrators who are required to approve users added to or modified
in this organization.

allowedOrgApprovers

Lists the potential user names who could be approvers for users added to or modified in this
organization.

allowedOrgApproverlds

Lists the potential user IDs who could be approvers for users added to or modified in this
organization.

orgUserForm
Specifies the userForm used by members users of this organization when creating or editing users.

orgViewUserForm
Specifies the view user form that is used by member users of this organization when viewing users.
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orgPolicies

Identifies policies that apply to all member users of this organization. This is a list of objects that are
keyed by type string: Each policy object contains the following view attributes, which are prefixed
by orgPolicies[<type>]. <type> represents policy type (for example, Lighthouse account).

* policyName -- Specifies name
* id-- Indicates ID
* implementation -- Identifies the class that implements this policy.

orgAuditPolicies
Specifies the audit policies that apply to all member users of this organization.

renameCreate

When set to true, clones this organization and creates a new one using the value of
orgNewDisplayName.

renameSaveAs
When set to true, renames this organization using the value of orgNewDisplayName.

Directory Junction and Virtual Organization Attributes

Name Editable? Data Type Required?
orgContainerld Read String System-generated
orgContainerTypes Read List System-generated
orgContainers Read List System-generated
orgParentContainerld Read String System-generated
orgResource Read/Write String yes, if directory

junction or virtual
organization

orgResourceType Read String System-generated

orgResourceld Read String System-generated

orgRefreshAllOrgsUserMembers Write String No
orgContainerld

Specifies the dn of the associated LDAP directory container (for example,
cn=foo,ou=bar,o=foobar.com).
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orgContainerTypes
Lists the allowed resource object types that can contain other resource objects.

orgContainers

Lists the base containers for the resource used by the Identity Manager interface to display a list to
choose from.

orgParentContainerld

Specifies the dn of the associated parent LDAP directory container (for example,
ou=bar,o=foobar.com).

orgResource

Specifies the name of the Identity Manager resource used to synchronize directory junction and
virtual organizations (for example, West Directory Server).

orgResourceType

Indicates the type of Identity Manager Resource from which to synchronize directory junction and
virtual organizations (for example, LDAP).

orgResourceld

Specifies the ID of the Identity Manager resource that is used to synchronize directory junctions
and virtual organizations.

orgRefreshAllOrgsUserMembers

If true and if the value of orgAction is refresh, synchronizes Identity organization user
membership with resource container user membership for the selected organization and all child
organizations. If false, resource container user membership will not be synchronized, only the
resource containers to Identity organizations for the selected organization and all child
organizations.

Dynamic Organization Attributes

Name Editable? Data Type Required?

orgUserMembersRule Read/Write String No

orgUserMembersRuleCacheTimeout Read/Write String No
orgUserMembersRule

Identifies (by name or UID) the rule whose authType is UserMembersRule, which is evaluated at
run-time to determine user membership.
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orgUserMembersCacheTimeout
Specifies the amount of time (in milliseconds) before the cache times out if the user members
returned by the orgUserMembersRule are to be cached. A value of 0 indicates no caching.

The discussion of the User view now includes the following discussion of the
accounts [Lighthouse] .delegates attributes: (ID-15468)

accountsfLighthouse].delegates
Lists delegate objects, indexed by workItemType, where each object specifies delegate information
for a specific type of work item

e If delegatedApproversRule is the value of delegateApproversTo, identifies the selected
rule.

e If manager is the value of delegateApproversTo, this attribute has no value.

accountsfLighthouse].delegatesHistory

Lists delegate objects, indexed from 0 to 11, where 7 is the current number of delegate history objects
up to the delegate history depth

This attribute has one unique attribute: selected, which is a Boolean that indicates the currently
selected delegate history object.

accounts[Lighthouse].delegatesOriginal

Original list of delegate objects, indexed by workItemType, following a get operation or checkout
view operation.

All accounts[Lighthouse] .delegates* attributes take the following attributes:

Attributes of Description

accounts[Lighthouse].delegate*

Attributes

workItemType Identifies the type of workItem being delegated. See the description of the

Delegate Object Model in the Identity Manager Technical Deployment
Overview section of this Documentation Addendum for a valid list of workItem
types.

workItemTypeObjects Lists the names of the specific roles, resources, or organizations on which the
user is delegating future workItem approval requests. This attribute is valid
when the value of workItemType is roleApproval, resourceApproval, Or
organizationApproval.

If not specified, this attribute by default specifies the delegation of future
workItem requests on all roles, resources, or organizations on which this user
is an approver.
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Attributes of Description

accounts[Lighthouse].delegate*

Attributes

toType Type to delegate to. Valid values are:
manager

delegateWorkltemsRule

selectedUsers

toUsers Lists the names of the users to delegate to (if toType is selectedUsers) .

toRule Specifies the name of the rule that will be evaluated to determine the set of
users to delegate to (if toType is delegatelWorkItemsRule).

startDate Specifies the date when delegation will start.

endDate Specifies the date when delegation will end.

Referencing a DelegateWorkltems View Object from a Form

The following code sample illustrates how to reference a DelegateWorkltems view delegate object
from a form:

<Field name='delegates[*].workItemType'>
<Field name='delegates[*].workItemTypeObjects’>
<Field name='delegates[*].toType’>

<Field name='delegates[*].toUsers'>

<Field name='delegates[*].toRule’>

<Field name='delegates[*].startDate'>

<Field name='delegates[*].endDate'>

where supported index values (*) are workItemType values.
e This chapter now contains the following description of the User Entitlement view:
Use to create and modify UserEntitlement objects.

This view has the following top-level attributes:

Name Editable? Type Required?
name String Yes
status String Yes
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Name Editable? Type Required?
user String Yes
userId String Yes
attestorHint String No
userView GenericObject Yes
reviewInstanceId String Yes
reviewStartDate String Yes
scanId String Yes
scanInstanceld String Yes
approvalWorkflowName String Yes
organizationId String Yes
attestorComments.name String No
attestorComments.attestor String No
attestorComments. time String No
attestorComments. timestamp String No
attestorComments.status No

name
Identifies the User Entitlement (by a unique identifier).

status

Specifies the state of User Entitlement object. Valid states include PENDING, ACCEPTED,
REJECTED, REMEDIATING, CANCELLED.

user
Identifies the name of the associated WSUser for this entitlement.

userld
Specifies the ID of the associated WSUser.

attestorHint

Displays the (String) hint to the attestor that is provided by the Review Determination Rule. This
hints acts as “advice” from the rule to the attestor.
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userView

Contains the User view that is captured by User Entitlement scanner. This view contains zero or
more resource accounts depending on the configuration of the Access Scan object.

reviewInstanceld
Specifies the ID of the PAR Task instance.

reviewStartDate
Indicates the (String) start date of the PAR task (in canonical format).

scanld
Specifies the ID of AccessScan Task definition.

scaninstanceld
Specifies the ID of AccessScan Task instance.

approvalWorkflowName

Identifies the name of workflow to be run for approval. This value comes from the Access Scan
Task definition.

organizationld
Specifies the ID of the WSUser's organization at the time of the scan.

attestorComments

Lists attestation records for the entitlement. Each attestation record indicates an action or statement
made about the entitlement, including approval, rejection, and rescan.

attestorComments|[timestamp].name
Timestamp used to identify this element in the list.

attestorComments[timestamp].attestor
Identifies the WSUser name of the attestor making the comment on the entitlement.

attestorComments[timestamp].time
Specifies the time at which the attestor attested this record. May differ from the timestamp.

attestorComments[timestamp].status

Indicates the status assigned by the attestor. This can be any string, but typically is a string that
indicates the action taken by the attestor -- for example, approve, reject, rescan, remediate.
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attestorComments[name].comment
Contains comments added by attestor.

The following User view attributes have been deprecated. (ID-15468)
accounts [Lighthouse] .delegateApproversTo

accounts [Lighthouse].delegateApproversSelected

accounts [Lighthouse] .delegateApproversStartDate

accounts [Lighthouse] .delegateApproversEndDate

The Delegate Approvers view has been deprecated, but still works for editing Delegate
objects whose workItemType is approval.

The existing User View accounts[Lighthouse] .delegate* attributes are deprecated and
no longer available via the User View. Use the new accounts [Lighthouse] .delegates
view.

Chapter 6, XPRESS Language

130

This chapter has been substantially updated. See the.pdf titled XPRESS in the same
directory as these Release Notes.

The description of the isTrue function should be revised as follows: (ID-17078)

Used when referencing Boolean values that are represented with the strings true and false
rather than the numbers 0 and 1. Takes one argument.

The following are considered true. Anything is considered false.
o The string true

o A Boolean true

o Anon-zero integer

Return value is:

o  0-theargument is logically false.

o 1-theargument is logically true.

Example

The following expression returns 0.

<isTrue>
<s>false</s>
</isTrue>
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Chapter 8, HTML Display Components

¢ The following discussion about an alternative to the MultiSelect component has been
added to this chapter:

It can be unwieldy to display many admin roles using the MultiSelect component (either
the applet or HTML version). Identity Manager provides a more scalable way of displaying
and managing admin roles: the objectSelector field template. (ID-15433)

The Scalable Selection Library (in sample/formlib.xml) includes an example of using an
objectsSelector field template to search for admin role names that a user can select.

Code Example Example of objectSelector Field Template

<Field name='scalableWaveset.adminRoles'>
<FieldRef name='objectSelector'>

<Property name='selectorTitle' value='_FM ADMIN ROLES'/>
<Property name='selectorFieldName' value='waveset.adminRoles'/>
<Property name='selectorObjectType' value='AdminRole'/>
<Property name='selectorMultiValued' value='true'/>
<Property name='selectorAllowManualEntry' value='true'/>
<Property name='selectorFixedConditions'>

<appendAll>
<new class='com.waveset.object.AttributeCondition'>
<s>hidden</s>
<s>notEquals</s>
<s>true</s>
</new>
<map>

<s>onlyAssignedToCurrentSubject</s>
<Boolean>true</Boolean>
</map>
</appendAll>
</Property>
<Property name='selectorFixedInclusions'>
<appendAll>
<ref>waveset.original.adminRoles</ref>
</appendAll>
</Property>
</FieldRef>
</Field>
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How to Use the objectSelector Example Code

132

1.
2.

From the Identity Manager IDE, open the Administrator Library UserForm object.
Add the following code to this form:
<Include>
<ObjectRef type='UserForm' name='Scalable Selection Library'/>
</Include>
Select the accounts[Lighthouse] .adminRoles field within the AdministratorFields field.
Replace the entire accounts [Lighthouse] .adminRoles with the following reference:
<FieldRef name='scalableWlaveset.adminRoles'/>
Save the object.

When you subsequently edit a user and select the Security tab, Identity Manager displays
the customized form. Clicking ... opens the Selector component and exposes a search field.
Use this field to search for admin roles that begin with a text string and set the value of the
field to one or more values.

To restore the form, import $WSHOME/sample/formlib.xml from Configure > Import
Exchange File.

See the Scalable Selection Library in sample/formlib.xml for other examples of using the
objectSelector template to manage resources and roles in environments with many
objects.

The discussion of the TabPanel component now contains the following description of the
validatePerTab property: (ID-15501)

validatePerTab -- When set to true, Identity Manager performs validation expressions as
soon as the user switches to a different tab.

The discussion of the MultiSelect component now contains the following description of the
displayCase property: (ID-14854)

displayCase — Maps each of the allowedValues to their uppercase or lowercase
equivalents. Takes one of these two values: upper and lower.
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The following discussion of the Menu component has been added to this chapter:
(ID-13043)

Consists of three classes: Menu, MenuBar, and MenuItem.

o  Menu refers to the entire component.

o MenuItemis aleaf, or node, that corresponds to a tab on the first or second level.
o MenuBar corresponds to a tab that contains MenuBars, or MenuItems.

Menu contains the following properties:

o layout - A String with value horizontal or vertical. A value of horizontal generates
a horizontal navigation bar with tabs. A value of vertical causes the menu to be
rendered as a vertical tree menu with typical node layout.

o stylePrefix - String prefix for the CSS class name. For the Identity Manager End User
pages, this value is User.

MenuBar contains the following properties:

o default - A String URL path that corresponds to one of the MenuBar's Menultem URL
properties. This controls which subtab is displayed as selected by default when the
MenuBar tab is clicked.

MenuItem contains the following properties:

o containedUrls - A List of URL path(s) to JSPs that are "related" to the Menultem. The
current Menultem will be rendered as "selected" if any of the containedUrls JSPs are
rendered. An example is the request launch results page that is displayed after a
workflow is launched from the request launch page.

You can set these properties on either a MenuBar or MenuItem:
o title - Specifies the text String displayed in the tab or tree leaf as a hyperlink
o  URL - Specifies the String URL path for the title hyperlink
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The following XPRESS example creates a menu with two tabs. The second tab contain two
subtabs:

Code Example Implementation of Menu, Menultem, and MenuBar Components

<Display class='Menu'/>
<Field>
<Display class='Menultem'>
<Property name='URL' value='user/main.jsp'/>
<Property name='title' value='Home' />
</Display>
</Field>
<Field>
<Display class='MenuBar' >
<Property name='title' value='Work Items' />
<Property name='URL' value='user/workItemListExt.jsp' />
</Display>
<Field>
<Display class='Menultem'>
<Property name='URL' value='user/workItemListExt.jsp'/>
<Property name='title' value='Approvals' />
</Display>
</Field>
<Field>
<Display class='Menultem'>
<Property name='URL' value='user/otherWorkItems/listOtherWorkItems.]jsp'/>
<Property name='title' value='Other' />
</Display>
</Field>
</Field>

* The following discussion of the ListEditor component has been added to this chapter:
(ID-16518)

ListEditor
Renders an editable list of strings.

Table 3 Properties of the ListEditor Component

Property Description

listTitle (String) Specifies the label that Identity Manager places next to the ListEditor
graphical representation.

pickListTitle (String) Specifies the label to use on the picklist component.

valueMap (Map) Specifies a map of display labels for the values in the list.

allowDuplicates (Boolean) A value of true indicates that Identity Manager allows duplicates in

the managed list
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Table 3  Properties of the ListEditor Component

Property Description

allowTextEntry (Boolean) A value of true indicates that Identity Manager displays a text entry
box, along with an add button.

fixedwidth (Boolean) A value of true indicates that the component should be of fixed width
(same behavior as Multiselect component).

ordered (Boolean) A value of true indicates that the order of values is important.

sorted (Boolean) A value of true indicates that the values should be sorted in the pick
list. If values are multi-valued and not ordered, Identity Manager also sorts the
value list.

pickvalueMap (List or Map) Specifies a map of display labels for the values in the pick list.

pickValues (List) Specifies the available values in the picklist component. If null, the

picklist is not shown
height (Integer) Specifies preferred height.

width (Integer) Specifies the preferred width. Can be used by the Container as a
property of the table cell in which this item is rendered

Example

The following example from the Tabbed User Form shows a form field that uses the
ListEditor display class:

<Field name='accounts[Siml].Group'>
<Display class='ListEditor' action='true'>
<Property name='listTitle' value='stuff'/>
<Property name='allowTextEntry'>
<Boolean>true</Boolean>
</Property>
<Property name='ordered'>
<Boolean>true</Boolean>
</Property>
</Display>
<Expansion>
<ref>accounts[Siml] .Group</ref>
</Expansion>
</Field>

This code snippet creates a field where the customer can add groups to or remove them
from a user.
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NOTE This display class typically requires a List of Strings as input. To coerce a
single String into a List of Strings:

<Expansion>
<appendAll><ref>accounts[Siml] .Group</ref></appendall>

</Expansion>

* The Text display component contains the new autocomplete property. (ID-17310) Setting
the autocomplete property to off prevents browsers from offering to store the user's
credentials on their computer.

You can implement this feature in input fields in XPRESS by adding this display property.
Any value other than off prevents Identity Manager from rendering the autocomplete
attribute in the rendered HTML from (which is the same as not setting the property).

Enabling autocomplete for Identity Manager Login Pages

You can enable this feature for the Identity Manager login pages by changing the
ui.web.disableAutocomplete system configuration object to true. Identity Manager login
pages include login. jsp, continueLogin. jsp, user/login.jsp, and
user/continuelLogin. jsp.

Identity Manager login forms other than the preceding ones are generated from XPRESS,
and you must edit these forms to use the new display property. These forms, which reside
in the sample directory, include this property commented out by default.

o Anonymous User Login

o Question Login Form

o End User Anonymous Enrollment Validation Form
o End User Anonymous Enrollment Completion Form

o  Lookup Userid

Appendix A, Form and Process Mappings

* Anupdated version of this appendix, titled Form and Process Mappings, is included in the
same directory as these Release Notes.

* You can access compliance-specific tasks through the mapped names. (ID-15447)
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Process Name Mapped Name Description

Access Review accessReview Performs an access review

Access Scan accessReviewScan Performs an access scan

Access Review Rescan accessReviewRescan Performs an access rescan

Audit Policy Rescan auditPolicyRescan Performs an audit policy rescan

Abort Access Review abortAccessReview Terminates an access review

Delete Access Review deleteAccessReview Deletes an access review

Recover Access Review recoverAccessReview Recovers missing access review status

objects from audit logs

|dentity Manager Deployment Tools

This section provides corrections and additions to the Identity Manager Deployment Tools
documentation:.

¢ The “Using the Identity Manager IDE” chapter (provided in previous releases) has been
removed from this book. Instructions for installing and configuring the Identity Manager
Integrated Development Environment (Identity Manager IDE) are now provided on
https://identitymanageride.dev.java.net. (ID-17700)

Instructions for using the Identity Manager’s Profiler and the Identity Manager FAQ are
provided on the following pages for your convenience.

NOTE Identity Manager Profiler is only supported on version 7.1 Update 1 and later.

Working with the Identity Manager Profiler

Identity Manager provides a Profiler utility to help you troubleshoot performance problems with
forms, Java, rules, workflows, and XPRESS in your deployment.

Forms, Java, rules, workflows, and XPRESS can all cause performance and scale problems. The
Profiler profiles how much time is spent in these different areas, enabling you to determine if these
forms, Java, rules, workflows, or XPRESS objects are contributing to performance and scale
problems and, if so, which parts of these objects are causing the problems.

Documentation Additions and Corrections 137



Identity Manager Deployment Tools

This section explains how to use Identity Manager’s Profiler and provides a tutorial to help you
learn how to troubleshoot performance issues in your deployment. The information is organized as
follows:

¢ Overview
* Getting Started
* Using the Profiler

e Tutorial: Troubleshooting Performance Problems

NOTE Identity Manager Profiler is only supported on version 7.1 Update 1 and later.

Overview

The section provides an overview of the Identity Manager’s Profiler’s features and functionality.
The information is organized as follows:

* Major Features
* How the Profiler Locates and Manages Source
¢ Statistics Caveats
Major Features
You can use the Profiler utility to
e Create “snapshots” of profiling data.

A snapshot is the cumulative result of profiling since the last time you reset all of your
collected profile results.

* You an display snapshot results in four, different data views:

o Call Tree view provides a tree table showing the call timing and invocations counts
throughout the system.

o Hotspots view provides a flattened list of nodes that shows the aggregate call timings
regardless of parent.

o Back Traces view provides an inverted call stack showing all the call chains from
which that node (known as the root node) was called.

o Callees view provides an aggregate call tree of the root node, regardless of its parent
chain.

* Specify what kinds of information to include in your snapshot:
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o You can include every element of form, workflow, and XPRESS or restrict the content
to a set of specific elements.

o You can pick specific Java methods and constructors to include or exclude from the
instrumentation. Instrumentation of Identity Manager classes and custom classes is
supported.

* Manage your project snapshots as follows:

o Save the snapshot in your project’s nbproject/private/idm-profiler directory or to
an arbitrary location outside of your project.

NOTE You can view a list of all saved snapshots in the Saved Snapshots section
of the IDM Profiler view.

o Open snapshots from your project or load them from an arbitrary location outside your
project.

o Delete snapshots.
* Search for specific nodes, by name.
How the Profiler Locates and Manages Source

This section describes how the Profiler looks up and manages the source for the following Identity
Manager objects:

e For Forms, Rules, Workflows, and XPRESS Objects

e For Java Source

TIP In Call Tree view or Hotspots view, you can double-click any node that corresponds
to a Java method, workflow, form, rule, or XPRESS to view the source for that node.

For Forms, Rules, Workflows, and XPRESS Objects When you take a snapshot with the Profiler,
the server evaluates all of the profiling data and discovers on which sources the data depends. The
server then fetches all of these sources from the repository and includes them in the snapshot.
Consequently, you can be sure that the Identity Manager objects displayed in the snapshot are
accurately reflecting the point at which the snapshot was captured.

This process adds to the size of the snapshot, but the source size is actually a relatively small
fraction of the total size. As a result, you can send a snapshot to Sun’s Customer Support without
having to send your source files separately.
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For Java Source When you take a snapshot of Java source, the client downloads the snapshot and
then goes through the snapshot to capture all referenced Java sources from the project. When you
save the snapshot, the client zips the sources and attaches them to the end of the snapshot.

Then, when you view the snapshot and go to the Java source, the client first checks the content of
the snapshot. If the client cannot find the content there, it checks the project’s content. This process
allows you to send a snapshot containing profiling data from both your custom Java code and
Identity Manager code.

NOTE In a Java source snapshot, do not assume the source is up-to-date with the server or
always available.

Statistics Caveats
The following sections contain information to consider when you evaluate results provided by the
Profiler:

*  Self Time Statistics

e Constructor Calls

e Daemon Threads

Self Time Statistics To compute a root node’s Self Time statistic, the Profiler subtracts the times
of all children nodes from the root node’s total time.

Consequently, an uninstrumented child node’s time is reflected in the root node’s self time. If a root
node has a significant self time, you should certainly investigate why. You might not have the
proper methods instrumented and so you are looking in the wrong place.

For example, assume method A calls method B.

Method A takes a total time of 10 seconds (where total time includes the call to B) and the call to B
takes a total time of 10 seconds.

If both A and B are instrumented, the call stack reflects that information. You will see that A has a
self-time of 0 seconds and that B has a self-time of 10 seconds (where 10 seconds was actually spent
in B). If, however, B is not instrumented, you only see that the call to A takes 10 seconds and that
A's self-time is 10 seconds. Consequently, you might assume the problem lies directly in A rather
than in B.

In particular, you might notice large self times on JSPs during their initial compile. If you reset the
collected results and then redisplay the page, the self time value will be much less.

Constructor Calls Because there are limitations in the Java instrumentation strategy, initial calls
to this () or super () will appear as a sibling to the constructor call, rather than as a child. See the
following example:
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class A
{
public A()
{
this(0);
}
public A(int 1)
{
}
}

and:

class B
{
public static void test()
{
new A();
}
}
The call tree will look like this:
B.test()
-A.<init>(int)
-A.<init>()
Rather than this:
B.test()
-A.<init>()
-A.<init> (int)

Daemon Threads Do not be mislead by the seemingly large amount of time spent in a number of
Identity Manager’s daemon threads, such as ReconTask.WorkerThread.run() or
TaskThread.WorkerThread.run (). Most of this time is spent sleeping, while waiting for events. You
must explore these traces to see how much time is actually spent when they are processing an

event.

Getting Started

This section describes how to start the Profiler and how to work with various features of the
Profiler’s graphical user interface. This information is organized as follows:

* Before You Begin

e Starting the Profiler
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* Specifying the Profiler Options

Before You Begin

Because the Profiler is very memory intensive, you should significantly increase the memory for
both your server and the Netbeans Java Virtual Machine (JVM).

¢ Toincrease your server’s memory,
a. Open the Netbeans window and select the Runtime tab.

b. Expand the Servers node, right-click Bundled Tomcat, and select Properties from the
menu.

c. When the Server Manager dialog displays, clear the Enable HTTP Monitor box on the
Connection tab.

d. Select the Platform tab, set VM Options to -Xmx1024M, and then click Close.
¢ To increase the Netbeans JVM memory,
a. Open the netbeans-installation-dir\etc\netbeans . conff file and locate the following line:
netbeans_default_options="-J-Xms32m -J-Xmx ...
b. Change the-J-xmx value to -J-Xmx1024M.
c. Save, and then close the file.
When you are finished, you can start the Profiler as described in the next section.

Starting the Profiler

You can use any of the following methods to start the Profiler from the Identity Manager IDE
window:

*  Click the Start Identity Manager Profiler on Main Project icon <} located on the menu bar.

NOTE The Start Identity Manager Profiler on Main Project icon is enabled when the
main Identity Manager project is version 7.1 Update 1 or later.

e Select Window > IDM Profiler from the menu bar.

The Identity Manager Profiler window appears in the Explorer. From this window, select
an Identity Manager project from Current Project drop-down menu, and then click the Start
Identity Manager Profiler icon ;. located in the Controls section.

¢ Right-click a project in the Projects window, and then select Start Identity Manager Profiler
from the pop-up menu.
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* Select a project in the Projects window, and then select IdM > Start Identity Manager
Profiler from the menu bar.

When you start the Profiler, the Profiler Options dialog displays so you can specify which profiling
options you want to use. Instructions for setting these options are provided in “Specifying the
Profiler Options” on page 143.

Using the Profiler

This section describes the features of the Profiler graphical user interface, and how to use these
features. The information is organized as follows:

* Specifying the Profiler Options
e  Working with the IDM Profiler View
*  Working with the Snapshot View
¢ Using the Pop-Up Menu Options
* Searching a Snapshot
* Saving a Snapshot
Specifying the Profiler Options
The Profiler Options dialog consists of the following tabs:
* Mode
¢ IDM Object Filters
e Java Filters
* Miscellaneous

Use the options on these tabs to indicate which objects to profile and which elements to display in
the profile.

After specifying the Profiler options, click OK to start the Profiler. Depending on your project
configuration, the Profiler does one of two things:

* If you are using a regular Identity Manager project with an Embedded Identity Manager
Instance, the Profiler performs a full build, deploys into the NetBean's application server,
and starts the Profiler.

¢ If you are using a regular Identity Manager project with an External Identity Manager
Instance or the remote Identity Manager project, the Profiler attaches to the Identity
Manager instance configured for the project.
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NOTE You can select IdM > Set Identity Manager Instance to control the Identity
Manager Instance action for the project.

Mode The Mode tab provides the following options:

* IDM Objects Only: Select to profile form, rule, workflow, and XPRESS objects. Excludes
Java objects from the profile.

* Java and IDM Objects: Select to profile form, Java, rule, workflow, and XPRESS objects.

NOTE ¢ The Java and IDM Objects option is not available if you are using a
regular Identity Manager project with an external Identity Manager
instance or using a remote Identity Manager project.

*  You cannot change the Mode option while the Profiler is running. You
must stop the Profiler to change the option.

IDM Object Filters The IDM Object Filters tab provides the following options:
¢ Show IDM Object details:

o Select this box to include every executed form, workflow, and XPRESS element in the
snapshot.

o  Clear this box to include only the following elements in the snapshot:
»  <invoke>
»  <new>
» <Rule>
’ <Form>
’ <WFProcess>
» <ExScript>
»  <ExDefun>
» <FieldRef>
»  <Action> (for workflow application callouts)

¢ Include Anonymous Sources:
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NOTE Anonymous sources are forms (or portions of a form) that are generated on
the fly (such as Login forms and MissingFields forms) and do not
correspond to a persistent form that resides in the Identity Manager
repository.

o  Select this box to include Anonymous sources in the snapshot.

o  Clear this box to exclude Anonymous sources from the snapshot.

Java Filters Select the Java Filters tab to

Include or exclude Java filters
Create new filters
Delete existing filters

Restore the default filters

Java filters are given in terms of method patterns, and they are expressed in patterns that include or
exclude based on canonical method name. Where a canonical method name is:

fully-qualified-class-name.method-name (parameter-type-1, parameter-type-2, ...)

NOTE

For constructors, method-name is <init>.

Here are a few examples:

To exclude all constructors, enable the Exclude box and add the following filter:
*,.<init>(*)

To exclude all constructors with a single org.w3c.dom. Element parameter, enable the
Exclude box and add the following filter:

*,<init>(org.w3c.dom.Element)

To exclude all Identity Manager classes, enable the Exclude box and add the following
filters:

"com.waveset.*"
"com.sun.idm.*"

To instrument your custom code only, disable the Exclude box, remove the initial *
include filter, and then add the following filter:
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"com.yourcompany. *"

NOTE The last two examples are currently equivalent because the filters are
applied only to your custom classes and Identity Manager classes.

If necessary, you can instrument other jars by modifying the following lines in build.xml as
appropriate. For example,

<instrument todir="${lighthouse-dir-profiler}/WEB-INF" verbose="${instrumentor.verbose}"
includeMethods="${profiler.includes}" excludeMethods="${profiler.excludes}">
<fileset dir="${lighthouse-dir}/WEB-INF">
<include name="1lib/idm*.jar"/>
<include name="classes/**/*.class"/>
</fileset>
</instrument>

By default, the configuration includes all your custom classes and most Identity Manager classes. A
number of Identity Manager classes are forcibly excluded — because enabling them would break
the Profiler.

For example, classes from the workflow, forms, and XPRESS engines are excluded or the Profiler
would produce an unintelligible snapshot when profiling Java and Identity Manager objects.

Note that Java filters provide much more filtering granularity than IDM Object Filters. Java
instrumentation adds significant overhead to the execution time, which can drastically skew the
profiling results. Because Identity Manager objects are interpreted rather than compiled, the
instrumentation overhead is negligible. So for example, there is basically no reason to exclude
workflow A and include workflow B, and so forth.

NOTE You cannot modify Java filters while the Profiler is running. You must stop the
Profiler before changing Java filters.

Miscellaneous The Miscellaneous tab provides the following options:
* Prune snapshot nodes where execution time is 0:

o Disable this option (default) if you want the snapshot to include invocation information
for all executed entities — even those whose execution time is zero.
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It might be useful to have the number of invocations, even for nodes where there is no
execution time.

o  Enable this option to remove these nodes, which allows you to focus on the most
relevant profiling data. In addition, enabling this option can provide a large savings in
Profiler snapshot size.

* Automatically Open Browser Upon Profiler Start:

o Enable this option (default) when you launch the Profiler to automatically open a
browser that points to the Identity Manager instance being profiled.

o Disable this option if you do not want to open a browser.
¢ Include Java Sources in Snapshot:

o Enable this option (default) to include Java sources for any Java methods referenced by
the profiling data in the Snapshot. You should always use this setting for snapshots in
the field. Custom Java is relatively small and it is very valuable to have for support.

o  Disable this option only if you are profiling Identity Manager and have the complete
Identity Manager source available.

In this situation, you do not want to include the Identity Manager source because it can
create extremely large snapshots. (See “How the Profiler Locates and Manages Source”
on page 139 for more information.)

Working with the IDM Profiler View

The IDM Profiler view consists of the following areas:
e Current Project Area
¢ Controls Area
e Status Area

* Saved Snapshots Area

Current Project Area The Current Project area consists of a drop-down menu that lists all of your
current projects. Use this menu to select the project you want to profile.

Controls Area The Controls area contains four icons, as described in the following table:

Icon Purpose

e Start Identity Manager Profiler ~ Starts the Profiler and opens the Profiler Options dialog.
Stop Identity Manager Profiler ~ Stops the Profiler.

(33 Reset Collected Results Resets all of the profile results you collected to this point.
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Icon Purpose

& Modify Profiling Re-opens the Profiler Options dialog so you can change any of the settings
to modify your current profile results.

Status Area The Status area reports whether you are connected to the Host and provides Status
information as the Profiler is starting up, running, and stopping.

Profiling Results Area The Profiling Results area contains two icons, which are described in the
following table:

Icon Purpose

Eaf

_J Start Identity Manager Profiler ~ Starts the Profiler and opens the Profiler Options dialog.

e
()

o2 Reset Collected Results Resets all of the profile results you collected to this point.

Saved Snapshots Area The Saved Snapshots area provides a list of all saved snapshots.

NOTE Instructions for saving snapshots are provided in “Saving a Snapshot” on page 151.

In addition, you can use the following buttons to manage these snapshots:

* Open: Click to open saved snapshots in the Snapshot View window.

TIP You can also double-click a snapshot in the Saved Snapshots list to open that
snapshot.

* Delete: Select a snapshot in the Saved Snapshots list, and then click this button to delete the
selected snapshot.

* Save As: Select a snapshot in the list and then click this button to save that snapshot
externally to an arbitrary location.

¢ Load: Click to open a snapshot from an arbitrary location into the Snapshot View window.
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Working with the Snapshot View

When you open a snapshot, the results display in the Snapshot View window, located on the upper
right side of Identity Manager IDE.

A snapshot provides several views of your data, which are described in the following sections:

Call Tree View

Hotspots View

Back Traces View

Callees View

Call Tree View Call Tree view consists of a tree table showing the call timing and invocation
counts throughout your system.

This tree table contains three columns:

Call Tree column: Lists all nodes.

Top-level nodes are one of the following;:

o]

Thread.run () methods for various background threads in the system

For example, if you enabled Java profiling, you will see the
ReconTask.WorkerThread.run () method.

Request timings

For example, if you viewed the idm/login.jsp URL, you will see a top-level entry for
idm/login.jsp. The data displayed in the Time column for this entry represents the
total time for that request (or requests). The data displayed in the Invocations column
represents the total number of invocations to that page. You can then explore further
into that data to see what calls contributed to its time.

NOTE The Call Tree also contains Self Time nodes. Self Time values represent
how much time was spent in the node itself. (For more information, see
“Self Time Statistics” on page 140.)

Time column: Lists the time spent in each node when that node was called from its parent.
The percentages are given relative to parent time.

Invocations column: Lists how many times each node was invoked from its parent.

Hotspots View Hotspots view provides a flattened list of nodes that shows aggregate call timings
regardless of parent.
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This view contains the following columns:
e Self Time: Lists the total amount of time spent in each node.
* Invocations: Lists the total number of times each node was invoked from its parent.

* Time: Lists the total amount of time spent in each node and in all of its children.

Back Traces View Back Traces view provides an inverted call stack showing all the call chains
from where each node was called.

You can use these statistics to answer the question — How much time would I save if I eliminated
this particular call chain from this node?

You can access the Back Traces view from any of the other snapshot views by right-clicking a node
(known as the root node) and selecting Show Back Traces from the pop-up menu.

NOTE The Time and Invocations data values mean something different in Back Traces
view:

¢ Time: The values in this column represent the time spent in the root node when
it is called from a given call chain.

* Invocations: The values in this column represent how many times the root node
was invoked from a given call chain.

Callees View Callees view provides an aggregate call tree for a node (known as the root node),
regardless of its parent chain.

These statistics are helpful if you have a problem area that is called from many places throughout
the master call tree and you want to see the overall profile for that node.

You can access the Callees view from any of the other snapshot views by right-clicking a node
(known as the root node) and selecting Show Callees from the pop-up menu.

NOTE The Time and Invocations data values used in Callees view have the same meaning
as those used in Call Tree view.

Using the Pop-Up Menu Options
Right-click any node in Call Tree view or in Hotspots view and a pop-up menu displays with the
options described the following table:
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Menu Options Description

GoTo Source Select this option to view the XML source for a node that corresponds to a
Java method, workflow, form, rule, or XPRESS. For detailed information
about this view, see “How the Profiler Locates and Manages Source” on

page 139.

Show Back Traces Select this option to access the Back Traces view. For detailed information
about this view, see “Back Traces View” on page 150.

Show Callees Select this option to access the Callees view. For detailed information about
this view, see “Callees View” on page 150.

Find In Hotspots Select this option to find a node in the Hotspots view. For detailed
information about this view, see “Hotspots View” on page 149.

List Options > Sort > Select this option to
* None
e Call Tree
e Time

¢ Invocations
e Ascending
¢ Descending

List Options > Change Visible Columns  Select this option to change the columns displayed in the Call Tree or
Hotspots list.

When the Change Visible Columns dialog displays, you can select one or
more of the following options:

e Call Tree: Call Tree
¢ Invocations: Invocations

e Time: Time

Searching a Snapshot

Use the Search icon /', located at the top of the Snapshot View window to search for nodes by
name the Call Tree view or Hotspots tree.

Alternatively, right-click any node in Call Tree view or Hotspots view and select Find in Call Tree
or Find in Hotspots (respectively) from the pop-up menu to search for a node.

Saving a Snapshot

The Profiler provides several options for saving a snapshot. See the following table for a description
of these options:
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Icon Purpose

Save the Snapshot in the Projecticon  Saves the snapshot in the nbproject/private/idm-profiler
(located at the top of the Snapshot directory of your project. Snapshots saved in your project are listed in
View window) the Saved Snapshots section of the Profiler view.

= Save the Snapshot Externally icon Saves a snapshot to an external, arbitrary location.

(located at the top of the Snapshot
View window)

Save As button (located in the Saved  Saves a snapshot to an external, arbitrary location.

Snapshots area)

Tutorial: Troubleshooting Performance Problems

Identity Manager provides a tutorial (profiler-tutorial.zip) to help you learn how to use the
Profiler to troubleshoot forms, Java rules, workflows, and XPRESS.

Step 1: Create an Identity Manager Project
Follow these steps to create an Identity Manager project:

1.
2.

Select File > New Project.
When the New Project wizard displays, specify the following, and then click Next:
a. In the Categories list, select Web to indicate what type of project you are creating.

b. In the Projects list, select Identity Manager Project.

NOTE You must create a regular Identity Manager project for a fully featured
development environment. Do not select the Identity Manager Project
(Remote) option.

Complete the following fields on the Name and Location panel, and then click Next:
o  Project Name: Enter Idm80 as the project name.

o Project Location: Use the default location or specify a different location.

o Project Folder: Use the default folder or specify a different folder.

When the Identity Manager WAR File Location panel displays, enter the location of the
Identity Manager 8.0 war file. Typically, unzipping this file creates an idm.war file in the
same directory.
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5. Click Next to continue to the Repository Setup panel.

You should not have to change the default settings on this panel, just click Finish. When
you see the BUILD SUCCESSFUL message in the Identity Manager IDE Output window, you
can extract the Profiler tutorial files. See “Step 2: Unzip the Profiler Tutorial” for
instructions.

Step 2: Unzip the Profiler Tutorial
Unzip profiler-tutorial.zip in the project root. The extracted files include:
<project root>/custom/WEB-INF/config/ProfilerTutoriall.xml
<project root>/custom/WEB-INF/config/ProfilerTutorial2.xml
<project root>/src/org/example/ProfilerTutorialExample. java
<project root>/PROFILER_TUTORIAL_README. txt
You are now ready to start the Profiler.
Step 3: Starting the Profiler
To start the Profiler,

1. Use the instructions provided in “Before You Begin” on page 142 to increase the memory
for your server and Netbeans JVM.

2. Use any of the methods described in “Overview” on page 138 to start the Profiler.
3. When the Profiler Options dialog displays, you can specify profiling options.
4. Continue to “Step 4: Setting the Profiler Options.”

Step 4: Setting the Profiler Options

NOTE For detailed information about all of the different Profiler options, see “Specifying
the Profiler Options” on page 143.

For the purposes of this tutorial, specify the following Profiler options:

1. On the Mode tab, select Java and IDM Objects to profile form, Java, rule, workflow, and
XPRESS objects.

2. Select the Java Filters tab.

Use the following steps to disable all Identity Manager Java classes except your custom Java
classes (in this case, org.example.ProfilerTutorial Example):

a. Click New and a new, blank field appears at the bottom of the Filter column.
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b. Enter com.waveset.* into the new field, and then select the Exclude box.
c. Click New again.
d. Enter com.sun.idm.* into the new field, and then select the Exclude box.

Click OK to run the Profiler.

NOTE The Profiler takes a few minutes to complete the first time you runitona
project or if you have recently performed a Clean Project action.

When the Profiler finishes processing, you are prompted to Log In.

Enter the password configurator, select the Remember Password box, and then click OK
to continue.

When the Identity Manager window displays, log in.

NOTE Typically, you should log in to Identity Manager as a different user instead
of logging in as configurator again. You are already logged into the Profiler
as configurator, and the Identity Manager session pool only allows one entry
per user. Using multiple entries can result in the appearance of a broken
session pool and might skew your profiling results for finer-grained
performance problems.

However, for this simple example the session pool is of no consequence so
you can login as configurator/configurator.

In Identity Manager, select Server Tasks > Run Tasks, and then click
ProfilerTutorial Workflow1.

The tutorial might take a few moments to respond.

Although you could take a snapshot now; you are going to reset your results instead, run
the Profiler, run it again, and then take a snapshot.

NOTE It is a best practice to run the Profiler a couple of times before taking a
snapshot to be sure all the caches are primed, all the JSPs are compiled, and
so forth.

Running the Profiler several times enables you to focus on actual
performance problems. The only exception to this practice is if you are
having a problem populating the caches themselves.
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a. Return to the IDM Profiler view in the Identity Manager IDE. Click the Reset Collected
Results icon & in the Profiling Results section (or in the Controls section) to reset all of
the results collected so far.

b. InIdentity Manager, select Server Tasks > Run Tasks again, and click
ProfilerTutorial Workflow1.

c. When the Process Diagram displays, return to the Identity Manager IDE and click Take
Snapshot in the Profiling Results section.

The Identity Manager IDE downloads your snapshot and displays the results on the right
side of the window.

This area is the Call Tree view. At the top of the Call Tree, you should see a
/idm/task/taskLaunch.jsp with a time listed in the Time column. The time should
indicate that the entire request took six+ seconds.

Expand the /idm/task/taskLaunch.jsp node, and you can see that
ProfilerTutorial Workflow1 took six seconds.

Expand the ProfilerTutorialWorkflowl node. Note that activity2 took four seconds and
activityl took two seconds.

Expand activity2.
Note that actionl took two seconds and action2 took two seconds.
Expand actionl and note that the <invoke> also took two seconds.

Double-click the <invoke> to open ProfilerTutorialWorkflowl.xml and highlight the
following line:

<invoke name='example' class='org.example.ProfilerTutorialExample'/>

You should see that a call to the ProfilerTutorialExample method took two seconds.

NOTE You are actually browsing XML source that was captured in the snapshot,
rather than source in the project. Snapshots are completely self-contained.
(For more information, see “How the Profiler Locates and Manages Source”
on page 139.)

Select the CPU:<date><time> tab to return to your snapshot.

Expand the <invoke> node, and note that the Profiler spent two seconds in the Java
ProfilerTutorialExample.example () method.

Double-click the method name to open the ProfilerTutorialExample. java source and
highlight the following line:
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17.

18.

19.

20.

21.

22.

23.

Thread.sleep(2000) ;

There's the problem! This method contains a two-second thread sleep.

If you return to the Call Tree, you can see that all of the two second paths lead to this
method. (You should see three paths; for a total of six seconds.)

Select the Hotspots tab (located at the bottom of the Call Tree area) to open the Hotspots
view. Notice that ProfilerTutorialExample.example () has a total self time of six seconds.

(For more information about Hotspots, see “Hotspots View” on page 149.)

Right-click ProfilerTutorialExample.example () and select Show Back Traces from the
pop-up menu.

A new Back Traces tab displays at the bottom of the area.

Expand the ProfilerTutorialExample.example () node on the Back Traces tab to see that
this method was called from three places, and that the method took two seconds when it
was called from each place.

(For more information about Back Traces, see “Back Traces View” on page 150.)
Click the Save the snapshot in the project icon [F to save your snapshot and close it.

If you check the Saved Snapshots section on the IDM Profiler tab, you should see your
snapshot. (You might have to scroll down.)

Select the saved snapshot, and then click Open to re-open it.

NOTE You can use the Save As button to save your snapshots externally and use
the Load button to load a snapshot from outside your project.

Close the snapshot again.

Using the Profiler on a Workflow ManualAction
The next part of this tutorial illustrates how to profile a workflow ManualAction.

156

1.

In Identity Manager, select Server Tasks > Run Tasks, and then click
ProfilerTutorial Workflow?2.

After a few moments, an empty form displays.
Click Save and the process diagram displays.

Select Server Tasks > Run Tasks again.
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Return to the Identity Manager IDE IDM Profiler view and click the Reset Collected Results
icon in the Profiling Results section.

Now click ProfilerTutorialWorkflow?2 in Identity Manager.
When the blank form displays again, click Save.
In the IDM Profiler view, click Take Snapshot.

After a few seconds, a snapshot should display in the Call Tree area. You should see that
/1dm/task/workItemEdit.jsp took six+seconds. (This result corresponds to the manual
action in the workflow.)

Expand the /idm/task/workItemEdit.jsp node and note that running all Derivations in
the ManualAction form took a total of six seconds.

Expand the Derivation, displayNameForm, variables.dummy, and <block> nodes.

You should see that the <block> took six seconds and, of that time, the Profiler spent two
seconds in each of the three invokes to the ProfilerTutorialExample.example (). method.

10. You can double-click <block> to view the source.

|dentity Manager IDE Frequently Asked Questions (FAQ)

This FAQ answers some commonly asked questions related to using the Identity Manager
Integrated Development Environment (Identity Manager IDE). The information is organized into
these categories:

Using NetBeans

Working with Projects

Working with the Repository

Using the Identity Manager IDE Debugger

Using NetBeans

Q: Which version of Netbeans should | use?

A: Use the Netbeans version referenced in the Identity Manager product documentation provided
for the Netbeans plugin version you are using.

NOTE

Always use the exact version referenced because even patch releases can cause major
functionality to break.
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Q: The Netbeans plugin was working, | did something, and now it is no longer working. What could be
causing this problem?

A: This problem is commonly caused by a corrupt file in your .netbeans directory. Generally,
deleting your .netbeans directory and re-installing the NetBeans plugin resolves the problem.
(Deleting the .netbeans directory effectively uninstalls the NetBeans plugin. You lose all of your
user settings, but the contents of your project will be safe.)

The steps are as follows:
1. Shutdown NetBeans.
Delete the .netbeans directory.

2

3. Start NetBeans.

4. Install the NetBeans plugin.
5

Restart NetBeans.

Working with Projects

Q: Building and running a project is taking a very long time, and the Identity Manager IDE seems to be
copying a lot of files. What could be causing this problem?

A: This problem can occur for the following reasons:
* You are using the Identity Manager IDE 7.0 or 7.1 plugin.

Use the Identity Manager IDE 8.0 plugin.
Several adjustments were made to the Identity Manager IDE 8.0 Configuration Build
Environment (CBE) to improve performance.

*  You might be using the Clean commands unnecessarily.

When you use Clean Project or Clean And Build Project, the Identity Manager IDE
deletes the entire image directory, which contains several thousand files. Identity Manager
IDE must copy all of these files from idm-staging during the next build.

To use the Identity Manager IDE efficiently, you must understand when to use the Clean
commands. Refer to the “When to Use Clean” section in the Identity Manager IDE
README. txt file for more information.

Q: Now that | have created an Identity Manager project, what files should be checked into source
control?

A: See the “CVS Best Practices” section in the Identity Manager IDE README. txt for information.
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Q: What are the best practices for using project management in CVS?

A: See the “CVS Best Practices” section in the Identity Manager IDE README. txt for information.

Q: When are objects imported into the repository?

A: See “Working with the Repository” on page 159 for information.

Q: How do | add a new JAR to the project?
A: See the “How to add a new JAR dependency” section in the Identity Manager IDE README. txt.

Working with the Repository

Q: Which repository should | use for my sandbox repository?

A: Use the embedded repository for your sandbox — particularly if you are using Identity Manager
7.1 (or higher), which has an HsSQL repository available. You lose functionality if you do not use
the embedded repository.

Refer to the “Working with the Repository” section in the Identity Manager IDE README. txt for
more information.

Q: When are objects imported automatically?
A: You have to configure Identity Manager IDE to import objects automatically.
The steps are as follows:

1. Select Repository > Manage Embedded Repository from the IdM menu.

2. Enable the Automatically Publish Identity Manager Objects option on the Manage
Embedded Repository dialog.

NOTE This option is not available for Identity Manager Project (Remote) or if you
specify your own repository.

3. Select Project > Run Project or Project > Debug Project.

The Identity Manager IDE automatically imports all objects that have changed since the last
time you ran the project.

NOTE Automatically publishing Identity Manager objects increases the time
needed to start the server. To minimize server start time, disable this option
and explicitly upload objects to the repository.
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Q: What is the most effective way to upload objects?

A: Use one of the following methods to upload modified objects:

Right-click one or more edited objects in the project tree and select Upload Object from the
pop-up menu.

TIP To upload multiple objects, press and hold the Control key as you select
objects from the list.

Select one or more edited objects, and then select Repository > Upload Objects from the
IdM menu. A dialog is displayed so you can select the objects to upload.

Either method uploads the object(s) directly to the server, so there is no cache latency issue and it is
much faster than using Run Project or Debug Project. The Upload Objects feature is available
regardless of which repository you are using.

Using the Identity Manager IDE Debugger

Q: The Identity Manager IDE Debugger is sluggish. What could be causing this problem?

A: To improve the Debugger’s performance:

Always disable Tomcat's HTTP Monitor, as follows:

a. Select the Identity Manager IDE Runtime Tab.

b. Expand the Servers node and right-click Bundled Tomcat > Properties.

c. Disable the Enable HTTP Monitor option, and then close the dialog.
The next time you start Tomcat, the HTTP Monitor will be disabled.

If you are not debugging Java, select Project > Run Project, and then select
Attach Debugger > Identity Manager XML Object Debugger to use just the XPRESS
Debugger.

Selecting Project > Debug Project for a non-remote Identity Manager IDE project starts both
the XPRESS Debugger and Java Debugger, and the Java Debugger adds substantial
overhead.

Q: | cannot set a breakpoint in the Debugger. What could be causing this problem?

A: The following conditions might prevent you from setting a breakpoint:

You just installed the NBM, but did not restart Netbeans.

Your XML contains a <Waveset> wrapper element.
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The Identity Manager IDE basically ignores any file that starts with a <wWaveset> wrapper
element because the Identity Manager IDE parses that element as a multi-object file.

The following features do not work on multi-object files:

o

o

o

o

o

o

o

Debugger

Rule Tester

Form Previewer
Any of the editors
Import file generator
Upload Object

Diff Object

Basically, all you can do with multi-object files is import them. The only files that should
contain <Waveset> wrapper elements are your project’s top-level import files.

Q: | set a breakpoint in the Debugger and it is not suspending on the breakpoint. What could be
causing this problem?

A: There are two things to check:

* Be sure the object name does not contain a CBE replacement string (%%). CBE replacement
strings are not allowed in object names.

* Verify that the code you think is being executed is actually being executed. Try adding a
trace and see if anything prints out.

Working with Rules

Q: When developing rules in Netbeans, why is design mode not available for a Rule Library?

A: The design mode functionality is available from the explorer tree in Projects view. Use the
following steps:

1. Expand the library node and right-click a rule.

2. When the pop-up menu displays, select Properties and then click Body.
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|dentity Manager Tuning, Troubleshooting, and
Error Messages

This section provides new information and documentation corrections for Sun Identity Manager
Tuning, Troubleshooting, and Error Messages.

* Some tasks have been moved from the adapter to the task package. Update these paths if
you have tracing enabled for any of the following tasks, or if you have customized task
definitions referencing these packages.

Old Package Name New Package Name
com.waveset.adapter.ADSyncFailoverTask com.waveset.task. ADSyncFailoverTask
com.waveset.adapter. ADSyncRecoveryCollectorTask com.waveset.task. ADSyncRecoveryCollectorTask
com.waveset.adapter.SARunner com.waveset.task.SARunner
com.waveset.adapter.SourceAdapterTask com.waveset.task.SourceAdapterTask

¢ The “Unable to Delete Errors” troubleshooting information previously provided in the
“Troubleshooting Identity Manager IDE” section is no longer applicable and has been
removed from the book. Now, the Netbeans embedded application server automatically
shuts down whenever you perform any of the following project operations: (ID-16851)

o]

o]

o

o]

Clean Project

Create Delta Distribution
Create Jar

Debug Project

Manage Embedded Repository
Profile Project

Run Project

¢ The “Debugging PasswordSync” section has moved from the “PasswordSync” chapter in
Identity Manager Administration into the “Tracing and Troubleshooting Identity Manager”
chapter in Identity Manager Tuning, Troubleshooting, and Error Messages. (ID-17340)
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Localization Scope

Historically, Identity Manager does not localize resource objects and functions, primarily because
they are mostly samples that get loaded (through init.xml) during initialization of Identity
Manager, and because the attributes of object types can vary between actual customer
deployments, depending on the level of customizations. Following is a list of areas where users
might encounter English: (ID-16349)

Default user forms and process mapping

o  Example: Edit User > Security > User Form pull-down menus
o  Example: Configure > Form and Process Mappings
Configuration object attribute names

Example: Configure > User Interface, concatenated names such as
displayPasswordExpirationWarning

Default tasks
o Task templates
Example: Server Tasks > Configure Tasks > available task template names in table
o Task type labels
Example: Server Tasks > Run Tasks > second column items from Available Tasks table
o Task definitions

Example: Server Tasks > Find Tasks > second pull-down menu to select Task
Definition

Default report names

Example: Report names found under Reports > Run Reports > Report Table
Default policy names

Example: Compliance > Manage Policies > audit policy names and descriptions
Default capability names

Example: Edit User > Security > Available Capabilities

Default report & graph names

Process/workflow diagram applets
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Online Help

This section contains documentation corrections for online help.

* The “Configure Reports” help page contains the following sentence, which should be
disregarded:

Fonts should also be added to the JVM in order for graphs to display properly.

The sentence is incorrect. Adding fonts to the JVM is not necessary in order to properly
render text in the PDF report.
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